
TUTORIAL CREACION DE UN AEROPUERTO PARA FSX 

INTRODUCCION 

MALAGA,JUNIO DE 1.984.- Una calurosa tarde jugaba en la calle con mis amigos, como todos los días. Quedaban un 

par de días para que cumpliera 11 años. Del portal de mi casa vi aparecer a mi padre, y me dijo que fuera con él a 

comprar una "cosilla". Nunca ha sido mi padre una persona de comprar cosas y mucho menos de regalos para 

cumpleaños, de eso se ocupaba mi madre. Nos subimos en el Seat Ritmo, sin aire acondicionado por supuesto, y 

fuimos a parar a un bazar hindú del centro de la ciudad. Yo no abrí la boca, y pidió al dependiente que le enseñara un 

ZX Spectrum de 48K. Tras un breve regateo, la cosa quedó en 39.000 pelas, que para la época era un pastón y 

escuché "Nos lo llevamos".  Entonces el dependiente empezó a empaquetarlo en la caja, y de pronto se metió en la 

trastienda. Al poco salío con una cinta de cassette con una portada preciosa, era un dibujo de la cabina de un avión 

aterrizando en un atardecer. Ponía "PSION - SIMULADOR DE VUELO". El hombre dijo "Esto de regalo para el chaval" y 

me quedé un rato mirando la carátula de la cinta, como si me hubiera embrujado. Ahí empezó todo. 

                                              

 

Después de muchos años de afición a la simulación de vuelo, un día me dio por investigar acerca de la creación de 

escenarios. Al principio todo parece bastante complicado, debido a que hay multitud de programas que realizan 

distintas funciones, incluso diversos programas para hacer lo mismo, y también a que prácticamente todo lo que hay 

en Internet está en inglés, lo cual para mí si es un problema. Pero una vez que uno se mete de lleno todo va saliendo, 

poco a poco, a veces con parones, a veces volviendo atrás un poco, a veces con ganas de dejarlo todo para 

siempre...Lo que pasa es que ya todos vosotros sabéis que la simulación es como una droga de la que es difícil salir y 

no recaer. 

 Mi primer escenario fue hacer el aeropuerto de Málaga para FS9, ya que me pillaba a mano, para complementar el 

AirHispania Scenery. De veras que no sabía dónde me estaba metiendo. Si llego a saber la cantidad de horas que 

tuve que dedicarle no lo hubiera hecho. Es un aeropuerto monstruoso, además estaba en plena ampliación en el año 

2.009 que fue cuando empecé esta locura de proyecto, por lo que había zonas de las que no había fotos ni nada, tan 

solo proyectos y renders que encontré por Internet. Mi "maestro", Don Alfredo Ferrer, AHS9083 me ayudó infinidad 

de veces, intercambiando correos, mandándome utilidades para simplificar los trabajos, etc, por lo que le estaré 

eternamente agradecido. Pero claro, la cosa no salió del todo bien, y el escenario resultante era un devorador de 

frames despiadado, que seguramente habrá hecho que todos los pilotos de AirHispania se acuerden de mí y de mi 

familia en las aproximaciones. Y después de un largo parón, por tema de trabajo, pañales y biberones, ahora que 

dispongo de algo más de tiempo, decidí retomar el asunto, pero ya enfocado al FSX. 

La idea de hacer éste tutorial surgió por si alguno de vosotros os animáis a desarrollar vuestros propios escenarios 

tengáis una pequeña guía, que en ningún caso pretende ir mas allá, y por mí mismo para tener un poco más 



estructurado el trabajo por si algún otro día vuelvo a recaer. Cuando hice LEMG, lo hice desordenadamente, 

apuntando todo lo que me iba haciendo falta en esquinas de libretas, coordenadas en papel reciclado, dimensiones 

para el modelado 3D en siete partes distintas, guardando archivos en carpetas que después no encontraba en el PC, 

en fin una locura.  

BREVE DESCRIPCION DE LOS ESCENARIOS EN FSX 

Tan solo a modo de introducción deberíamos ver qué tipos de escenarios existen, ya que es importante que 

previamente al comienzo de un proyecto, sepáis que es lo que queréis hacer, y centraros exclusivamente en aquellos 

que os interesen.  Tened en cuenta que existe un ESCENARIO BASE, que es el que trae FSX por defecto, y a partir de 

ahí ESCENARIOS AÑADIDOS, que son los que existen tanto comercialmente como gratuitos para mejorar el escenario 

base. Veamos primero que trae éste escenario base. 

ESCENARIO BASE DE FSX (COMPONENTES): 

1. Modelos de elevación digital: Es lo que asigna a cada punto del simulador su elevación, creando una malla 

tridimensional que nos permite ver el relieve del terreno. 

 

2. Landclass y Waterclass: Estos no son escenarios en sí, sino una asignación a cada cuadrícula de la malla base de 

qué tipo de terreno o agua nos vamos a encontrar (ciudades, bosques, desierto, aguas oceánicas, aguas tropicales, 

tundra, selvas, etc.). 

3. Texturas: Son la representación gráfica de dichos Landclass y Waterclass, es decir la imagen que veremos en el 

simulador para cada cuadrícula base.  



 

Dichas texturas pueden presentar modificaciones, en referencia a la estación de año que nos encontremos, 

nocturnas o diurnas, e incluso mostrar una imágen por satélite (textura fotorealista). 

4. Elementos Vectoriales: Aquí van incluidos los objetos que se definen por elementos lineales, tales como ríos, 

arroyos, líneas de costa, carreteras, líneas de ferrocarril, líneas de electricidad, etc. 

5. Objetos: Se trata de los objetos tridimensionales tales como edificios, barcos, vehículos, árboles, puentes, 

antenas, es decir todo lo que nos podamos imaginar que se represente como un volúmen.  

 

6. Autogen y Regiones: Estos dos componentes no son tampoco escenarios en sí, sino elementos que de un modo u 

otro ordenan o modifican diversos objetos para acercarlos a la realidad. El Autogen por ejemplo se encarga de 

distribuir edificios aleatorios en las ciudades,árboles en los bosques o incluso animales en la sabana, para darles un 

aspecto realista. En cuanto a las Regiones, FSX realiza una división mundial por zonas, para asignar por ejemplo más 

tráfico en una carretera de Nueva York que en una de Uganda, o incluso basado en la densidad de población dibujar 

más edificios o menos según dichas zonas. 

7. Otros elementos tales como radioayudas a la navegación, efectos especiales, inteligencia artificial en 

aeropuertos,animaciones, etc, que nos permiten ver desde como parpadea una luz estroboscópica, o como se 

mueve un vehículo, colocar frecuencias de las radioayudas, movimiento de aviones en aeropuertos, en fin detalles 

para mejorar todo lo anterior. 



 

Autogen 

 

Regiones en FSX 

Esta es en definitiva la estructura básica de los escenarios en FSX. Como os podéis imaginar todos y cada uno de los 

componentes que hemos reflejado son susceptibles de ser modificados, mejorados o creados desde cero, lo que se 

pueden denominar como ESCENARIOS AÑADIDOS. Como ejemplos tenemos las mallas de FSGlobal (comerciales) o 

las que tenemos en AirHispania para toda España, con un nivel de detalle excelente, el Ultimate Terrain (comercial), 

que mejora la asignación de Landclass y Waterclass, así como de elementos vectoriales, el Ground Environment 

(comercial), que sustituye las texturas por unas de mejor calidad, los escenarios fotorealistas de toda España, que 

están disponibles también en AirHispania totalmente gratuitos, aeropuertos diseñados con modelos 3D, 

adaptaciones de Autogen para mejorar determinadas zonas, y un sinfín más.  

Lo que sí es de extrema importancia es tener ordenados todos y cada uno de los escenarios añadidos que 

compremos, descarguemos o realicemos, si os habéis dado cuenta, la estructura de escenarios es como un puzzle 

que se empieza desde las mallas de terreno y termina en un simple poste de electricidad, una capa sobre la otra y 

teniendo claro el orden de superposición. Echar un vistazo al manual de instalación de AirHispania SC, donde viene 

muy bien explicado y poder ordenar así la Biblioteca de Escenarios de FSX. 

 



CREACION DE UN AEROPUERTO EN FSX 

En AirHispania tenemos un magnífico escenario, como es el AHSCX, que engloba diversos aeródromos de nuestra 

geografía, incluso los más pequeños, obstáculos, cambios de AENA en las radioyudas, faros, e incluso nuestros toros 

de Osborne. Además en el foro se pueden descargar las mallas de terreno para España, de un nivel de detalle 13 

(equivalente a una malla de 5x5 m.), y los escenarios fotoreales con una resolución de 1m/pixel de toda nuestra 

geografía. Os recomiendo que os descarguéis los 3 componentes, aunque os aviso que las mallas y los escenarios 

fotoreales ocupan muchísimo espacio. Pero merece la pena comprarse un buen disco duro externo y almacenarlo 

todo ahí. 

Para éste tutorial vamos a centrarnos en desarrollar el aeropuerto de Córdoba (LEBA), ya que según el Coordinador 

de Escenarios, Luis Fernández AHS8553, es un aeropuerto bastante utilizado en AirHispania. Este aeropuerto ya fue 

desarrollado por nuestro compañero Koldo Navarro para FS9, lo que pasa es que últimamente ha tenido 

modificaciones en la vida real, como la ampliación de las pistas y nuevos edificios. 

 

En primer lugar, como hemos comentado antes, tenemos que tener más o menos claro que es lo que queremos 

hacer exactamente.  Aquí vemos ahora el aspecto de LEBA en el escenario por defecto de FSX, sin ningún tipo de 

escenario añadido. 

 



Observamos que el escenario por defecto no tiene edificios, tan solo las radioayudas, un aplanado de la superficie 

(flatten) y la pista. El entorno más o menos está conseguido, con el Río Guadalquivir, las zonas de cultivo y la ciudad 

de Córdoba al fondo. Observamos como también existe Autogen que le da un buen aspecto general. 

Ahora vemos una imagen desde el mismo punto con el MESH LOD13 y los escenarios fotorealistas del foro de 

AirHispania, así como AHSCX activado. 

 

El cambio es apreciable, si bien no tanto en el Mesh, por ser una zona relativamente llana, pero sí en el entorno con 

la imagen fotoreal. Desaparece el rectángulo terrizo alrededor de la pista, así como el Autogen, pero tenemos una 

pista mucho más detallada en cuanto a marcas, vemos también la plataforma y algunos edificios. El aspecto es 

francamente bueno. 

Lo que ocurre es que el aeropuerto de Córdoba ha sufrido cambios en los últimos años, tanto en edificios como en la 

ampliación de la pista, y es lo que vamos a intentar reflejar. La idea que tenemos para empezar a desarrollar el 

proyecto está basada en los siguientes puntos: 

1. Creación de una imagen fotoreal con la máxima resolución que nos sea posible, que cubra solo el perímetro 

del aeropuerto, para mantener el resto del entorno tal y como está. 

2. Aplanado (Flatten) del aeropuerto ampliado. 

3. Actualización de las pistas, plataformas, radioayudas y diversos elementos. 

4. Creación de los objetos correspondientes a los edificios, con sus correspondientes texturas. 

5. Acabados y detalles. 

Veamos si podemos llevar a cabo todo esto. Antes de empezar nos conviene crearnos una carpeta en el ordenador a 

la que podemos llamar “Documentación escenario LEBA”, donde iremos acopiando todo aquello que busquemos en 

Internet y que nos pueda ser de utilidad. En especial, debemos tener: 

1. Documentación de AENA referente al aeropuerto. En el AIP de Aena debemos descargarnos las fichas de 

Datos de Aeródromo, el Plano de Aeródromo y la carta de Aproximación Visual. Esta es la documentación 

oficial y por tanto a la que tendremos que adaptar nuestro proyecto. 

http://www.enaire.es/csee/Satellite/navegacion-aerea/es/Page/1078418725163//AD-Aerodromos.html 



2. Fotografías aéreas. Buscamos en Google Earth, Bing Maps, PNOA (Iberpix), y nos bajamos aquella que nos 

parezca más actualizada y con mejor resolución. Según lo que yo he visto por ahí, la de Bing Maps es la que 

mejor refleja el estado actual del aeropuerto y la que mejor se ve. 

 
Observar un detalle, si miráis en la imagen que pusimos del escenario de AHSCX anteriormente, fijaros la 

distancia que hay entre la cabecera de la pista 03 y el Río Guadalquivir. Ahora mirad esta última imagen y 

vemos que actualmente dicha cabecera está prácticamente en el río. 

De momento con ésta documentación podemos ir comenzando. Poco a poco iremos rellenando ésta 

carpeta, pero lo iremos viendo conforme nos vaya haciendo falta. 

Bueno, empecemos. 

 

PASOS A REALIZAR PREVIAMENTE A COMENZAR CUALQUIER DISEÑO DE ESCENARIOS 

Para desarrollar cualquier tipo de escenario para FSX vamos a necesitar una serie de requisitos 

indispensables que no podemos evitar.  

1. FSX: Esto es obvio, necesitamos disponer del simulador de vuelo, ya que muchos programas auxiliares 

toman datos de él. Es conveniente tenerlo bien configurado, en particular debemos de crear dentro del 

apartado de VUELO LIBRE una situación de inicio, con el avión más simple que dispongamos (el 

ultraligero por ejemplo), con la ubicación en LEBA, eliminamos toda la información meteorológica, y 

ponemos una hora diurna. Arrancamos el vuelo y nos encontraremos en la cabecera de LEBA, con 

motores en marcha. Pulsamos el botón “Y”, para ponernos en modo desplazamiento, pulsamos 

“MAYUS+Z” para tener en la esquina superior las coordenadas,  nos vamos al menú Vistas->Modo de 

vista->Cabina->Cabina, así como menú Vistas->Panel de Instrumentos->Desactivar los paneles del avión. 

Nos vamos al menú Vuelos->Guardar y le damos un nombre, por ejemplo “LEBA”, y lo establecemos 

como predeterminado. A continuación debemos de configurar  el aspecto gráfico. Esto queda a vuestro 

gusto,  os comento como lo tengo yo. Nos vamos a Opciones->Configuración->Pantalla. En el apartado 

Gráficos lo tengo así: 
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En el apartado Escenarios: 

 
Los demás apartados (Avión, Meteorología y Tráfico), los tengo todos en configuración Mínima, ya que no es 

fundamental para lo que nos ocupa actualmente. 

2. FSX-SDK: Esto es fundamental para poder crear escenarios. Se trata de una serie de complementos que 

vienen de forma independiente del FSX, donde se encuentran las herramientas de compilación 

imprescindibles. Para la instalación del FSX-SDK os pongo un enlace donde lo explican detalladamente, 

ya que la instalación dependerá de que versión tengáis del simulador. Es fundamental seguir los pasos 

tal y como viene explicado. 

http://www.fsdeveloper.com/wiki/index.php?title=SDK_Installation_%28FSX%29 

Si habéis conseguido instalarlo correctamente, la forma de comprobarlo es abrir un vuelo en FSX, y os 

debe aparecer en la barra de menús, uno nuevo llamado “Herramientas”, y dentro de éste deben 

aparecer 3 submenús: Object Placement Tool, Traffic Toolbox y FX Tools. Si no os aparecen consultar 

esto: 



http://www.fsdeveloper.com/wiki/index.php?title=SDK_Installation_%28FSX%29_-_Troubleshooting 

Yo por ejemplo no lo conseguí a la primera, y lo conseguí solucionar de la siguiente manera: 

Nos vamos a C:\Usuarios\Admin\Appdata\Roaming\Microsoft\FSX (si tenemos Windows 7, si tenemos 

otra versión de Windows, debemos buscar manualmente el archivo dll.xml),y abrimos con el bloc de 

notas el archivo dll.xml, y lo configuramos así: 
 
<?xml version="1.0" encoding="Windows-1252"?> 
 
<SimBase.Document Type="Launch" version="1,0"> 
  <Descr>Launch</Descr> 
  <Filename>dll.xml</Filename> 
  <Disabled>False</Disabled> 
  <Launch.ManualLoad>False</Launch.ManualLoad> 
  <Launch.Addon> 
    <Name>Object Placement Tool</Name> 
    <Disabled>False</Disabled> 
    <ManualLoad>False</ManualLoad> 
    <Path>..\Microsoft Flight Simulator X SDK\SDK\Mission Creation 
Kit\object_placement.dll</Path> 
  </Launch.Addon> 
  <Launch.Addon> 
    <Name>Traffic Toolbox</Name> 
    <Disabled>False</Disabled> 
    <ManualLoad>False</ManualLoad> 
    <Path>..\Microsoft Flight Simulator X SDK\SDK\Environment Kit\Traffic Toolbox 
SDK\traffictoolbox.dll</Path> 
  </Launch.Addon> 
  <Launch.Addon> 
    <Name>Visual Effects Tool</Name> 
    <Disabled>False</Disabled> 
    <ManualLoad>False</ManualLoad> 
    <Path>..\Microsoft Flight Simulator X SDK\SDK\Environment Kit\Special Effects 
SDK\visualfxtool.dll</Path> 
  </Launch.Addon> 
  <Launch.Addon> 
        <Name>FSUIPC 4</Name> 
        <Disabled>False</Disabled> 
        <Path>Modules\FSUIPC4.dll</Path> 
    </Launch.Addon> 
</SimBase.Document> 

 

En especial fijaros en las líneas en rojo, que son los 3 add-ons que se instalan en el menú Herramientas. 

Cambiar en las tres <Disabled>True/Disabled> por <Disabled>False/Disabled> Comprobad también las 

rutas de instalación de los tres añadidos del SDK. Grabar el archivo y cerrarlo. 

3. FSUIPC: Este complemento es de sobra conocido por todos vosotros, y seguramente ya lo tengáis 

instalado, y sirve para comunicar FSX con otros elementos, periféricos o programas externos. 

Comentaros que tan solo necesitamos la versión libre, que se consigue aquí (bajaros la versión 4.939): 

http://www.schiratti.com/dowson.html 

 

Con esto creo que de momento tenemos ya configurado correctamente el simulador para empezar a trabajar. 

¿Preparados? 

IMAGEN FOTOREAL DEL CONTORNO DEL AEROPUERTO 

Este va a ser nuestro primer paso. La idea es conseguir una buena imagen satelital u ortofoto, y colocarla en 

sus coordenadas en el FSX, creando una máscara para recortar el contorno del aeropuerto, así como crear la 

textura nocturna. Para ello vamos a necesitar lo siguiente: 

1. SAS PLANET: Este programa gratuito nos sirve para descargarnos la imagen fotoreal que queramos usar. 

Tiene la ventaja de que nos baja la imagen georreferenciada, es decir, con las coordenadas, lo que nos 

será muy útil para después colocarla en su sitio correctamente. Lo que ocurre es que SAS PLANET por 

defecto solo te permite bajar imágenes de servidores “comerciales”, tales como Google Earth, Bing 

Maps, Yahoo Maps, etc, y éstas imágenes no las podemos usar por temas de copyright para hacer 

escenarios que se vayan a distribuir, aunque sea libremente y sin ánimo de lucro. ¿Qué podemos hacer?. 

Muy fácil. Existe un blog llamado digimapas.blogspot en el que han añadido a SAS PLANET los servidores 



del Instituto Geográfico Nacional, con lo cual podremos usar las imágenes del PNOA o de las 

Comunidades Autónomas.  Lo que debemos de hacer es bajarnos SAS PLANET desde ésta dirección: 

http://digimapas.blogspot.com.es/p/descargas.html 

Ahí buscamos •  SASPlanet.Release.141212+Mapas3.0 y lo descargamos. Este programa no tiene 

instalador, es portable, así que nos conviene crearnos un acceso directo en el escritorio. 

2. SBUILDERX: Es un programa gratuito que genera diversos tipos de escenario, tales como Landclass y 

Waterclass, escenarios fotoreales, objetos vectoriales, polígonos de tierra (ground polys), etc. Bajaros la 

versión X313. Ultimamente la página del creador parece que está caída, pero no os será difícil encontrar 

una descarga googleando un poco. Yo aquí os pongo una: 

http://sbuilderx.software.informer.com/download/ 

3. SOFTWARE DE EDICION GRAFICA: Nos va a hacer falta un programa de tratamiento de imágenes. Hay 

multitud de ellos, yo concretamente uso PhotoShop, que es comercial, pero también podéis usar GIMP, 

que es gratuito y hace lo mismo. 

http://www.gimp.org/downloads/ 

Con esto podemos ir tirando. Vamos a ir comentando los pasos que tenemos que dar. 

1. DESCARGA DE LA IMAGEN: Abrimos SAS Planet+Mapas 3.0. Este es el aspecto inicial: 

 
Ahora vamos a seleccionar el servidor de la Junta de Andalucía: Vamos a Maps->Andalucía->Orto 2010-2011. 

MUY IMPORTANTE: Debemos de cambiar el sistema de proyección, para ajustarlo al de FSX: 

View->Projection->Geographic (Latitude/Longitude):WGS84/EPSG 4326. 

También nos conviene poner las coordenadas del programa en formato decimal: 

Settings->Options->Pestaña View->Coordinates Representation: Las colocamos en -- deg. (-12.1233º). 

Como sabemos que las coordenadas del aeropuerto son aproximadamente 37,8423,-4.84634, nos vamos a: 

Operations->Go To-> Pestaña Coordinates-> Introducimos esas coordenadas. 

 
Ya debemos estar situados sobre la zona del aeropuerto. Ahora debemos ir ampliando con la rueda del ratón 

hasta que tengamos un nivel de zoom aceptable. Las ortofotos de máxima resolución de la Junta de 
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Andalucía están en 0,25 m/pixel. Por lo tanto vamos a elegir esa resolución (cada pixel de la imagen 

representa 25 cms. reales). En SAS PLANET podemos ir viendo esa información en la esquina inferior 

izquierda de la pantalla.  

 
Vemos que 0,25 m/pixel corresponde a un nivel de zoom z20. A continuación nos alejamos con el zoom 

porque ahora vamos a seleccionar el rectángulo de imagen que vamos a descargar. Nos vamos a un zoom 

por ejemplo z16, donde vemos todo el aeropuerto y sus alrededores. Fijaros que la imagen del mapa está 

como “aplastada” un poco, pero eso no nos importa, ya que después habrá que calibrarla. Nos vamos a  

Operations->Selection Manager->Rectangular Selection, y dibujamos un rectángulo alrededor del 

aeropuerto. No quedaros cortos, dadle margen suficiente alrededor, ya después lo recortaremos. Una vez 

cerrado el rectángulo, automáticamente nos aparece el cuadro de diálogo Selection Manager, que es el que 

nos permitirá descargarnos la imagen. 

 
Aquí está la clave de la descarga de la imagen. En la pestaña Download, en Map seleccionamos el servidor 

ORTO 2010-11, y ponemos el nivel de zoom en 20. Lo demás lo dejamos igual que estaba. En la pestaña 

Stitch seleccionamos como Output Format el BMP. En Save To seleccionamos la ruta donde queremos que 

nos descargue el archivo, por ejemplo, en la que creamos “Documentación escenario LEBA” Es importante 

que al nombre del archivo le pongáis Photo delante, o sea que nos quedará como PhotoLEBA.bmp. En Map 

de nuevo ponemos ORTO 2010-11. En Zoom, ponemos 20. En Projection ponemos 

Geographic/WGS84/EPSG4326. En el cuadrito Create Georreferencing File, marcamos la casilla “.dat” (esto 

nos creará un pequeño archivo con las coordenadas que nos será muy útil posteriormente). 

 
Pulsamos Start y esperamos que nos genere los dos archivos, PhotoLEBA.bmp y PhotoLEBA.dat: 



 
PhotoLEBA.bmp 

 
PhotoLEBA.dat 

Ya podemos cerrar SAS PLANET. El fichero .dat lo podemos abrir con el bloc de notas por ejemplo, pero no 

aún. Vemos que el archivo BMP ocupa 354 Mb, lo que es una barbaridad, pero no os preocupéis, después se 

reducirá.  Lo que sí vemos es que la imagen tiene un color un poco tristón, apagado, y eso se nota bastante 

en FSX. A continuación veremos como darle algo más de vida, así como crear la máscara de recorte del 

perímetro del aeropuerto.  

 

2. TRATAMIENTO DE LA IMAGEN OBTENIDA: Este es el paso quizá más artístico, y en el que queda a vuestra 

elección el aspecto final que queramos que tenga nuestra imagen fotoreal. También aquí crearemos la 

máscara de recorte, y la textura nocturna. Yo, como os dije, trabajo con Photoshop, pero podéis usar 

cualquier otro programa de tratamiento digital de imágenes (El Paint de Windows no, ese se nos queda 

corto). Usad Gimp si no queréis comprar el Photoshop, aunque puede variar algo la forma de actuar para 

llegar al mismo punto. Abrimos Photoshop. Hacemos Archivo->Abrir y seleccionamos nuestro 

PhotoLEBA.bmp. Lo primero que podemos hacer es resaltar la imagen. Aquí entra en juego vuestra 

capacidad creativa, y o normalmente lo que hago es subirle el contraste y la intensidad a la imagen, así como 

aplicarle un filtro de enfoque. Id probando. A mí me ha quedado así: 



 
Si comparáis las dos imágenes se aprecia un cambio considerable. Cuando estéis conforme con vuestra 

imagen, vamos a Archivo->Guardar como->Lo llamamos igual, con lo que reescribiremos el anterior 

PhotoLEBA.bmp, es importante que le pongáis la extensión BMP, y en las opciones marcáis Windows y 

profundidad 24 bits. 

 
Podemos aprovechar y crear la textura nocturna del aeropuerto. Esto también conlleva cierto grado de 

capacidad artística, y existen numerosos métodos para crear una textura nocturna. Nosotros vamos a usar 

prácticamente siempre el escenario en combinación con el escenario fotorrealísta de AirHispania. Resulta 

que éste escenario no se aprecia en su versión nocturna, sino que se ve totalmente negro. Pero si nosotros 

no creamos una textura para la noche, nuestro escenario se verá como si fuera de día, creando un efecto 

bastante irreal. Lo que haremos será simplemente oscurecer nuestra imagen original. Yo lo hago de la 

siguiente forma. Partimos del archivo PhotoLEBA.bmp en el Photoshop. Vamos a Imagen->Ajustes-

>Variaciones. Nos aparecerán una serie de cuadros que son previsualizaciones de los ajustes que le 

hagamos. Vamos pulsando repetidamente en el cuadro “Más Oscuro”, hasta que nos quede nuestra imagen 

previsualizada prácticamente en negro. Nos quedará algo así: 



 
Como véis da una impresión bastante cercana a lo que es una imagen nocturna, ya que incluso parece 

reflejar la iluminación de las casas que rodean el aeropuerto. Pero para mi gusto queda demasiado 

remarcado las líneas de pista y el campo de vuelo. Haremos un último retoque. Vamos a Imagen->Ajustes-

>Tono/Saturación, y le rebajamos los valores de Tono aproximadamente a -33, y la Luminosidad a -51. A 

continuación vamos a Archivo->Guardar como, y lo grabamos como PhotoLEBA_N.bmp, en la misma 

carpeta. 

 Ahora vamos a crear la máscara de recorte del contorno del aeropuerto. Esto no es imprescindible, ya que si 

queréis podéis dejar la imagen tal cual y en FSX veremos todo el rectángulo. Pero yo he optado por crearle la 

máscara para así solo modificar la zona del aeropuerto y dejar el resto cómo estaba. Tened en cuenta que 

FSX admite dos tipos de máscara, una llamada Water Mask y otra que es la Blend Mask. La Water Mask se 

aplica si tenemos zonas de costa y queremos que en FSX la zona de agua se represente con las texturas de 

agua del propio simulador. Si no lo hacemos, FSX considera la totalidad de la imagen como tierra. La Blend 

Mask nos sirve para delimitar qué parte de nuestra imagen queremos que se vea en FSX y qué parte 

queremos ocultar. La Blend Mask tiene una particularidad. Mientras que las Water Mask sólo admite un 

tono blanco para las zonas visibles y uno negro para la zona de agua que ocultamos, la Blend Mask admite 

tonos de gris, con lo que podemos de alguna forma “difuminar” los bordes de nuestra imagen para hacer 

una transición gradual entre la imagen que aplicamos y las texturas existentes alrededor de ella. Por lo tanto 

nosotros crearemos una Blend Mask, pero no vamos a hacerla con tonos de grises, creo que no será 

necesario. Para crearla hacemos: 

Capa->Duplicar capa->OK. En la parte derecha del Photoshop aparecen las dos capas existentes, una que se 

llama Fondo y otra que se llama Fondo Copia. Nos aseguramos que tenemos seleccionada la capa Fondo 

Copia. 

En la barra de herramientas de la izquierda seleccionamos “Herramienta Lazo Poligonal” 



 
Empezamos a dibujar el contorno. A nuestro gusto, procurando seguir el vallado del aeropuerto, pero 

incluyendo algo de las carreteras perimetrales. Una vez que hemos cerrado el polígono, vamos a Edición-

>Rellenar->Seleccionamos Blanco. Quedará algo así: 

 
Ahora hacemos Selección->Invertir,  y quedará seleccionado el resto de la imagen. 

A continuación Edición->Rellenar->Seleccionamos Negro. 

 
Ya vamos viendo la máscara. Sólo nos queda grabarla. Vamos a Archivo->Guardar como y seleccionamos el 

tipo de extensión .TIFF, y el nombre del archivo será PhotoLEBA_B.tif. Ponerlo en la misma carpeta que 

PhotoLEBA.bmp. 



 
Aceptar los dos siguientes cuadros de diálogo tal y como están, sin cambiar nada. Podemos cerrar 

Photoshop, o el programa que estéis usando. 

 

3. CREACION DEL BGL: Nuestro próximo paso será muy importante, digamos fundamental, ya que es el que nos 

va a crear el archivo BGL, que son los tipos de archivo que FSX es capaz de leer. Para ello usaremos 

SBUILDERX, con el que importaremos la imagen, la calibraremos y la compilaremos. Paso a paso. 

Abrimos SBUILDERX y vamos a File->New Project. Le ponemos de nombre LEBA y damos OK. A continuación, 

y muy importante, es que tenemos que copiar nuestros tres archivos PhotoLEBA.bmp, PhotoLEBA_N.bmp y 

PhotoLEBA_B.tif a la carpeta Tools\Work que existe dentro del directorio donde hayáis instalado SBUILDERX. 

Esto es imprescindible. 

A continuación debemos de modificar una pequeña cosa en el archivo de configuración de SBUILDERX para 

que nos muestre las coordenadas en formato decimal. Hacemos Edit->Preferences, y pulsamos INI File. Se 

nos abrirá un archivo de configuración con el bloc de notas. En el apartado [Main], buscamos la cadena 

DecimalDegrees=False y la cambiamos por DecimalDegrees=True. 

 
Guardamos y le damos a OK. 

Vamos a FIle->Add map->From disk y seleccionamos PhotoLEBA.bmp. Veremos nuestra imagen en la 

pantalla, pero nos saldrá un mensaje como éste: 

 
Tenemos que calibrar la imagen. Ahora mismo SBUILDERX no sabe en qué coordenadas tiene que colocar 

nuestro escenario, ni que dimensiones tiene. Damos a Aceptar. Se nos abre el cuadro “Map Properties”. 

Solamente pulsar en el botón “Calibrate” y aparecerá el cuadro “Map Calibration”. ¿Os acordáis del fichero 

PhotoLEBA.dat que grabamos con el SAS PLANET?. Pues es el momento de utilizarlo. Abrirlo con el bloc de 

notas. 
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Esas dos coordenadas son las que vamos a necesitar para calibrar la imagen. 

 
Copiamos y pegamos cada valor en su casilla correspondiente, pero cuando acabemos hemos de cambiar el 

punto decimal por comas, de lo contrario SBUILDERX nos mostrará un error. Damos a Calibrate. 

¿Qué ha ocurrido? Parece que ha desaparecido la imagen. No os preocupéis que sigue estando ahí. 

Pinchamos en View->Go to Position, e introducimos las coordenadas de cualquier esquina del aeropuerto. 

 
Ahora vamos ampliando el zoom con la rueda del ratón, y… voilá. Aquí tenemos nuestra imagen, pero 

además, si todo está en orden, ya no la veremos “achatada”, sino con su forma real, al haberla calibrado. 

 



Además debería estar en su sitio, en las coordenadas correspondientes. Por último nos queda compilar el 

escenario para que funcione en FSX. Vamos a Select->Select All. Veréis que se selecciona la imagen con un 

rectángulo de color verde en el borde y unos puntos rojos en las esquinas. Hacemos click con el botón 

derecho sobre uno de los bordes de la imagen y damos en Properties. 

Escribimos en Map Name: PhotoLEBA, a continuación, vamos a la pestaña “Seasons”. En la casilla “Night”, 

pinchamos en el icono de los puntos suspensivos y localizamos nuestro archivo PhotoLEBA_N.bmp. y le 

damos en la parte inferior al botoncito que pone “Data File”. Por último pulsamos “OK”. 

 
Parece que no ha pasado nada, pero sí que ha pasado. Volvemos a seleccionar el mapa en Select->Select All 

hasta que veamos el rectángulo verde alrededor de la imagen. Aseguraros que está el rectángulo, que a 

veces se queda un poco pillado y hay que darle dos veces. Por último vamos a FIle->BGL Compile y nos saldrá 

éste cuadro de diálogo: 

 
Aseguraros que están marcadas SOLAMENTE esas dos casillas: Photo Scenery y Copy BGL files to BGL folder. 

Pulsamos en Compile. Comenzará a compilar en una pantalla de MS DOS, eso es que está empleando el 

Resample. Esperamos a que acabe. 

 
Grabamos nuestro proyecto en FIle->Save Project y cerramos el SBUILDERX. Sí todo ha ido como debiera, en 

vuestra carpeta Tools\Work\ de vuestro directorio de instalación de SBUILDERX, debería de haber 6 

archivos: 

-PhotoLEBA.bmp: Esta era la imagen que hemos usado para nuestro escenario. 

-PhotoLEBA_N.bmp: Textura nocturna. 
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-PhotoLEBA_B.tif: Esta es la máscara Blend Mask de recorte. 

-PhotoLEBA.txt: Es un ficherito de texto que crea SBUILDERX cuando pulsamos el botón Data File, con las 

coordenadas de las 4 esquinas de nuestro escenario. 

-PhotoLEBA.inf: Es un fichero de información que se crea al compilar, donde le dice al resample.exe las 

fuentes que empleará para dicha compilación (el .bmp y el .tif de la máscara). 

-PhotoLEBA.bgl: Aquí tenemos nuestro escenario.  Al final ocupa unos 13 Mb, que es bastante, pero no 

necesitamos archivos de texturas, que ocupan bastante en escenarios fotorrealistas, ya que dichas texturas 

quedan compiladas en el archivo .bgl. Para poder verlo, yo recomendaría crear una carpeta que se llame 

“LEBA”, y dentro de ella creamos dos subcarpetas, llamadas “Scenery” y “Texture”.  Copiamos nuestro 

PhotoLEBA.bgl a la subcarpeta “Scenery”, y lo podemos renombrar como queramos. Si seguimos el esquema 

que suele usarse en AHSCX, lo llamaríamos “Cordoba_LEBA_background”, por ejemplo. 

Arrancamos el FSX a ver cómo ha quedado. Vamos a Configuración->Biblioteca de Escenarios. Primero nos 

conviene desactivar momentáneamente todos los escenarios de AHSCX, por lo tanto desmarcamos las 

casillas. Después le damos a Agregar Zona, nos buscamos nuestro directorio LEBA, hasta que veamos en el 

recuadro blanco las dos subcarpetas Scenery y Texture. Pinchamos en Aceptar y a continuación pinchamos 

en el ratón en el area en blanco dentro del recuadro, justo debajo de Scenery. 

 
Nos quedará algo parecido a esto: 

 
Vamos a vuelo libre y cargamos nuestro vuelo guardado como “LEBA”, y esperamos. Ya podéis dar un paseo 

por Córdoba en modo desplazamiento, a ver qué os parece. 



 

 
Fijaros como la pista se adapta y centra perfectamente en la imagen del fondo, lo que quiere decir que 

hemos acertado en las coordenadas. Si cambiamos la hora del simulador y nos ponemos en una hora 

nocturna queda algo así: 



 
Queda bastante oscuro, pero se puede apreciar la pista y el entorno sin llamar mucho la atención sobre los 

alrededores. 

Por último comentaros que SBuilderX también permite crear las texturas “estacionales”, es decir crear un 

juego de texturas distinto para primavera, verano, otoño, invierno y extremo invierno. Nosotros no lo vamos 

a aplicar, ya que las texturas fotorrealistas del entorno no van a variar, pero si queréis practicar, adelante. El 

proceso es el mismo que para la creación de la nocturna, tenemos que modificar el aspecto de la imagen 

original PhotoLEBA.bmp adaptándola a las diferentes estaciones (tonos verdes en primavera, amarillos en 

verano, blancos con nieve para extremo invierno…), y vamos grabando cada uno como PhotoLEBA_SP.bmp 

para primavera, PhotoLEBA_SU.bmp para verano, PhotoLEBA_FA.bmp  para otoño , PhotoLEBA_WI.bmp 

para invierno y PhotoLEBA_HW.bmp para extremo invierno. Recordad antes de compilar, en el cuadro de 

diálogo “Map Properties”, localizar la ruta de cada una de las texturas estacionales. 

 

APLANADO (FLATTEN) DEL AEROPUERTO 

Los Flatten en FSX son un tipo de escenario que realiza una explanación del terreno a una altura 

determinada, con lo que modifica la malla de terreno en una superficie que nosotros le especifiquemos 

dibujando un contorno perimetral. Se usa normalmente en aeropuertos, para que toda las pistas, 

plataformas y calles de rodadura estén al mismo nivel. En FSX incluso se pueden realizar flatten con 

pendientes, para pistas que en la realidad la tengan (caso del aeropuerto de Courchevel), pero éste no es el 

caso. 

Nosotros nos vamos a basar en ver cómo está el aeropuerto de LEBA en el escenario base de FSX, para crear 

nuestra modificación. Una cosa muy importante es que jamás se debe de modificar un escenario báse del 

simulador, machacándolo. Siempre se puede modificar, pero guardándolo como añadido y manteniendo el 

original intacto. Posteriormente, por el orden de superposición que vimos anteriormente, haremos que 

nuestro escenario sea el que realmente se vea. 

Si nos acercamos a la cabecera de la pista 03 de LEBA, vemos esto: 
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¿Veis el desnivel que hay en la cabecera? Esto se debe a que el flatten original de FSX es más pequeño 

lógicamente que la ampliación del aeropuerto. Lo que haremos será realizar un flatten nuevo adaptado al 

nuevo perímetro de LEBA. Vamos a necesitar lo siguiente: 

1. ADE (Airport Design Editor): Este software, gratuito, es fundamental en la creación de escenarios de 

aeropuertos para FSX, ya que prácticamente nos permite añadir todos los elementos que lo forman 

habitualmente, tales como pistas, rodaduras, plataformas, radioayudas, algunos objetos estándar, 

vallado, y por supuesto flattens. La última versión es la 1.65, y lo podéis descargar aquí: 

http://www.scruffyduck.org/downloads/4584110854 

Bajaros también el manual, que está en inglés, pero es casi fundamental. Eso sí, son 300 páginas, así que 

paciencia. 

De momento no necesitaremos más. Vamos a instalar el ADE. Simplemente ejecutar el instalador. Yo os 

recomendaría que dejárais las opciones marcadas por defecto. Una vez instalado lo ejecutamos, y al ser la primera 

vez, nos aparecerá un asistente de configuración como este: 

 

Tendremos que ir completando todos los pasos. Veamos que tenemos que modificar. Si pulsamos “NEXT”, nos 

aparece el cuadro de “General Settings”. Aquí solamente tenemos que añadir nuestras iniciales en el primer 

recuadro, para que al generar un proyecto las refleje, así como marcar la casilla que pone “Parking and apron (Path) 

taxiway links do not display surfaces…” Lo demás dejarlo como está. El siguiente cuadro es “Folders”. Aquí 

simplemente pulsar el botón FIND, para que ADE os localice el directorio dónde tengáis instalado FSX, así como las 

rutas de acceso a varios programas del FSX-SDK necesarios. El siguiente cuadro es “Units”, tan solo seleccionar en la 

última casilla la opción “Decimal”, para las coordenadas. A continuación tenemos el cuadro “Project Settings”, qué es 
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donde le indicamos a ADE el lugar donde queramos que nos grabe nuestro proyecto (“Save Projects To”), así como 

nuestros archivos BGL de escenarios. A vuestro gusto, yo los proyectos los grabo en la carpeta \Airport Design 

Editor\FSX\Projects, que es la que viene por defecto, y los BGL le doy la ruta para que los grabe en la carpeta que 

creamos \LEBA\scenery, donde ya teníamos grabado es escenario “Cordoba_LEBA_Background.bgl” de nuestra 

imagen fotorreal. Lo demás lo dejamos como está. Ya hemos terminado. Damos en NEXT y FINISH. A trabajar. 

Lo primero que haremos será arrancar el simulador, ya que ADE engancha con él y nos será muy útil para tomar 

coordenadas y demás. Cargamos nuestro vuelo inicial LEBA y nos quedamos quietecitos. 

Vamos a ADE, a File->Open Stock Airport. Nos saldrá éste cuadro. 

 

Lo qué estamos haciendo es cargar el aeropuerto original LEBA del FSX. Veremos algo así: 

 

Vemos la pista, las radioayudas, las posiciones de inicio y el ARP del aeropuerto. A continuación lo que haremos será 

grabar nuestro proyecto, para así no alterar este escenario original y hacer todas las modificaciones en el proyecto. 

Vamos a File->Save Airport As y le damos nombre. En mi caso se llama LEBA_ADEX_JL.ad4, pero a vosotros os 

cambiará las iniciales JL por las vuestras. Aquí ya podemos cambiar lo que queramos. Echemos un vistazo a qué es lo 



que existe en el aeopuerto original de LEBA en FSX.  Vamos a Lists->Project Tree, y desplegando todas las pestañas 

nos aparece esto: 

 

Es decir que tenemos 0 posiciones de Parking, 1 pista 03/21 de asfalto, 2 posiciones de inicio, 0 calles de rodadura, 0 

marcas designadoras de pista, 1 vista de torre de control, 4 objetos de librería (1 antena con luz estrobóscopica, 1 

NDB, una pequeña bomba de fuel y un VOR), y una plaza para repostar combustible. Eso es todo. Parece algo escaso, 

así que iremos añadiendo elementos . 

Lo primero que haremos será añadir una imagen de fondo del aeropuerto. Ojo, que ésta imagen sólo nos servirá de 

guía y referencia para ayudarnos a colocar objetos, ADE no realiza escenarios fotorreales. Por lo tanto debemos 

buscarnos la foto por satélite u ortofoto que encontremos más actualizada, por lo tanto la de Bing Maps me parece 

la más idónea. Para bajarla usaremos de nuevo nuestro viejo conocido SAS PLANET. Lo Abrimos. Vamos a Maps-

>Bing ->Bing Maps Satellite. Nos cargará la imagen. Ahora View->Projection->Geographic. Seguramente el programa 

recuerde aún nuestro último rectángulo de selección, sí es así lo veremos en negro. Si no, realizar una nueva 

selección alrededor del aeropuerto sin quedaros cortos. Hacemos Operations->Selection Manager->Last Selection (si 

recuerda nuestra última selección) o Rectangular Selection. Nos aparecerá el cuadro de diálogo de descarga. En la 

pestaña Download, en Map tendremos Bing Maps Satellite, y marcamos un nivel de zoom de 19 por ejemplo. En la 

pestaña Stitch, seleccionamos JPG en Output Format (ADE no puede manejar imágenes de mucho peso, por eso 

evitamos el formato BMP), para la ruta podemos meterlo en la carpeta “Documentación escenario LEBA”, y yo le 

llamaré al archivo “LEBA_ADE_Background”. Ponemos el zoom en 19, ponemos la casilla Projection en Geographic, y 

marcamos la casilla con el archivo .dat. Damos a START y cerramos SAS PLANET. 

Ahora vamos a importar esa imagen como fondo de ADE. En cualquier punto de la pantalla principal de ADE, 

hacemos click derecho, y seleccionamos Add->Image. Buscamos nuestro archivo descargado, y marcamos la casilla 

“Enter  corner coordinates”. Aquí abrimos nuestro fichero .dat (Ojo: no confundirlo con PhotoLEBA.dat, ahora 

abrimos LEBA_ADE_Background.dat) y copiamos y pegamos las coordenadas de la esquina NW (Top Left) y SE 

(Bottom Right). Pulsamos en SAVE, y tendremos nuestra imagen en su sitio. 
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Antes de crear el flatten, vamos a comentar un aspecto en cuanto a la altura del aeropuerto. Si nos vamos a la ficha 

de Datos de Aeródromo de AENA, que es la oficial, nos indica que la elevación del aeropuerto de Córdoba son 94m. 

Veamos qué altura tiene nuestro aeropuerto en FSX. Nos vamos a File->Airport Properties. Nos damos cuenta que la 

altura en FSX es de 90,52m. Son 3,5 m. de diferencia. ¿Qué hacemos ahora?. Podríamos modificar la altura del 

aeropuerto en FSX, pero creedme que eso no es tarea sencilla. Pero fijaros en un detalle. En la misma ficha de AENA 

de datos de aeródromo, viene dibujado un perfil del aeropuerto. Esta es la imagen: 

 

Aquí vemos que en el centro de la pista, la altura es de 90,56m, es decir la misma que tenemos en FSX. Parece que 

AENA ha tomado como referencia la altura del aeropuerto en su punto más alto, que es la cabecera de la pista 21, 

con 93,83m. Por lo tanto, no vamos a modificar la altura en FSX, y crearemos un Flatten a los 90,525m. 

Ya qué estamos, vamos a ver si las coordenadas del ARP (Airport Reference Point) son las mismas que en AENA. Lo 

único que ocurre es que en las cartas de AENA las coordenadas son sexagesimales, y en FSX decimales. No hay 

problema, buscamos cualquier conversor de coordenadas en Google. Esto es lo que nos dice AENA: 

 

Y esto FSX (dentro de ADE->Files->Airport Properties): 



 

Como vemos, está “clavado” en su sitio. Menos mal, porque mover un aeropuerto tampoco es tarea sencilla. Si 

queremos completar el cuadro de Airport Properties, tan solo dos detalles que no tienen la más mínima importancia. 

Donde pone “Mag Var” (Declinación Magnética), FSX pone 3,00, y AENA dice 2,00. Pues lo cambiamos. Y en la 

pestaña Services, que son los tipos de combustible que disponemos, según AENA solo tenemos fuel 100LL y JET A-1. 

Por lo tanto marcamos con YES solamente las casillas AV100 y JETA1, lo demás lo dejamos en NO, y le damos a OK. 

Ahora por fin vamos a meter mano a nuestro ansiado Flatten. Lo que vamos a crear es un polígono delimitado por 

esa carreterita estrecha que bordea todo el aeropuerto. En la barra de herramientas de ADE, debajo de los menús 

hay un botón con un polígono cerrado en color verde, que es “Add Polygon”.  

 

Lo pulsamos y el cursor se nos cambia a una cruz. Vamos a ir haciendo click en cada vértice de nuestro contorno, y 

en el último hacemos doble click para cerrarlo. Al cerrar se nos abre un cuadro de diálogo así: 

 

En Type seleccionamos Airport Background, y en Tag marcamos “Flatten Mask Class Map Exclude Autogen”. La 

casilla Edit Individual Points la dejamos desmarcada, y la altura dejamos la que trae, que es la del aeropuerto 

(90,525m). Damos a OK. 



 

Ese rectángulo verde es nuestro polígono de Flatten, y es la zona que quedará a 90,525m. Además de eso hace algo 

más. Como hemos seleccionado “Flatten Mask Class Map Exclude Autogen”, lo que hace son tres cosas: 

-El Flatten como hemos dicho aplana la superficie 

-El Mask Class Map lo que hace es sustituir la textura terriza que trae el escenario por defecto de FSX, que es muy 

difícil de eliminar, alrededor del aeropuerto, por una que se puede excluir cuando sea necesario. En nuestro caso 

como tenemos una imagen fotorreal no es muy necesario. 

-El Exclude Autogen lo que hace es suprimir el Autogen en la zona interior del polígono. En nuestro caso, si tenemos 

los escenarios fotorreales de AirHispania no se va a notar, porque ya están deshabiltados, pero si tenemos el 

escenario por defecto, sí que lo notaremos. 

Vamos a compilar, a ver que tal vamos. Nos vamos a llevar una ingrata sorpresa. Vamos a File->Compile Airport, le 

marcamos el directorio donde lo queremos compilar (que debe de venir por defecto en \LEBA\Scenery\) y pulsamos 

Compile. Es bueno tener cerrado el FSX cuando compilamos, ya que puede dar errores. 

Si vamos a la carpeta \LEBA\scenery, debemos de tener 3 archivos:  

-Cordoba_LEBA_background.bgl: Nuestra imagen fotorreal de fondo. 

-LEBA_ADEX_Iniciales.bgl: Lo que mantenemos del aeropuerto original de FSX. 

-LEBA_ADEX_Iniciales_CVX.bgl: El archivo de nuestro polígono de terreno flatten. 

Arrancamos el simulador y cargamos nuestro vuelo “LEBA”. Como observamos, efectivamente sí que nos ha 

aplanado el terreno, pero si nos vamos a la cabecera de la pista 03, tenemos un pequeño problema: 



 

Si os fijáis, al estar tan próxima al río, que está unos cuantos metros más bajo que el aeropuerto, nos ha creado un 

pequeño barranco justo en el borde de nuestro flatten. En nuestro caso no parece muy grave, pero puede haber 

otras ocasiones en las que el salto sea considerable. Pero ADE nos permite realizar unos pequeños polígonos con 

inclinación para poder “suavizar” éstos saltos. Lo haremos en ésta cabecera como ejemplo. En resumen lo que 

haremos será crear un nuevo polígono que comienza justo en el borde de nuestro flatten, y vamos contorneando el 

río.  A éste polígono le daremos la propiedad de editar la altura de cada vértice, y lo iremos acomodando a la altura 

que tiene en FSX. Algo así: 

 

No se si se aprecia lo que queremos hacer, espero que sí. Vamos al ADE de nuevo, y le damos Add Polygon. Creamos 

más o menos uno similar al que está marcado en rojo (sin las aristas interiores, claro está). Cuando lo cerremos y nos 



salga el cuadro de diálogo de propiedades, lo que es fundamental es marcar la casilla “Edit Individual Points”, en 

Type marcamos “Airport Background” y en Tag “Flatten”. Dejamos la altura por defecto (90,525m.). 

Ahora toca editar las alturas de los vértices del polígono que bordean el río. ¿Cómo lo hacemos? Pues abrimos FSX y 

nuestro vuelo.  Ahora en ADE seleccionamos el polígono creado, en la barra de herramientas con icono de la flecha. 

Veremos el polígono resaltado con los bordes amarillos y los vértices en verde. Nos ponemos sobre el primer vértice 

al que hay que modificar la altura, hacemos click con el botón derecho y marcamos Move Aircraft Here. 

Automáticamente nos aparece el icono del avión sobre el vértice. 

 

Hacemos doble click sobre el vértice, y nos aparece éste cuadro: 

 

Marcamos “Set Altitude To FS”, y automáticamente nos tomará la altura del simulador en ese punto. A continuación 

hacemos OK, y repetimos este mismo paso con todos los vértices del polígono que bordean el río. Los vértices que 

lindan con nuestro polígono flatten no hay que tocarlos, ya que tendrán la altura de 90,525m que le hemos marcado. 

Cuando esté listo, grabamos y compilamos (Con el FSX cerrado). Volvemos a abrir FSX y nuestro vuelo LEBA y… 
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Aunque no se aprecia mucho, ya que el barranco era pequeño, si comparamos las dos imágenes vemos como se han 

suavizado los bordes del barranco. Daros una vuelta en modo desplazamiento por alrededor del aeropuerto por si 

detectáis otros saltos en el terreno, y si queréis repetís la operación. Hasta aquí nuestro apartado de “Flatten”. 

ACTUALIZACION DEL AEROPUERTO 

Aquí comenzamos la parte más importante de nuestro proyecto. Vamos a modificar pistas, rodaduras, plataformas, y 

en definitiva todo aquello que configura el aeropuerto para adaptarlo a su situación actual. Todo ello lo vamos a 

realizar con ADE, por lo que de momento no será necesario nada más. Sí que tenemos que disponer de las cartas de 

AENA, así como la fotografía aérea actualizada para ir haciendo consultas. 

Vamos a ir viéndolo punto por punto. Abrimos ADE y nuestro proyecto tal y como lo habíamos dejado. Como no 

vamos a necesitar los polígonos de flatten que habíamos realizado, vamos a ocultarlos para así poder ver el fondo 

con la imagen aérea que nos servirá de guía. Abrimos el menú View y desmarcamos la casilla “Airport backgrounds”, 

y los polígonos verdes se ocultarán. 

Si recordáis en Lists->Project Tree, nos aparecían todos los elementos que provienen del aeropuerto por defecto de 

FSX. Cómo vamos a rehacerlo por completo, eliminaremos todo aquello que podamos, para partir de cero.  Si 

seguimos el orden del Project Tree, nos aparece: 

-Parking (0): No hay puestos de estacionamiento de aeronaves, por lo tanto no hay que eliminar nada. 

-Runways (1): Tenemos la pista 03/21, que sigue existiendo actualmente, aunque ampliada. Por lo tanto no la vamos 

a eliminar, sino que posteriormente la editaremos. 

-Starts(2): Son las posiciones de inicio para FSX cuando le indicamos que queremos aparecer en cabecera de pista. 

Tenemos una en la cabecera de la 03 y otra en la 21. Cómo éstas cabeceras se modificarán, las eliminamos. Para ello 

seleccionamos el puntero en la barra de herramientas , buscamos en el display el símbolo  , lo 

seleccionamos haciendo click en el hasta que se marque en naranja, y pulsamos Supr en el teclado. 
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-Taxi Links, Taxi Points y Taxi Signs (0): Los Taxi Links forman la red que hace que los aviones de inteligencia artificial 

de FSX se desplacen por un aeropuerto. Digamos que es un esquema de los ejes de las calles de rodadura. Estos Taxi 

Links se conectan mediante Taxi Points, que son los nodos de unión. Y los Taxi Signs son los carteles indicativos que 

nos sirven de guía para carretear por un aeropuerto. Como tenemos 0, no tenemos que modificar nada. 

                      

-Tower : Este es el punto desde el cual FSX nos toma la vista de la torre de control. La eliminamos. 

 -Image: Esta es nuestra imagen de fondo, que no la vamos a tocar para que nos sirva de referencia. 

-Library Objecs (4): Estos son objetos “tipo” de la librería por defecto de FSX. Si pinchamos para desplegar la carpeta, 

aparecen 4 objetos:  beacontower01, ndb01, small fuel station2 y vorsmalldme. 

 

Repetimos la operación que hicimos con Tower, seleccionamos cada elemento y lo borramos. 

-Shape Poly: Tenemos dos, que son nuestros polígonos de “flatten”. Los dejamos como están. 

-Fuel Trigger: Son áreas destinadas a repostaje de combustible de aeronaves. En FSX esto se hace con “Parking 

Spots” de tipo “Fuel”. Lo eliminamos. 

Nuestro “Project List” ahora debería aparecer así: 



 

A continuación iremos modificando elemento a elemento y añadiendo nuevos. Para ellos vamos a seguir el orden 

que especifica el manual de ADE.  

1.PISTA 

Por supuesto que es el elemento más importante de un aeropuerto. Lo que vamos a hacer es modificar la que 

tenemos en el aeropuerto por defecto de FSX. Ya veremos más adelante que las pistas se pueden hacer de otras 

maneras, que quizás resulten más atractivas visualmente, pero primero vamos a hacerla con ADE. Seleccionamos la 

pista con el puntero hasta que se quede resaltada en amarillo, y hacemos click derecho->Edit Object. Nos aparecerá 

el cuadro de diálogo “Properties”. 

 

Vemos que tiene 6 pestañas en su parte superior: Runway, Pattern, Markings, Lights, Primary y Secondary. La 

pestaña Runway es la que contiene las características principales de la pista (número de pista, tipo de superficie, 

dimensiones y localización). Como vemos, el número de la pista primaria es la 03 y la secundaria es la 21. Esto no ha 

cambiado en Córdoba (recordemos que los designadores de pista varían con el tiempo debido a la declinación 
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magnética.). En la casilla “Designator” lo dejamos en NONE, esto se aplica cuando hay pistas paralelas en grandes 

aeropuertos, dónde cada una añadirá al número de pista un designador (L,R o C habitualmente), indicando si es la 

izquierda, derecha o centro. Como LEBA es pequeño, no tendremos que añadir nada. A continuación  tenemos que 

indicarle el tipo de superficie, que está indicado como “Asphalt”. Si vamos a la carta de AENA, la pista sigue siendo 

de asfalto, pero si nos fijamos en la foto por satélite, vemos que es un asfalto nuevo y oscuro. En FSX tenemos 21 

tipos de materiales para superficies de pistas, aunque algunas coinciden entre sí, o por lo menos yo no soy capaz de 

distinguirlas. Son éstas: 

 

Parece que la más parecida es la 14. Bituminous, así que elegiremos ésta. No es que sea perfecta, pero de momento 

nos valdrá. 

 Y ahora tenemos las dimensiones. Esto sí que ha cambiado, en cuánto a longitud. La anchura real es de 45 m., y aquí 

tenemos 45,10 m. Podemos dejarla como está o modificarla, son solo 10 cms. Según AENA, la pista 03 tiene 2.050 m. 

de longitud y la 21, 2.241 m.¿ Porqué ésta diferencia?. Muy sencillo, eso es debido al umbral desplazado que 

tenemos en la 21. Vamos a aclarar un poco éste asunto de las dimensiones. Todas las pistas tienen 4 distancias 

diferentes, que son la TORA (Take Off Run Available), la TODA (Take Off Distance Available), la ASDA (Accelerate Stop 

Distance Available) y la LDA (Landing Distance Available). Las tres primeras corresponden a distancias de referencia 

para despegues y la última para aterrizajes. La diferencia entre unas y otras se hallan básicamente en tres 

elementos: las CWY (Zona Libre de Obstáculos), las SWY (Zona de parada) y los umbrales desplazados. Estos pueden 

o no estar presentes en una pista determinada. Tendremos: 

TORA = Distancia entre umbrales (en la mayoría de los casos, aunque para despegues se puede utilizar la distancia de 

umbral desplazado) 

TODA=TORA+CWY 

ASDA=TORA+SWY 

LDA= Distancia que se ha declarado disponible para el recorrido en tierra de un avión que aterriza. 

 AENA indica las dimensiones de una pista por la mayor de cada una de estas distancias que hemos visto en esa pista. 

En nuestro caso tenemos: 
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Como vemos la parte de umbral desplazado se puede emplear para despegues desde la 21, y parte de ese umbral 

desplazado se puede emplear para aterrizajes por la 03. 

Recordamos que el umbral desplazado es parte de la pista, aunque no se pueda emplear para algunas situaciones 

(aterrizajes por la 21). Por lo tanto nuestra pista 03/21 que vamos a dibujar en ADE será de 2.241x45 m. 

Introducimos esas cantidades en el apartado “Width” y “Lenght” y pulsamos en OK. 

 



Vemos que la longitud de pista se ha alargado, sin embargo no está bien situada. Esto es debido a que en ADE las 

coordenadas de la pista vienen referenciadas al centro de la misma. En nuestro caso, el centro de la pista se ha 

desplazado del original, debido a que se ha ampliado más por un extremo que por el otro. Por lo tanto tendremos 

que moverla a mano. ¿Cómo lo hacemos para que al moverla no se nos desplace lateralmente?. Lo haremos con la 

ayuda de dos herramientas muy prácticas, los “Position Markers” ( ) y las “Guidelines” ( ). Ambas se hallan 

en la barra de herramientas. Lo primero que haremos será hacer zoom hasta el máximo nivel en la cabecera de la 03, 

y situamos una Position Marker justo en el eje de la primera línea de eje central de la pista. Hacemos lo mismo con la 

cabecera de la 21. 

 

Volvemos a ampliar al máximo la cabecera de la 03 y comenzamos a dibujar una Guideline, haciendo click en la 

marca de posición. Sin soltar el botón del ratón, hacemos zoom atrás con la rueda y ampliamos la cabecera de la 21 y 

soltamos el botón del ratón cerca de la marca (no hace falta que coincida, ahora la ajustaremos). Para ajustarla a la 

marca, seleccionamos la línea de guía hasta que esté en amarillo, y veremos un circulo pequeño sobre la flecha. 

Pinchamos y arrastramos hasta que hagamos coincidir el eje de la línea con la marca. 

 

A continuación seleccionamos la pista, y hacemos zoom en la zona del umbral de la 03, y vamos desplazando con el 

ratón sin soltar hasta que hagamos coincidir los dos umbrales, fijándonos bien en que las líneas de eje de pista estén 

centradas con nuestra línea de guía roja, y comprobamos que la cabecera de la 21 esté en su sitio también. 
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Ya tenemos la pista con sus dimensiones reales, dispuesta en su localización real y centrada en el eje. Pero lo que 

ocurre es que tenemos diferencias con la real. No tenemos umbral desplazado, no vemos las marcas de umbral de 

pista, etc. Vamos en la medida de lo posible a corregir esto. Recordemos que con ADE no tendremos una copia 

exacta de las marcas de la pista real, pero intentaremos aproximarnos al máximo. 

En el cuadro de diálogo “Properties” de la pista, a continuación de la pestaña “Runway”, tenemos “Pattern”. Aquí le 

indicamos al simulador qué pistas son aptas para aterrizajes y despegues, así como la dirección de los giros en el 

circuito de tráfico de aeródromo y la altura a la que hay que realizar dicho circuito. Si miramos en la documentación 

de AENA, en AD-2-LEBA 4, y en la carta de aproximación visual al aeródromo: 

 

Vemos que ambas pistas son válidas para despegues y aterrizajes, los giros para la 03 son a izquierdas y para la 21 a 

derechas, y que la altura del circuito son 1000 ft. AGL. Nos quedará algo así: 



 

La tercera pestaña es “Markings”, y sirve para indicar qué tipo de marcas usarán nuestras pistas. Si queréis tener un 

documento donde vienen especificadas las marcas y señales que suelen usarse en pistas, os recomendaría que os 

descarguéis y miréis el documento “Síntesis de señales visuales en tierra”, que tenemos en el apartado 

“Documentos” de las Publicaciones de AirHispania. En concreto, para nuestro caso de Córdoba, tenemos: 

-Marcas de umbral de pista: Tenemos en la 03 y en la 21. 

-Señal designadora de pista: Es la numeración. Las dos tienen numeración. 

-Faja lateral de pista: A lo largo de toda la pista. 

-Señales de eje de pista: A lo largo de toda la pista. 

- Señal del punto de visada: Son dos fajas rectangulares anchas, en el punto teórico donde acaba la senda de 

aproximación. Tenemos en la 03 y en la 21. 

-Señales de toma con clave de distancia: Son pares de marcas rectangulares situadas a 150 m. de distancia entre 

ellas. Lo tenemos en la 03 y en la 21, aunque con ligeras diferencias. 

-Señales de umbral desplazado: Lo tenemos en la 21. 



 

Si nos vamos a “Properties” de la pista, en la tercera pestaña, llamada “Markings”, deberíamos de marcar así: 

 

Es lo más parecido que podemos tener a la imagen real de la pista, aunque no nos coincidirá al 100%. Ojo, que en la 

representación de ADE no nos dibuja todas las marcas, digamos que hace un esquema. Para ver como quedan 

tenemos que compilar e irnos al simulador. Lo haremos un poco más tarde. 

La cuarta pestaña de “Properties” es “Lights”, donde intentaremos buscar la iluminación de pistas más aproximada 

posible a lo que nos indica AENA. Existen infinidad de tipos de iluminación en una pista, que se suelen agrupar en 

dos tipos: iluminación de aproximación e iluminación de pista. Podéis consultar en Internet, pero si nos centramos 

en Córdoba tenemos: 



 

Eso es un esquema de cómo debería quedar. 

Ya sólo nos quedan dos pestañas, “Primary” y “Secondary”, donde le indicaremos para cada pista (en nuestro caso la 

Primary es la 03 y la Secondary la 21), las zonas de Blastpad/Overrun si las tuviera, la disposición de los sistemas 

VASI/PAPI y la longitud de los umbrales desplazados. En nuestro caso, y con la documentación de AENA por delante: 

 

En nuestro caso, no tenemos zonas de Blastpad/Overruns, así que nos centramos en los VASI/PAPI y en el umbral 

desplazado de la 21. Según AENA, el sistema VASI/PAPI de LEBA es un PAPI de 4 luces, por lo tanto PAPI4. En Edge 

tenemos que indicar la distancia desde el borde de la pista hasta el eje de la primera luz de PAPI. Esto lo podemos 



medir bien en SAS Planet o en Google Earth, resultando 15 metros. En THold es la distancia desde el umbral de cada 

pista al eje de las luces PAPI. Midiendo nos sale 295 metros para la 03 y -45 para la 21 (El PAPI en este caso está 

antes del umbral de pista). Spacing se usa para sistemas VASI y es la distancia entre barras. En Pitch el ángulo de la 

senda, que AENA marca como 3 grados. 

Por último, el Offset Threshold es la distancia desde el inicio de pista hasta el umbral desplazado, que según AENA es 

de 591 metros. Sólo lo marcamos en la pista 21, por lo tanto en la pestaña “Secondary”. 

Con esto ya tenemos nuestra pista finalizada. Grabamos el aeropuerto y compilamos a ver que pasa. 

 



2.PLATAFORMAS 

Las plataformas son todas aquellas zonas destinadas al estacionamiento de aeronaves, de las parten las calles de 

rodadura. En éste caso, con ADE, además de realizar las plataformas en sí, realizaremos otras zonas que 

complementan el aeropuerto, tales como los apartaderos que existen en las cabeceras de pista, las bandas que 

existen a ambos lados de la pista y las zonas de seguridad de las pistas. Aunque sabemos que no son plataformas 

propiamente dichas, las asimilaremos como tales. 

Empezamos observando la fotografía aérea con el SAS Planet. Tiene mucha más resolución que la que usamos en 

ADE y nos servirá para observar la configuración de las plataformas. En la zona de plataforma observamos que hay 

dos diferenciadas por un cambio de tonalidad, una con asfalto algo más oscuro y otro más claro. 

 

De momento nos olvidaremos de las superficies de apoyo de los edificios y la terminal, ya los haremos más tarde. 

Fijaros que en la plataforma 1, nos hemos introducido un poco en la calle de rodaje. Esto es porque en las calles y 

debajo de la pista crearemos como otra plataforma, ésta con un tono más oscuro. 

 

En principio éstas serán nuestras 5 plataformas. Pensamos en que materiales podemos aplicarles, sabiendo que las 

texturas son las mismas 21 que existen para pistas. Creo que lo que mejor se adapta es: 

PLATAFORMA 1: ASPHALT 

PLATAFORMA 2: BITUMINOUS 

PLATAFORMA 3: BITUMINOUS 

PLATAFORMAs 4 y 5: ASPHALT 

Ahora a dibujar en ADE.  Lo primero que vamos a hacer es ocultar los molestos iconos de las dos radioyudas que 

tenemos en Córdoba, el VOR y el NDB. Para ello vamos a View->Desactivamos la casilla Navaids.  
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Si ampliamos el Display en la zona de plataformas, nos damos cuenta que la resolución que tiene la imagen de fondo 

no es demasiado precisa. Esto es porque ADE nos limita estas imágenes a 7Mb., por lo que no podemos poner toda 

la zona en alta resolución. Pero podemos hacer una cosa. Ahora mismo nos interesan las zonas de plataforma y 

calles A y B, y las cabeceras de las pistas. Vamos a descargarnos de SAS Planet unas imágenes parciales de esas 

zonas, a un zoom de 20, con sus correspondientes archivos .dat para poder colocar las fotos adecuadamente y 

tendremos mucho más detalle. No importa que se solapen. Yo voy a descargarme estas fotos: 

 

Para incorporar éstas imágenes a ADE, mirad el capítulo de Añadir Imagen de Fondo, y lo repetimos para nuestras 

nuevas 6 imágenes, apoyándonos en los ficheros de coordenadas .dat. 

Ahora si ampliamos con zoom estas zonas notaréis un cambio brutal en la resolución. Recordad que éstas imágenes 

son solamente de apoyo y no se compilan, con lo que no aumentaremos el peso del archivo de escenario .bgl. 

A continuación vamos a girar el Display para intentar que nuestra pista la veamos en posición más o menos 

horizontal. Pulsando CTRL y girando la rueda del ratón, vamos rotando de 5 en 5 grados, y pulsando SHIFT y 

moviendo la rueda, rotamos de 1 en 1 grado. Nos podemos apoyar en uno de los márgenes inferiores para intentar 

dejarlo lo más horizontal posible. Algo así: 



 

Vamos con la plataforma 1. Para ello vamos a la barra de herramientas a , y seleccionamos como 

material en la pestaña desplegable “ASPHALT”. A continuación pulsamos en el icono de la izquierda para añadir la 

plataforma. El cursor cambia a una cruz de color negro. Ahora haciendo zoom en la zona que queremos vamos 

haciendo clics en los vértices, creando un polígono. Intentar no quedaros cortos en el dibujo, y no os preocupe que 

los vértices no queden alineados en un principio. En el último vértice haced doble clic y se os cerrará el polígono. 

Ahora veréis que el polígono se rellena y nos cubre la imagen de fondo. Para continuar viéndola, seleccionad el 

polígono y pulsar MAYUS+O, y se irá haciendo transparente progresivamente. A mí me ha quedado así: 

 

Si observáis que alguno de  los vértices no están bien alineados, podéis corregir su posición con ayuda de las líneas 

de guía. Para ello, vamos a crearla apoyándonos en las marcas de eje de pista. Hacemos zoom en el centro de la 

pista, seleccionamos la herramienta “Add Guidelines”, y pinchamos justo en el centro de una de las marcas de eje de 

pista. Lo prolongamos una longitud adecuada, y hacemos zoom en el otro extremo de la línea de guía. La 

seleccionamos y arrastramos el icono del círculo pequeño hasta que quede justo en el centro del eje. Ahora 

quitamos el zoom, y arrastramos nuestra línea de guía hasta el vértice superior izquierdo de la plataforma. Ahora lo 



que tenemos que ir haciendo es ir seleccionando los vértices de la plataforma que corresponden a esa alineación y 

desplazarlos un poco hasta que “pisen” nuestra guía. 

Id repitiendo este proceso con todas las líneas horizontales. Para las verticales crearemos una línea de guía vertical 

apoyándonos por ejemplo en la marca de umbral de pista y hacemos lo mismo. Sacad a relucir vuestra vena artística. 

Creamos las 5 plataformas de la misma forma, y al acabar, si vamos a Lists->Aprons, tendremos algo así: 

 

Grabamos, compilamos y arrancamos el simulador a ver qué tal nos ha ido. 

 



A continuación, y para terminar con las plataformas, también podemos agregar luces de borde en el perímetro. Si 

miramos la documentación de AENA, vemos que Córdoba cuenta con dichas luces. Pero sólo la añadiremos en las 

plataformas 1 y 2, delimitando lo que es el contorno estricto de las superficies donde estacionan los aviones. Para 

añadir luces de borde de plataforma pinchamos en la barra de herramientas en el icono , a la izquierda de los 

iconos de plataformas. Lo que dibujaremos será una línea poligonal, apoyándonos en los bordes de las plataformas 

que hemos dibujado, pero siempre por el interior de las mismas , y hacer doble clic en el último vértice. En ésta 

ocasión no se nos cierra el polígono. 

 

Ahora si hacemos doble click en la línea de luces, nos aparecerá el cuadro de propiedades. Yo he medido en la foto 

por satélite la distancia entre luces, y me sale aproximadamente 20 m. Las luces de borde de plataforma suelen ser 

azul, así que quedará así: 

 

Sí queréis ver una simulación de cómo os quedarán en visión nocturna, podemos ir a View->Marcamos Night 

Lighting. Si queréis compilad de nuevo e ir probando. 



 

3.PUESTOS DE ESTACIONAMIENTO 

Los puestos de estacionamiento son los que nos van a permitir establecer las posiciones de inicio cuando iniciamos 

un vuelo en FSX. De todos es sabido que está totalmente prohibido en AirHispania el conectarse a l

online en las cabeceras de las pistas, así que siempre nos debemos de posicionar en un puesto de estacionamiento. 

Normalmente en la documentación del AIP de AENA vienen descritas las plazas existentes en cada aeropuerto. Este 

no es el caso de Córdoba, que al ser tan pequeño no aparecen. De todas formas, si miramos en la foto por satélite 

(seguimos recomendando la de Bing Maps por su alta definición), nos damos cuenta que en la Plataforma A, 

aparecen dos puestos, para aviones medianos. También

estacionadas y ordenadas. Vamos a aprovecharnos de eso, y crearemos esas.

Nos vamos a la pestaña desplegable de la barra de herramientas, junto al icono 

las dos posiciones más grandes escogere

hacemos click en donde queramos acomodar nuestra plaza. Para las pequeñas escogeremos “Ramp GA Small”, y 

repetimos. Las vamos colocando guiándonos por la imagen de fondo

debemos editarlas. Por ejemplo, seleccionamos el Parking 2:

Los puestos de estacionamiento son los que nos van a permitir establecer las posiciones de inicio cuando iniciamos 

un vuelo en FSX. De todos es sabido que está totalmente prohibido en AirHispania el conectarse a l

online en las cabeceras de las pistas, así que siempre nos debemos de posicionar en un puesto de estacionamiento. 

Normalmente en la documentación del AIP de AENA vienen descritas las plazas existentes en cada aeropuerto. Este 

e Córdoba, que al ser tan pequeño no aparecen. De todas formas, si miramos en la foto por satélite 

(seguimos recomendando la de Bing Maps por su alta definición), nos damos cuenta que en la Plataforma A, 

aparecen dos puestos, para aviones medianos. También vemos que en la Plataforma B hay muchas avionetas 

estacionadas y ordenadas. Vamos a aprovecharnos de eso, y crearemos esas. 

Nos vamos a la pestaña desplegable de la barra de herramientas, junto al icono 

las dos posiciones más grandes escogeremos “Ramp GA Medium”. Pulsamos en el icono verde “Add Gate”, y 

hacemos click en donde queramos acomodar nuestra plaza. Para las pequeñas escogeremos “Ramp GA Small”, y 

Las vamos colocando guiándonos por la imagen de fondo. Cuando tengamos  las 2

debemos editarlas. Por ejemplo, seleccionamos el Parking 2: 

 

Los puestos de estacionamiento son los que nos van a permitir establecer las posiciones de inicio cuando iniciamos 

un vuelo en FSX. De todos es sabido que está totalmente prohibido en AirHispania el conectarse a la red de vuelo 

online en las cabeceras de las pistas, así que siempre nos debemos de posicionar en un puesto de estacionamiento. 

Normalmente en la documentación del AIP de AENA vienen descritas las plazas existentes en cada aeropuerto. Este 

e Córdoba, que al ser tan pequeño no aparecen. De todas formas, si miramos en la foto por satélite 

(seguimos recomendando la de Bing Maps por su alta definición), nos damos cuenta que en la Plataforma A, 

vemos que en la Plataforma B hay muchas avionetas 

 

, y para 

mos “Ramp GA Medium”. Pulsamos en el icono verde “Add Gate”, y 

hacemos click en donde queramos acomodar nuestra plaza. Para las pequeñas escogeremos “Ramp GA Small”, y 

. Cuando tengamos  las 26 plazas colocadas, 
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Vamos a ir rellenando las casillas. En “Name”, escogemos “Parking”, en “Number”, el número 2, en “Type”, 

“Ramp_GA_Medium”, en “Radius”, ponemos 12,5 metros, ya que vemos en el suelo del aeropuerto un enorme 

cartel donde indica “Max Span 25 m”, es decir que la envergadura máxima para esas plazas no puede exceder de 

12,5 metros de radio. Los “Tee Offsets” son las marcas en T donde finaliza el aparcamiento. Podemos poner hasta 4, 

pero en éste caso no será necesario. En “Pushback Direction”, lo dejamos en “None” (Esta característica no tiene 

efecto en FSX), en “Airlines” lo dejamos tal cual, ya que esto es para asignar aerolíneas concretas o tipos de avión 

específicos  de inteligencia artificial para cada plaza, y por último las coordenadas, que no tocaremos. Por último en 

“Heading” se coloca al rumbo en el que se va a situar el avión en su posición de inicio. Yo he tomado la de la pista, 

pero en sentido opuesto.  Repetimos la operación para cada una de las plazas, yo en las pequeñas he ido variando 

los radios en 8 y 10 metros. Con paciencia os quedará algo parecido a esto: 

 

Si vamos a Lists->Parkings veremos un listado de todas las posiciones que tenemos. Grabamos y compilamos. 

4.VISTA DE TORRE 

En todos los aeropuertos de FSX debe existir una vista desde la torre de control, ya que entre otras cosas es el punto 

desde el cual FSX nos sitúa si elegimos esa vista. Además sirve para algunos añadidos que utilizan esa vista para 

tomar posiciones de ATC y controlar de una manera más realista (creo que IVAO la usa). Situar ésta vista en nuestro 



aeropuerto es muy simple, la única duda que podemos tener es a qué altura está la torre de control. Vamos a ver un 

pequeño truco para calcular alturas desde fotografías, que nos será especialmente útil cuando estemos modelando 

los edificios. Lo primero que tenemos que buscar es una foto en Internet de la torre de control. Tecleando en Google 

“torre de control aeropuerto de Córdoba”,  y vamos a imágenes nos saldrán un montón. Nos conviene buscar una 

que sea más bien frontal, que no haya mucha perspectiva que deforme la imagen y nos sirva para tomar medidas.  

Yo he encontrado ésta: 

 

Abrimos la imagen con Photoshop. Anotamos los valores que nos resultan. A mí me han salido para la medición 

horizontal 115,24 píxeles, y para la altura 334,15 píxeles. 

 

Ahora abrimos SAS Planet o Google Earth o cualquier programa que nos permita medir fotos aéreas. 



 

Tenemos 4,88 m. Sólo nos queda hacer una regla de tres, que para eso se inventaron. Si 115,24 píxeles representan 

4,88 metros, 334,15 metros nos representan 14,15 metros de altura. Ya la tenemos. 

Bueno ,pues en ADE, nos situamos con el cursor sobre la posición de la torre de control, que localizaremos con la 

ayuda de nuestra imagen de fondo. Hacemos click derecho->Add->Tower, e introducimos la altura. Una cosa menos. 

 

5.POSICIONES DE INICIO 

Debemos establecer las posiciones de inicio en cabeceras de pista, para que en FSX podamos seleccionarlas, siempre 

que volemos offline, recordad. No hay mucho que comentar, simplemente en cualquier punto de la pantalla de ADE, 

hacemos click derecho->Add->Runway Start, y seleccionamos la pista 03. A continuación repetimos para la 21. 

Fijaros que por defecto la posición de inicio en la 21 la establece al comienzo de la zona de umbral desplazado, ya 

que esa parte es utilizable para despegues. Si queréis desplazarla al umbral, solo tenéis que seleccionarla y arrastrala 

a la nueva posición deseada. 
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6.RED DE CALLES DE RODAJE 

Este es el apartado fundamental de ADE, donde vamos a crear un entramado de calles de rodaje por donde 

circularán en FSX los aviones de inteligencia artificial AI, pero además, nos servirá para dibujar marcas en el 

pavimento (ejes de calle, bordes de calle), así como iluminaciones de las mismas. Ojo con este paso, que nos va a 

determinar si un diseño es adecuado o no. Si no dibujamos bien las calles, se nos creará como una especie de tela de 

araña de marcas innecesarias, así como ralentizará el movimiento de aviones de AI. Hay mil maneras de hacerlo, yo 

os intentaré explicar el que yo uso.  

En primer lugar, debemos de saber qué es  y cómo funciona el sistema de calles en FSX. Este está basado en nodos y 

enlaces (Taxi points y Taxi Links respectivamente). Entre dos nodos siempre habrá un enlace. Ahora bien, existen 

varios tipos de nodos y de enlaces. 

 

Los Taxi Points son: 

1.Normal Taxi Point: Es el que se usa habitualmente para todo tipo de conexiones, tanto en pistas, calles y 

plataformas.  

2.Hold Short Taxi Point: Es el que crea las marcas de punto de espera en las cabeceras de las pistas. 

3. ILS Hold Short Taxi Point: Es una marca especial de punto de espera. 

 

             Normal Taxi Point                                 Hold Short Taxi Point                          ILS Hold Short Taxi Point 
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Los Links pueden ser: 

1. Taxiway Link: El usado en calles de rodaje propiamente dichas, dibujan textura de suelo, marcas y luces. 

2.Apron Link: Se usa como circulación interior en plataformas, y para unión de los puestos de estacionamiento a la 

red de calles. No dibuja textura de suelo, pero sí marcas y luces. 

3.Runway Link: El que se usa longitudinalmente en la pista de aterrizaje, ya que por la pista también se puede rodar. 

No dibuja ni textura de suelo, ni marcas ni luces, ya que las marcas de pista que especificamos anteriormente en el 

apartado “Runway” son las que quedarán dibujadas. 

4.Closed Link: Se usa para dibujar calles cerradas a tráfico. Similiar a Taxiway Link, pero dibuja marcas en forma de X. 

5.Vehicle Links: Se usa para el tráfico de vehículos auxiliares por el aeropuerto. 

6.Parking Link: Este tipo no se puede seleccionar, ya que ADE lo elige automáticamente cuando cualquiera de los 

anteriores conecta con una plaza de estacionamiento. 

 

Como hemos comentado anteriormente, la red de calles tiene dos objetivos en FSX: 

1.Asegurar un correcto movimiento en superficie de los tráficos de inteligencia artificial AI, es decir que haremos que 

los aviones AI circulen por el camino que hemos diseñado en nuestra red. 

2.Dibujar marcas de ejes, bordes, luces, etc, es decir el componente artístico de todo esto y lo que realmente 

nosotros veremos en el simulador. 

Con respecto al punto 1, tened en cuenta que para que los tráficos circulen fluidamente no debe de existir una red 

“sobrecargada” de nodos, ya que su movimiento se ralentiza bastante. Además, deberá de existir como mínimo un 

Parking Link, un Taxi o Apron Link y un Runway Link para que todo funcione como es debido. De todas formas, no 

nos vamos a preocupar mucho de éste primer aspecto de la red de calles. 

NOTA IMPORTANTE: El paso que vamos a hacer a continuación (punto 2), podemos omitirlo si queremos crear 

nuestras marcas de pista y rodadura con Ground Polygons, que veremos más adelante. No obstante, podéis hacerlo 

para que os sirva de práctica y saber su funcionamiento. Si después optáis por los Ground Poly, bastaría con eliminar 

toda ésta red de enlaces “decorativa”. La que sí tenemos que hacer es la del punto 1 que hemos comentado. 

El punto 2 es sobre el que vamos a concentrar todos nuestros esfuerzos. Vamos a intentar plasmar de la forma más 

fiel posible las marcas existentes en el aeropuerto real de Córdoba al que nosotros estamos diseñando para FSX. Ya 

os adelanto que es totalmente imposible el hacerlo exactamente igual. Habrá cosas que no podamos hacer con la 

red de calles (por ejemplo las marcas rojas de las zonas prohibidas). Además os daréis cuenta que ADE tiene una 

forma un tanto peculiar de tratar las uniones de varios enlaces, en lo que a dibujo de marcas se refiere. Y recordad 

que no siempre se verá en el display de ADE el resultado definitivo en FSX, por eso éste apartado necesita algo más 

de paciencia, e ir compilando frecuentemente y comprobar resultados en el simulador. Método de prueba y error. 



Vamos a tomar papel y lápiz, y dibujar un croquis lo más detallado posible de la plataforma del aeropuerto. Para ello, 

si nos fijamos en la imagen de SAS Planet, por todo el borde de la plataforma discurre una doble línea amarilla. Ese 

es el contorno que tenemos que dibujar. Lo ideal es tomar medidas de cada arista de ese polígono de borde y 

hacerlo más o menos a escala. Si tenéis algún software de CAD también podéis hacerlo. 

Ahora fijaros en las líneas de eje de calle que discurren por la plataforma. Es una línea amarilla bordeada con negro. 

                      Línea de borde de plataforma                    Línea de eje de calle de rodaje  

Tenemos que dibujar esas líneas de eje también en nuestro croquis. Algo así: 

 

Hacemos lo mismo con la pista, marcando únicamente lo que es el recorrido de rodaje. 

 

Bien, ese es el trazo que queremos dibujar. En primer lugar vamos a colocar los nodos, para posteriormente ir 

uniéndolos con enlaces del tipo que correspondan. Todos estos nodos son del tipo “Normal Taxi Point”, así que 

seleccionamos su icono y empezamos. Podéis hacerlo a vuestra forma, yo he elegido éste método, en función de los 

distintos casos que se nos presentan: 

a)Tramo recto continuo: Pinchamos un nodo en cada extremo. 

b)Curva simple: Colocamos un nodo al inicio de la curvatura y otro al final: 



 

c)Curva triple o isleta: Colocamos un nodo al inicio de cada curvatura, y dos o tres intermedios, dependiendo de la 

longitud de la curva. Más adelante veremos porqué lo hacemos así. 

 

d)Doble curva o empalme en T: Colocamos un nodo en cada vértice del triángulo que forma la T: 

 

De éste tipo también tenemos uno que no conecta el tramo horizontal, aunque lo dibujamos igual: 

 



e)Curva múltiple en apartaderos de espera: Colocamos varios nodos siguiendo el contorno de la curva. Fijaros que la 

terminación de la línea de eje no coincide con la de eje de pista, está ligeramente desplazado a la derecha. 

 

f)Tramos donde desaparece la línea de eje amarilla: Esto ocurre en la pista. Si os fijáis en la imagen por satélite, 

veréis que la línea de eje no transcurre continua por toda la longitud de pista, hay tramos en los que desaparece y 

vuelve a aparecer. Bien, pues ponemos un nodo en cada uno de los inicios y fin de tramo de línea. 

 

A mí me ha quedado algo así en la zona de plataformas: 



 

Y en las pistas: 

 

 

A continuación lo que vamos a hacer es unir esos nodos mediante los correspondientes enlaces. Se trata de hacer 

como el pasatiempo antiguo que consistía en unir puntos hasta que apareciera una figura. ¿Qué tipo de enlaces 

vamos a necesitar? Pues en un primer momento, los vamos a hacer con Apron (Paths) Links, debido a que éstos no 

dibujan una superficie sobre la que tengamos, y nuestro objetivo aquí recordad que es exclusivamente el dibujo de 

las líneas de eje. Marcamos el icono de “Apron Link”, y en la persiana desplegable de la derecha, ponemos 10,00 

metros, que será el ancho que le demos a las calles. No nos va a afectar ese ancho en casi nada, a excepción del 

radio de curvatura que le queramos dar a las uniones. ADE considera el ancho de calle como el radio de la curva que 

une dos puntos no alineados. 

 

Id enlazando todos los nodos, pero tened cuidado de que se os resalte cada uno al ir pintando el enlace, así nos 

aseguramos que los nodos quedan unidos. También sería conveniente que bloquearais todos aquellos elementos de 

nuestro aeropuerto que no deseamos que se muevan accidentalmente. Para ello, vamos a Lock->Marcamos todo 

excepto Taxiways. 

Finalmente tendremos algo parecido a esto: 



 

 

 

Ahora vamos a eliminar las líneas de bordes de calle, y nos quedaremos sólo con los ejes. Iremos a Lists->Taxi Links, y 

nos aparecerá el cuadro de diálogo con un listado de todos nuestros enlaces. 

 

Pinchamos en Select All, y a continuación Edit. Nos aparece el cuadro de Multiedición: 



 

Aquí editaremos los campos Center Line Lights (NO), Left Edge (NONE), Left Edge Lights (NO), Right Edge (NONE) y 

Right Edge Lights (NO). Con ésto haremos desaparecer las líneas de borde y sus correspondientes luces, y 

mantenemos las de eje. Grabamos, compilamos y sería interesante también cerrar ADE y volver a abrirlo, ya que 

muchas veces, cuando hacemos cambios de éste tipo, en el display no se redibujan hasta que reiniciamos el 

programa. 

Ahora veremos algunas cosas “extrañas”. Por ejemplo, la isleta central entre plataformas: 

 

Observad dos cosas: primero, en FSX nos dibuja unos empalmes que no deberían estar, que coinciden con los nodos 

a los que llegan 3 enlaces, y segundo que en ADE aparecen unas extrañas líneas rectas que después no figuran en 

FSX. ¿Por qué ocurre esto?. Pues simplemente porque el modo de dibujar de ADE es un tanto peculiar, ya lo 

comentamos antes. Si a un nodo acometen más de dos enlaces, ADE siempre dibujará uniones entre los 3 enlaces, 

aunque a nosotros sólo nos interese unir dos de ellos. 

 



Esto que parece una tontería, no es tan sencillo de solucionar. O sí lo es, cuando le cogemos algo de práctica. La 

clave está en que si queremos prescindir de un empalme, primero debemos identificar que enlaces son los que no 

queremos unir. En nuestro caso, está claro que los enlaces que no queremos unir son los que forman los brazos de la 

Y, mientras que sí nos interesan el que forma la base con un brazo, y la base con el otro. Pues a esos dos enlaces 

debemos de suprimirles la línea de eje. 

 

Para suprimir la línea de eje, simplemente seleccionamos cada enlace y lo editamos, desmarcando la casilla “Center 

Line” y “Center Lights”. Pero ahora tenemos otro problema, y es que al suprimir esos ejes, la nueva línea de eje no 

llega hasta los nodos extremos. Esto se debe a otra peculiaridad de ADE, y es que cuando en un nodo convergen 3 

enlaces, y dos de ellos no tienen eje, automáticamente ADE prolonga el eje principal que sigue existiendo una 

longitud igual al ancho de calle que tengamos. Sé que es difícil de pillarlo. Por ejemplo, si en nuestro caso tenemos 

que el ancho de las calles son de 10,00 metros, el eje que queda (el de la base de la Y), se adentra en ambos brazos 

de la Y una distancia de 10,00 metros. 

 

Para arreglar éste problema, podemos hacer dos cosas, o bien acercamos los dos nodos de los extremos de los 

brazos de la Y hasta que estén sobre el final de la prolongación de los ejes “intrusos”, y continuar dibujando nodos a 

partir de ahí, o bien creamos unos nodos intermedios en esos puntos. Desde esos nodos hacia los extremos de la Y 

se nos crean dos nuevos enlaces, a los que sí le marcaremos “Center Line” en sus propiedades. 



 

El resultado final es lo que andábamos buscando: 

 

Bueno, pues éste caso también se nos va a dar en la situación en la cual tengamos que dibujar calles de rodaje, con 

un ancho determinado, y nos aparezcan empalmes indeseados en dichas calles. (en LEBA no tenemos por suerte). 

Tendremos que hacer algo parecido. Os recomendaría encarecidamente que os leáis este documento, que aunque 

está en inglés, y con un lenguaje algo espeso, nos puede solucionar muchos problemas de aspecto: 

http://www.fsdeveloper.com/downloads/adding_realism_to_airports_tutorial.pdf 

Practicad mucho y veréis como al final le pilláis el truco. 

Además de la isleta central, tenemos este mismo problema en todas las uniones en T, que son unas pocas, pero la 

solución es la misma. Recordad de id compilando y probando en FSX de vez en cuando, e ir reiniciando ADE cuando 

modifiquemos para actualizar el display.  

Sigamos. Una vez que tengamos solucionados todos los empalmes, debemos de crear los puntos de espera que 

existen en las calles de rodaje A y B. Para ello, introducimos un nodo de tipo “Hold Short Taxi Point”, justo en su 

posición.  



 

Pero además, como véis en la foto, al tener un ancho de calle de 10,00 metros, la barra de espera se nos queda 

corta. Seleccionamos los 4 enlaces que llegan a éste nodo y los editamos, modificando la anchura a 17,00 metros, 

que es la que nos marca AENA. También vemos que el nodo de la calle A tiene mal orientada las barras. 

Seleccionamos el nodo, lo editamos y en “Orientation” ponemos “Reverse”. 

Si nos fijamos en la pista, vemos que hay tramos que no van dibujados, ya que la línea de ejes aparece y desaparece. 

Pero como hemos dibujado todos los nodos que corresponden a los extremos, podemos eliminar los enlaces que no 

nos interesan. Prestad atención a que la línea de ejes quede un poquito desplazada del eje de pista, ya que en la 

realidad está de esa forma. 

Para terminar nuestra red “decorativa”, nos falta dibujar las marcas que existen en la zona de parking de la 

plataforma A. Aquí lo que nos interesa es que al dibujar esos enlaces, no queden unidos  con las plazas de 

aparcamiento. El enlace con estas plazas lo realizaremos posteriormente de otra forma. Para conseguir que no se os 

unan, dibujad por fuera del círculo verde que delimita las plazas, y después desplazad los enlaces hasta su posición, 

ya que si intentáis dibujarlos dentro del círculo, quedarán automáticamente unidos. 

 

Siempre que queráis dibujar enlaces y que no se os unan por proximidad a otro enlace existente, dibujadlos 

separados, y después lo seleccionáis y arrastráis a la posición deseada. Así nos saltaremos el molesto “snap” que ADE 

nos impone. Por ejemplo, fijaros en el enlace de la esquina inferior izquierda. Realmente ahí existen dos nodos muy 



juntos, por lo que lo hemos dibujado anteriormente alejado y arrastrado después a su posición. Si nos uniera ambos 

enlaces, nos dibujaría una curva de empalme que realmente no existe. 

Para terminar nuestra trama decorativa, podemos también dibujar la línea de borde de plataforma, que es una doble 

línea amarilla. Para ello podemos usar un pequeño truco que ADE nos permita. Vamos a dibujar enlaces (Tipo Apron) 

por todo el perímetro de plataforma y calles de rodaje, siguiendo la imagen por satélite. Le daremos un ancho de 

0,10 metros, y marcaremos en sus propiedades que solo disponga de Right Edge (SOLID). Con esto conseguiremos 

aproximadamente la línea de borde. Tened en cuenta que también dibujaremos los bordes de ambas calles de 

rodaje (A y B), y los bordes de los apartaderos existentes en las cabeceras de pista 03 y 21. 

 

 

También debemos de colocar Apron Edge Lights en ambos lados de las calles de rodaje, y en todos los apartaderos. 

 



Bien, así se podía quedar nuestra red de enlaces, siempre y cuando no usemos tráfico AI. Actualmente, si probamos 

cualquier tráfico, veremos cómo no pueden ejecutar ningún vuelo, ni de entrada ni de salida. El motivo es que no 

tenemos conectados los parkings a la red, ni tenemos el Runway Link, fundamental para las salidas y llegadas. Pero 

es que además, si conectamos las plazas de aparcamiento con la red, nos creará empalmes donde no queremos que 

los haya. La solución está en dibujar una red casi paralela a la que tenemos que conecte todas las plazas, y que 

discurra próxima a ella, y enlazarla con el Runway Link. Imaginaros los planos de fontanería de una casa, donde 

discurren tuberías de agua caliente y de agua fría, casi solapándose. Pues eso es lo que tenemos que hacer. Repito 

que éste paso es optativo, ya que sólo será necesario si volamos con tráfico AI. Yo, por ejemplo, hace años que no lo 

hago, pero habrá gente que sí prefiera hacerlo. 

Es fundamental para ésta red que nos hagamos un pequeño esquema de cómo será el tráfico en nuestro aeropuerto, 

para poder plasmarlo correctamente en ADE. 

 

 

Os recomendaría que para los enlaces de ésta red uséis Apron links, pero dibujadlos en color rojo para distinguirlos 

del resto. Esto se consigue editando cada enlace y seleccionando el color. Dibujadlos  sin marcas de ningún tipo, ni 

luces, y escogéis el ancho que queráis, por ejemplo 10,00 metros. Para el Runway Link, intentad que os quede al 

principio de cada cabecera y más o menos alineado con el eje de pista. El Runway Link no nos dibujará marcas de 

ningún tipo, ni luces, y el ancho por defecto es el ancho de la pista. 

MUY IMPORTANTE: Necesitaréis crear dos nuevos “Hold Short Taxi Points”, en el mismo sitio donde están los otros, 

pero si los editáis podéis seleccionar la opción “No draw”. 

Un último paso a realizar, y que después nos será de mucha utilidad, es clasificar nuestras redes. Le añadiremos un 

comentario a cada una de ellas para dividirlas. Para ello, en primer lugar seleccionaremos todos los enlaces de 

nuestra red “decorativa”, haciendo click en una de ellas, y después shift+click para ir añadiendo elementos. Cuando 

estén todas seleccionadas, y en color amarillo, hacemos click con el botón derecho->Edit Object. En el cuadro de 

diálogo Multi Edit, añadiremos en el campo User Comment “RED DE MARCAS”. A continuación hacemos lo mismo 

con la red de tráfico AI, llamándola “RED TRAFICO AI”, y con la de borde de plataforma (“RED BORDE DE 

PLATAFORMA”). Ya las tenemos clasificadas. 



 

Comprobad la orientación para que os coincida con los que dibujamos (Forward). Sin éstos puntos, no volarán los 

tráficos AI. Por último, y fundamental es que no enlacéis las dos redes, deben quedar totalmente independientes. 

Mi red para tráficos AI me ha quedado así: 

 

No os preocupéis mucho si no están demasiado bien alineados los enlaces, no se notará en los tráficos. Sí que es 

primordial el que os detengáis un rato y alineéis lo mejor que podáis los enlaces verdes, ya que las marcas si hacen 

notar cambios en la alineación. Un truco para alinear es que como sabéis la orientación de la pista (028,88), si váis 

seleccionando los enlaces uno a uno, su orientación debe ser la misma de la pista o 45,90,135,180,270 y 315 grados 

más. 

Bloquead todo (Lock->Marcamos todo), grabad, compilad y…suerte!!. 

NOTA: Para comprobar los tráficos AI, podéis descargar un programa gratuito, llamado AI Flight Planner, desde aquí: 

http://stuff4fs.com/newpage.asp?Folder=AIFP 

Se trata de crear planes de vuelo y compilarlos en un fichero Traffic_xxx.bgl. Imprescindible leer el manual. 



 

 

 



7.TAXI SIGNS O LETREROS DE RODAJE 

Los letreros de rodaje son un sistema de ayuda visual para los pilotos en los movimientos de tierra dentro de un 

aeropuerto. Son señales indicativas de emplazamiento, dirección a tomar, puntos de espera, etc. Podéis echar un 

vistazo al documento de Airhispania “Síntesis de señales visuales en tierra”, o bien en éste enlace: 

http://www.seguridadaerea.gob.es/media/4159060/insa_12_ins_14_1_0.pdf 

Normalmente la tarea de colocar éstos signos en un aeropuerto mediano o grande es bastante laboriosa y puede 

llevar horas, aunque es una tarea repetitiva. Por suerte en Córdoba solo existen unas pocas, veremos cómo 

colocarlas. Para detectar qué señales existen en cualquier aeropuerto es bueno buscar fotos en sitios como 

Jetphotos.net o Airliners.net, así cómo ver su ubicación en la foto por satélite o en la vista de pájaro de Bing Maps. 

Podemos hacernos un croquis con la ubicación y los símbolos que tenemos que colocar. Yo he encontrado éstos en 

LEBA: 

 

Más adelante repasaremos por si nos falta alguno, yo creo que no. Para colocarlos en ADE, es tan sencillo como en el 

display,situarnos en el punto deseado para colocar nuestra señal, hacer click derecho->Add->Taxi Sign. Nos aparece 

un editor de señales. 
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Size: Es el tamaño de nuestra señal. Yo he escogido un SIZE2 para Córdoba. 

Justification: Es el sentido desde el que coloca la señal, no debemos preocuparnos por esto ahora mismo. 

Type: Son los diferentes tipos de rótulos que disponemos en FSX. Según el letrero que estemos colocando 

pincharemos en uno u otro. 

Special Symbols: Son unos símbolos especiales que FSX pone a nuestra disposición para adaptarse a los oficiales. 

Pero como vemos en los letreros de pista libre, no los tiene todos y tenemos que hacer una pequeña “adaptación”. 

 

                                                            Letrero “oficial”                Letrero que nos permite FSX 

El recuadro en blanco es donde escribimos nuestro letrero. Por ejemplo, para hacer éste último de pista libre, 

pincharíamos dentro de Type el que tiene el fondo negro, a continuación en Special Symbols escogemos el corchete 

a la izquierda, escribimos “A”, corchete derecho, Type de nuevo y cogemos el de fondo amarillo, espacio, pinchamos 

cuatro veces el símbolo especial correspondiente, y espacio para finalizar. Lo tenemos. 

Lo único que falta es situarlo correctamente en cuanto a su orientación. Tened en cuenta que el cartel lo dibujamos 

desde la posición frontal desde la que lo miramos, ojo con esto. La parte visible de la señal se caracteriza por tener 

un borde gris. 

 



Para modificar la orientación, seleccionarlo y en el circulito naranja podéis arrástralo hasta el ángulo deseado. 

Mirando en la imagen por satélite he conseguido identificar dónde están ubicados los letreros y los he colocado ahí., 

dándoles su orientación real. 

 

 

8.HELIPADS O PLATAFORMA PARA HELICOPTEROS 

En Córdoba, según AENA, no disponemos de éste tipo de plataformas. Si estáis haciendo un aeropuerto que sí las 

tenga, consultad el manual de ADE, son muy simples de colocar. 

9.VALLADO 

ADE nos permite también colocar las vallas que delimitan el perímetro del aeropuerto. Existen dos modelos de 

vallado, uno el vallado perimetral en sí, y otro que se refiere a las vallas antichorro, que son barreras para impedir 

que la propulsión de grandes aviones dañen otras zonas. En Córdoba solamente tendremos vallado perimetral. 

Lo primero que haremos es imprimir una foto por satélite de todo el aeropuerto, y con ayuda de SAS Planet, Google 

Earth o incluso Google Street View, vamos recorriendo el borde del aeropuerto, identificando la valla y las puertas 

que existan. También observad que hemos marcado unas zonas que arrancan justo a ambos flancos del edificio 

Terminal, ya que son vallas distintas a las que nos ofrece FSX, y por tanto las modelaremos posteriormente. 

Aquí tenemos que hacer una reseña, ya que aunque en ADE veréis un montón de tipos de vallado, FSX realmente 

solo puede colocar dos tipos, el “5 meter chain link with wire” y el “5 meter chain link with bent top”. Esto lo vamos 

a aprovechar para diferenciar las puertas del vallado perimetral. Escogeremos el primer tipo para las puertas y el 

segundo para el vallado perimetral. 

 



 

Para colocarlas, primero escogemos en la persiana desplegable el tipo que queremos, y a continuación en el icono 

“Add boundary fence”, y vamos haciendo un polígono, doble click en el último punto.  

 



9.JETWAYS O FINGERS 

Por supuesto que en Córdoba no disponemos de fingers, es demasiado pequeño. Pero ADE te permite instalar 

fingers animados si los necesitas en tu aeropuerto. Ojo que consumen bastantes frames. 

10.MANGAS DE VIENTO 

En LEBA disponemos de dos mangas de viento, que en el plano de AENA aparecen como WDI (Wind Direction 

Indicator), una en la cabecera de la pista 03 y otra entre las dos plataformas. En las fotos por satélite se identifican 

rápidamente porque tienen un pequeño círculo alrededor. Nos situamos en ADE sobre ese punto, y hacemos click 

derecho->Add->Windsock. Nos aparecerá el cuadro de propiedades. 

 

Como véis podemos modificar multitud de propiedades, como la altitud del poste, la longitud de la manga, si está 

iluminada o no (En Córdoba sí lo están), la inclinación, etc. Nosotros aquí tan solo vamos a modificar el color, que 

pasa de ser naranja por defecto a roja, y la altura del poste, que según AENA es de 7,00 metros. Colocamos las dos 

iguales. 
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11.BEACON O FARO DE AERÓDROMO 

El faro de aeródromo es una baliza que se coloca en determinados aeropuertos destinados principalmente al vuelo 

visual, y que se utilizan en horario nocturno o en condiciones de baja visibilidad. En concreto, Córdoba dispone de 

una, según AENA, y la sitúa justo encima de la antigua torre de control que existe en la Terminal. Emite una luz con 

destellos blancos y  verdes, para que los pilotos localicen el aeropuerto. 

 

Usando el método que comentamos anteriormente para medir alturas, nos da 14,00 metros de altura. Esto nos va a 

hacer falta, ya que aún no tenemos edificio para la Terminal, así que momentáneamente se nos quedará “flotante”. 

Para situarla, nos vamos al display y nos colocamos justo en el centro del techo de la antigua torre de control, 

hacemos click derecho->Add->Beacon, y nos saldrá el cuadro de propiedades. 

 

Escogemos en Type la opción Civilian, en Base Type, Airport, y le asignamos una altura de 14,00 metros. 
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Ahí tenemos nuestro faro “flotante”. 

12.EFECTOS ESPECIALES 

Como ya sabéis, FSX dispone de una enorme cantidad de efectos especiales, tales como humo, fuego, explosiones, 

sonidos, tormentas, luces, etc. Podemos añadir a nuestro escenario cualquier tipo de efecto usando ADE, pero ahora 

mismo lo dejaremos tal cual, y ya en los retoques finales si creemos conveniente colocar alguno lo haremos. 

13.FUEL TRIGGER 

ADE nos permite colocar puestos de abastecimiento de combustible, siempre y cuando tengamos plazas de 

aparcamiento de tipo “fuel”. Su funcionamiento es que si estacionamos nuestro avión en éste tipo de aparcamiento, 

y disponemos de “fuel trigger”, nos saldrá una pantalla para que repostemos. Este no es nuestro caso, ya que según 

parece, en Córdoba el abastecimiento se produce a través de camiones, que se desplazan a las distintas plazas. De 

momento aquí no haremos nada. 

14.EXTRUSION BRIDGES Y WEATHER TRIGGER 

ADE actualmente no soporta ninguna de éstos dos elementos, y además no los necesitamos. 

15.COMUNICACIONES Y ATC 

Podemos establecer diferentes frecuencias para comunicaciones ATC en nuestro aeropuerto, que ocupen las 

dependencias de salidas, torre, aproximación, etc. En el caso de Córdoba, no existe control de tráfico, tan solo una 

frecuencia para comunicaciones aire-aire, a modo de UNICOM o MULTICOM. En concreto la frecuencia es 118,300 

MHz. Si nos vamos a Lists->Comms, nos aparece esto: 
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Es decir, que en el aeropuerto por defecto de FSX ya está contemplada ésta frecuencia. Tened en cuenta que éstas 

frecuencias que podemos añadir sólo nos servirán para el caso de que volemos en el modo ATC del simulador, 

cuando se vuela online en AirHispania o IVAO, el funcionamiento de las frecuencias no tiene nada que ver con las 

que tenga establecidas el simulador, aunque numéricamente sean la misma. 

16.RADIOAYUDAS PARA LA NAVEGACION 

Las radioayudas son todos aquellos elementos que permiten la navegación por instrumentos, aunque podamos 

usarlo como apoyo para vuelo visual (VORs, NDBs, ILS, Marcadores, Waypoints). Como es lógico todos los 

aeropuertos con tráfico IFR disponen de algún tipo de éstas ayudas. Córdoba solo está autorizado para tráfico visual, 

VFR, pero aun así dispone de 3 radioayudas en sus inmediaciones, las cuales vienen especificadas en el documento 

de Aena “Datos de Aeródromo”. En concreto dispone de un NDB, cuya identificación es COR, y un VOR con DME, 

llamado CDB. Estos elementos vienen ya en el escenario por defecto, y si tuviéramos que modificarlos por algún 

motivo, no podríamos hacerlo con ADE, habría que trastear de un modo más profundo. Comprobamos que en la lista 

de radioayudas están disponibles, y coinciden las frecuencias. Hacemos Lists->Navaids: 

 

Aparecen también otras radioayudas que se encuentran próximas, pero vemos que las que existen coinciden en 

frecuencia y denominación. Si vamos a View->Navaids, vemos que también se hallan correctamente ubicadas 

geográficamente. 

17.ELEMENTOS DE TERRENO 

Como ya comentamos al principio de este tutorial, FSX dispone de un sistema que clasifica los escenarios como 

mesh, landclass, waterclass, vectores, etc. ADE nos permite modificar algunos de ellos, en concreto los landclass, los 

waterclass y los vectores, para conseguir un aspecto más realista del entorno de un aeropuerto. Pero esto no es 

aplicable si estamos utilizando un escenario fotorrealista como base de nuestro aeropuerto. Quizá en otro tutorial 

hagamos uno exclusivamente con elementos de terreno en lugar de usar una foto por satélite. Las dos opciones 

tienen sus ventajas e inconvenientes. 

18.CUSTOM GROUND POLYGONS O POLIGONOS DE SUELO  

Aquí se abre un nuevo campo dentro del diseño de escenarios con ADE. Los Ground Polygons son una potente 

herramienta que nos permitirá diseñar de un modo más realista todos aquellos objetos a nivel de suelo (pistas, 

rodajes, plataformas, marcas, señales, etc.), y que anteriormente solo podían realizarse con programas de modelado 

3D, tipo Gmax, para después de un complejo entramado de operaciones, conseguir que los viéramos en FSX sin 

problemas de superposición e interferencias. ADE en su última versión ha incorporado un editor de Ground 

Polygons, que nos facilita enormemente la tarea.  
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En Córdoba los vamos a utilizar, y así veremos las diferencias en hacerlo de una forma más tradicional, dejando las 

texturas de pista, rodaje y plataformas con las texturas por defecto de FSX, o de ésta nueva manera, en la que 

sustituiremos dichas texturas por las que creemos nosotros, además de incorporar las marcas de pista que no 

pudimos realizar con el sistema de Links. El proceso es largo, pero creo que merece la pena. 

18.1.DEFINICION DE GROUND POLYGONS 

Los Ground Polygons (GP) son un tipo de escenario para FSX, de tipo “Objetos 3D”, es decir son un modelo 

tridimensional al que se le aplican texturas bidimensionales, para que después de su compilación los podamos situar 

en el simulador. Lo que ocurre en éste caso especial es que no se trata de objetos 3D al uso, tales como los edificios 

que después crearemos, sino que se dan dos circunstancias “especiales”: 

-Los GP no son tridimensionales, sino bidimensionales, es decir, son planos sin espesor 

-Los GP se ubican a cota de suelo, se sobreponen a las texturas por defecto que tengamos en pistas, escenario 

fotorrealista, plataformas, etc. 

Al ser objetos, los expertos en diseño de escenarios realizaban estos GP con programas de modelado 3D, tipo Gmax, 

3DSMAX o Sketchup, para después importarlos al simulador. Lo que ocurría es que había de implementarse una serie 

de operaciones algo complejas para evitar un problema que presentaban tanto en FS9 cómo en FSX. Éste problema 

consistía en que las dos últimas versiones del simulador no aceptaban de buen grado que un objeto situado a nivel 

de suelo se sobrepusiera al escenario base, se creaba un conflicto porque al estar a la misma distancia del 

observador, el simulador no discernía cuál de ellos debía de mostrarse, creando un efecto de “parpadeo” o 

“flickering” de las texturas, muy molesto. 

 

Esto se conseguía solucionar compilando los objetos con el SDK que traía FS2002, ya que ésta versión sí que 

solucionaba éste problema, pero había que hacer varias y tediosas tareas “a mano”, llamadas “tweaking”, además de 

disponer del SDK del FS2002, que no es nada fácil de conseguir si no se dispone del original. Posteriormente surgió 

un programa llamado ModelConverterX, realizado por el famoso gurú del diseño de escenarios Arno Gerretsen, que 

simplificaba enormemente éstas operaciones, y que produce unos resultados fabulosos. 

Pero ya que tenemos ADE, y ha incorporado ésta herramienta, vamos a aprovecharla al máximo. ADE divide los GP 

en dos grupos: Ground Polygons (GP) y Ground Lines (GL). Los GP se usan para elementos de forma bidimensional o 

superficiales, tales como pistas, rodaduras, plataformas, suelos especiales, etc, mientras que los GL los usaremos 

para elementos unidimensionales o lineales, tales como las líneas de marcas de pavimentos (que realizamos 

previamente con el sistema de nodos y enlaces, pero con el que no se conseguía una total fidelidad). Tened en 

cuenta que éstas GL, si bien se aplican a elementos lineales, en realidad son bidimensionales, ya que es obligatorio el 

introducir un ancho de línea o espesor, lo que ocurre es que trata de forma diferente la aplicación de texturas y nos 

simplifica el trabajo enormemente. 
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   Estos son los iconos del menú de herramientas de ADE que nos permitirá crear GP y GL. 

18.2.PASOS PREVIOS PARA REALIZAR LOS GP 

Lo primero que vamos a hacer es aligerar “exceso de equipaje” en nuestro escenario. Si habéis seguido el tutorial, y 

realizasteis las marcas de pavimento con el sistema de nodos y links, es el momento de deshacernos de él. Si no lo 

hicisteis, saltaros éste paso. Para ello aprovecharemos que clasificamos las tres redes en “RED DE MARCAS”, “RED DE 

BORDE DE PLATAFORMA” y “RED DE TRAFICO AI”. Pues bien, vamos a deshacernos de las dos primeras, y nos 

quedaremos sólo con la de tráfico. Nos vamos a Lists->Taxi Links. En el campo “Filter” escribimos Red de Marcas, y se 

nos quedarán exclusivamente aquellas. Hacemos click en Select All, y después en Delete. Borramos el campo Filter, y 

escribimos “Red de borde de plataforma” y repetimos. Si borramos el campo Filter de nuevo, solo tendremos un 

listado con los links de la Red de Trafico AI y los 5 Runway Links. Comprobad que los enlaces que quedan no tienen 

ningún tipo de marca ni de luces. (Recordad que ésta red no se ve en el simulador). 

Pero si vamos al display, vemos que efectivamente nos ha eliminado los enlaces, pero los nodos siguen estando ahí. 

Para eliminarlos, vamos a Lists->Taxi Points, y hacemos click en la columna Link Count, para ordenarlos de mayor a 

menor. Lo que haremos será seleccionar todos los Taxi Points que tengan un Link Count=0, es decir nodos sin enlace 

alguno, nodos sueltos. Los eliminamos y nos aseguramos que no queda ninguno suelto.  

Aprovechamos y modificamos un poco los enlaces de la red de tráfico para adaptarla un poco mejor a lo que sería un 

tráfico normal. Algo así: 

 

He seleccionado los enlaces de parking y les he cambiado el color a verde, editándolos, pero ésto no tiene mayor 

importancia. Grabamos y compilamos. 

Ahora vamos a modificar las opciones de visualización, para hacer invisible todo aquello que no nos interesa. Nos 

vamos a View->Dejamos marcado solo Comments, GP Objects y Grid. 

18.3.CONCEPTOS DE LOS GP 



Ahora es el momento de empollarnos el manual de los GP de ADE. En el directorio de instalación de ADE (suele ser 

uno llamado MSFS), encontraréis un directorio llamado “Manuals”. Ahí lo tenéis (ADE-GP-User Manual). Leerlo 4 o 5 

veces, no exagero, en especial la parte de “Texture Management”, que es la fundamental. En resumen, los GP se 

basan en 4 elementos: la definición geométrica de los mismos, las texturas a aplicar, la relación entre la geometría y 

la textura y el orden de dibujo o capas (Layers). Manejando y combinando esos 4 elementos debemos de ser capaces 

de diseñarlo todo, si bien existen pequeñas diferencias entre los GP y los GL. Veamos cada uno de ellos: 

-Geometría de los GP: La forma que le demos a los GP y GL seguirá el proceso normal de dibujo para cualquier 

elemento superficial (GP) o lineal (GL) que ya hemos visto. Simplemente ir haciendo click en cada vértice y doble 

click para finalizarlo. Una vez finalizado el objeto se nos abre el Editor de GP, donde habrá de indicarse todas y cada 

una de las propiedades de los mismos. 

 

-Texturas: Es el elemento fundamental de los GP, ya que hasta ahora no habíamos generado texturas para nuestro 

escenario. A partir de ahora si lo haremos. Pero debemos de tener claro varios conceptos en cuanto a las texturas. 

Como ya sabéis, las texturas son archivos de imagen, bidimensionales, que se utilizan para adaptarlos sobre objetos 

tridimensionales y dotarlos de realismo. 

 

Pero para FSX no es válido cualquier imagen generada con programas de dibujo o tomadas de fotos, ya que sólo 

admite ciertos formatos de archivo. Hay dos condicionantes básicos: 



a) Las hojas de texturas deben tener unas dimensiones cuyos lados sean siempre potencia de dos en píxeles, es 

decir 128x128, 256x256, 512x1024, etc. 

b) Los archivos deben de ser en formato comprimido, con extensiones .bmp (extendido) o .dds. Esto implica 

que si intentamos colocar una hoja de textura en formato bmp normal, FSX no la admitirá, por lo tanto habrá 

que hacer un procesamiento de la imagen previo. Existen muchos tipos de compresión de imágenes para 

ambos formatos, los más habituales son los DXT1 (sin canal alpha), DXT1 (con canal alpha), DXT3 o DXT5. ¿Y 

qué es un canal alpha?. Muy simple. Los archivos de imágenes suelen tener un canal donde archivan la 

información de la paleta RGB, es decir los colores que se usan normalmente en una textura, pero además si 

disponemos de programas de tratamiento de imágenes como Photoshop o Gimp, podemos crear un canal 

añadido, llamado alpha, que nos permite introducir transparencias en nuestra hoja. En éste canal, 

habitualmente el negro se usa para asignar transparencia total y el blanco para las zonas totalmente opacas. 

En los DXT1 sin alpha no existirán transparencias, como por ejemplo en la caja que hemos visto 

anteriormente, los DXT1 con alpha permite solo establecer zonas totalmente transparentes (negras) o zonas 

totalmente opacas (blancas), los DXT3 admiten una graduación intermedia de las transparencias (con tonos 

de gris), lo que creará un efecto de fusionado con el elemento que haya detrás, y los DXT5 admiten una 

graduación aun mayor en tonos de gris. Os recomiendo que leáis éste artículo: 

http://www.fsdeveloper.com/wiki/index.php?title=Alpha_channel_creation_with_Photoshop 

 
Otra característica de los archivos comprimidos dxt, es que disponen de la capacidad de creación de 

mipmaps, que son unas imágenes reducidas desde la original, para que cuando sean renderizadas por el 

simulador desde cierta distancia, vaya usando esas imágenes más pequeñas y de menor resolución, con lo 

que se aligera la carga del procesador gráfico, y por lo tanto se aumenta el rendimiento. 

 

-Relación entre geometría y textura: Una vez que dispongamos de nuestra hoja de textura, existen infinidad de 

formas de adaptarla a la forma del GP/GL. Esto se realiza mediante el control de las coordenadas UV. Las 

coordenadas UV son las que pertenecen propiamente a la hoja de textura, mientras que las XYZ son las del objeto. 

Podemos así desplazar la textura sobre nuestro objeto, girarla, aumentar o disminuir de tamaño, repetirla en un 

sentido o en ambos, etc. Una cosa fundamental en el editor de GP, es que si movemos, giramos o escalamos los 

vértices, éstos no se van a modificar físicamente en el display de ADE, y por tanto no se van a modificar en el 

simulador, tan solo estamos modificando su posición en relación a la textura a aplicar. 

-Capas o layers: Tendremos que crear un orden de capas en los elementos GP/GL que dibujemos, para otorgar 

prioridad a los que creamos convenientes en caso de que se superpongan. Por ejemplo, las marcas de la pista van 

encima de las marcas de rodadura, y éstas a su vez por encima de las marcas de plataforma. Los números más 

elevados de capa se dibujan sobre los números más bajos de capa. 



18.4.EL EDITOR DE GP 

A través del editor vamos a asignar todos y cada uno de los conceptos que hemos visto anteriormente, para dejar 

nuestro GP acabado. Los editores de GP varían ligeramente de los editores de GL. Veamos los primeros: 

 

-Layer: Aquí es donde le indicamos la capa donde queremos que se dibuje nuestro GP. Un consejo es que cuando 

queramos separar capas distintas, no es recomendable darles valores consecutivos, sino dejar 4 capas intermedias. 

Así que si por ejemplo dibujamos las marcas de rodaje en la capa 24, para las marcas de pista usaremos una capa 28. 

-Group Number: Dejadlo de momento en Auto, no usaremos esto ahora. 

-Main Texture: Aquí es donde seleccionaremos nuestra textura. Podemos usar las que trae el programa por defecto, 

o bien crear nosotros una a nuestro gusto, pero para esto último deberemos de completar ciertos pasos previos. Las 

texturas que usaremos se dividen por su cobertura  ( dimensionadas o no dimensionadas), y por la presencia o no de 

patrones para líneas (uniformes sin patrón o con patrones). Una textura dimensionada es aquella a la que le hemos 

asignado unas dimensiones específicas. Por ejemplo, tenemos una textura de suelo cuyo archivo de imagen es de 

512x512 píxeles. Si le indicamos que esos 512 píxeles representan 100 metros, será una textura dimensionada, y 

además sabremos la resolución que tiene (5,12 píxeles/metro). Una textura de patrón es aquella en cuya hoja 

aparecen subdivisiones, que nos va a permitir asignar a determinadas GL que creemos,  partes concretas de esa hoja 

de textura. Este es un ejemplo de una textura de patrón: 

 

Cuando creemos GL, podemos escoger si queremos asignarle una doble raya amarilla o una simple blanca, etc. 



Veamos un poco el sistema de almacenamiento que ADE tiene para las texturas, ya que es la base para que después 

podamos agregar las que nosotros creemos. Si vamos al directorio de instalación de ADE, encontraremos una serie 

de directorios llamados: 

/Textures/: En éste directorio se almacenan las texturas con la que estamos trabajando en el programa. Aquí 

incorporaremos las nuestras, siempre en versión comprimida con dxt, y además de inicio tiene incluidas las que trae 

de ejemplo ADE, en su versión con Mipmaps. 

/Textures_Base_Mipped/: Aquí se encuentran las texturas originales de ejemplo de ADE, en su versión con Mipmaps. 

Estas se encuentran copiadas en el directorio /Textures/, que es donde debemos modificarlas si hay algo que no nos 

gusta. Este directorio dejadlo siempre como está, por si algún día queremos usar las originales de nuevo. 

/Textures_Base_Nonmipped/: Igual que el anterior, pero con las texturas originales sin Mipmaps. 

/Textures_Dpy/: Aquí se almacenan la versión de las texturas que nos muestra el editor en su ventana de asignación. 

Son las mismas que en el directorio /Textures/, pero grabadas sin compresión,  es decir son imágenes normales en 

versión bmp de 24 bits, y éstas no las usa el simulador, tan solo es a efectos de visualizarlas en el editor. Por lo tanto 

cuando creemos una textura nuestra, debemos hacer dos versiones, una comprimida que irá al directorio /Textures/ 

y otra sin comprimir, en 24 bits, que irá en éste directorio. Es fundamental que ambos archivos tengan el mismo 

nombre. 

/Textures_Dpy_Base/: Igual que el anterior, pero almacenando las originales que trae por defecto ADE. Este no hay 

que tocarlo. 

También veremos que hay 4 archivos .txt, que son archivos de control de las texturas. Estos archivos contienen la 

información de qué tipo de texturas tenemos, y como se usan (dimensionadas, no dimensionadas, uniformes o con 

patrones). Son: 

Textures_Def.txt: Archivos de control de las texturas que estamos usando, para los GP. 

Lines_Def.txt: Archivos de control de las texturas que estamos usando, para las GL. 

Textures_Def_Base.txt: Archivos de control de las texturas originales para los GP (No tocar). 

Lines_Def_Base.txt: Archivos de control de las texturas originales para las GL (No tocar). 

Estos archivos se pueden modificar a mano, pero siempre es preferible hacerlo desde un módulo que ADE dispone, 

llamado GP Texture Editor, que veremos más adelante. Si queremos agregar nuestras texturas, previamente a 

usarlas debemos de pasar por el editor de texturas para incorporarlas a los archivos de control. 

-Outline Width: Aquí podemos especificarle al editor de GP si queremos que nuestro polígono disponga de una GL en 

todo su perímetro, una especie de reborde o margen. Tan solo debemos introducir el ancho que queremos que 

tenga. Esto será especialmente útil en las zonas restringidas o de aparcamiento. 

-Outline Texture: Esta opción solo está disponible si hemos escogido crear una GL de reborde con un ancho, y nos 

permite escoger qué textura llevará ese reborde. 

-Botones de control de vértices: Como vemos hay una serie de botones que nos permitirán desplazar (Drag), escalar 

(Resize), girar (Rotate), invertir (Flip), cambiar los colores del display (Change Color) y modificar el zoom (Zoom), de 

los vértices que seleccionemos en el display principal. Recordad que cuando hacemos éstas operaciones, no estamos 

cambiando su posición en el display de ADE ni en el simulador, tan solo su relación con la textura. 

-Display principal: Aquí es donde vemos nuestro polígono y su relación con la textura. Podemos seleccionar los 

vértices individualmente o en conjunto para poder modificarlos con los botones de control. Si la textura es más 

pequeña que el polígono, ADE la repetirá (tiles), hasta rellenar el objeto.  



-Botones UV: Aquí se nos muestra las coordenadas del vértice que seleccionemos en relación a la textura. Podemos 

ver esa distancia en fracción decimales o en píxeles. 

-Main Texture Size: Aquí introduciremos la distancia que queremos que cubra nuestra hoja de texturas, en metros, 

tanto en el eje X como en el eje Y. Escogemos siempre la opción de Metros en lugar de pies en los botones de la 

derecha. 

-Reset: Si lo pulsamos deshacemos todas las modificaciones que hayamos realizado y la deja en su estado original. 

-OK/Cancel: Cuando tengamos completamente configurado nuestro GP, pulsando OK lo incorporamos al display 

principal de ADE, y podrá ser compilado. Si hacemos Cancel, el GP se elimina. 

-Undo: Deshacer la última acción realizada. 

Para las GL, el editor es prácticamente igual con algunas pequeñas diferencias: 

 

Las diferencias están todas en la línea superior del editor: 

-Line Width: Para cualquier GL es obligatorio introducir un espesor de línea (con lo cual es como si creamos un GP, 

pero con un espesor relativamente pequeño respecto a su longitud). Si no introducimos un ancho, no crearemos la 

GL. 

-Backing Width: Aquí indicaremos al editor si deseamos que nuestra GL tenga un reborde en su parte inferior, lo que 

nos será muy útil en las líneas de eje de rodaje, que tienen un fondo negro de reborde. Introducimos el espesor 

deseado de esa banda inferior. 

-Backing Texture: Elegimos la textura a aplicar en el reborde. 

Por lo demás, todo es igual. Y llega la hora de ponerse a trabajar. 

18.5.DISEÑO DE LOS GP 

Lo primero que vamos a hacer es estructurar lo que vamos a necesitar hacer con GP/GL. Para ello, estudiaremos 

detenidamente la imagen por satélite de Bing Maps, y anotaremos todos los elementos que diseñaremos. Yo os 

recomiendo que hagáis una hoja de Excel, donde tengáis todo anotado, así como una hoja de croquis con las 

dimensiones que nos serán útiles de cada uno de ellos. 



 

 

Vamos a comenzar con las bases. Como se aprecia en la foto aérea, se distinguen varios tipos de asfalto en el 

aeropuerto. La pista y las calles de rodaje son de asfalto oscuro, bastante nuevo, sin marcas de neumáticos y con un 

cierto rayado vertical. La zona de Apron 1, que corresponde a la plataforma A, también tiene un asfalto nuevo, algo 

más claro que la pista, sin marcas. La Apron 2 cubre más o menos la mitad de la plataforma B, y tiene un asfalto claro 



pero con un rayado más oscuro, en franjas. La Apron 3 es la antigua plataforma, y su asfalto es con un tono algo más 

marrón, y con numerosas marcas de reparaciones o “cracks” en el pavimento. Después tenemos las zonas de 

seguridad que hay en las cabeceras de ambas pistas, con asfalto claro y con un rayado horizontal y algunos restos de 

hierba. Por último, la vía de servicio tiene un asfalto de color intermedio. Lo primero que vamos a hacer son las 

texturas de todos éstos GP de base. 

18.5.1.GP DE BASES DE PISTA, RODAJES, PLATAFORMAS Y VIA DE SERVICIO 

-Texturas: Siempre es interesante partir de alguna textura que ya exista, tanto en el escenario Textures del 

simulador, o bien dentro de AHSC. Así podemos ahorrar el crearlas de cero. Lo primero que vamos a necesitar es un 

programa que nos permita visualizar y tratar archivos de imagen extendidos, ya que como habréis podido 

comprobar, esos archivos de texturas no los podemos ver con visualizadores normales como ACDSee o el de 

Windows. Yo uso el DXTBMP, que lo podéis descargar aquí: 

http://www.mwgfx.co.uk/programs/dxtbmp.htm 

Yo he encontrado una textura que me gusta, en el directorio Texture del FSX, que se llama taxi_bitu.dds. La abrimos 

con el DXTBMP, entrando en File->Open->Buscamos en el directorio Texture de FSX. 

 

Aquí podemos ver que la textura es de 1024x1024 pixeles, que está grabada en formato .dds, y que su canal alpha 

(recuadro superior derecho) está totalmente en blanco, o sea, que es opaca. Vemos que la compresión usada es 

DXT1. Lo siguiente que haremos será asignar un editor de imágenes en el DXTBMP, para que podamos manipular la 

textura. Vamos a Prefs->Select Editor, y ahí buscamos y seleccionamos el ejecutable del programa de dibujo que 

usemos, Photoshop o Gimp. A continuación vamos a Image->Send to editor, y nos lanzará el software de diseño, en 

mi caso Photoshop, con la textura abierta. Esta textura será nuestra base, pero como hemos visto, tenemos distintas 

tonalidades de gris para el asfalto de LEBA. Vamos a crear 4 texturas a partir de ésta con los cambios de tonalidad. 

Para hacerlo lo más fielmente posible, en Photoshop abrimos también una de las imágenes aéreas que tenemos 

grabadas, por ejemplo LEBA_ADE_background.bmp, y la ponemos como actual. En la barra de herramientas, 

escogemos la herramienta Cuentagotas, y pinchamos en algún punto de la pista.  En la parte superior derecha 

anotamos en papel los valores RGB de ese punto, y repetimos el proceso para las zonas Apron 1, Apron 2 y Apron 3. 



 

Ya podemos cerrar la foto aérea, y nos quedamos con la textura taxi_bitu.dds abierta. Yo he obtenido los siguientes 

valores: 

-Runway: R99,G96,B83 

-Apron1: R122,G110,B94 

-Apron2: R127,G121,B110 

-Apron3: R148,G133,B110 

Ahora vamos a intentar modificar la tonalidad de la textura original con éstos valores. Empezamos con la de Runway. 

En Photoshop, vamos a Imagen->Ajustes->Reemplazar Color. Nos sale el cuadro de diálogo: 

 

Pinchamos en el cuentagotas con el signo +, ajustamos la tolerancia a 100, pinchamos en varios puntos de la textura, 

hasta que el recuadro central quede totalmente en blanco, y pinchamos en el recuadro de color que hay justo 

encima de “Resultado”. Ahora se nos abre un selector de color: 



 

Ahí, en la columna de la derecha introducimos los valores RGB que anotamos para la textura de la pista (99,96,83), 

damos OK, se nos cerrará el selector de colores, y damos a OK en el menú Reemplazar Color. Ya tenemos nuestra 

nueva textura, y como vemos es algo más oscura que la original.  

A continuación vamos a grabar, pero lo vamos a hacer ordenadamente. Creamos un directorio en el escritorio por 

ejemplo, llamado TEXTURAS LEBA, y en Photoshop vamos a Archivo->Guardar Como, seleccionamos el directorio que 

hemos creado, le llamamos al archivo LEBA_asfalto_baserwy, y escogemos el formato BMP. En el siguiente cuadro 

de opciones, aseguraros de marcar la profundidad de 24 bits. 

Vamos a repetir estos pasos para las otras 3 texturas, llamándolas LEBA_asfalto_baseapron1, 

LEBA_asfalto_baseapron2 y LEBA_asfalto_baseapron3. Recordad que éstas texturas están en 24 bits, y no se pueden 

usar en el simulador. 

Cerramos Photoshop y vamos de nuevo a DXTBMP. Ahora vamos a cargar cada textura y grabarla en formato 

comprimido. Hacemos File->Open, y seleccionamos la primera textura, la de la pista (LEBA_asfalto_baserwy). 

Aseguraros de tener marcada la casilla “Include when saving”, dentro del recuadro de la derecha “Mipmaps”, para 

generarlos. Ahora vamos a File->Save as, seleccionamos el directorio TEXTURAS LEBA, dejamos el mismo nombre, y 

escogemos el formato DDS DXT1 (ya que el canal alpha es opaco) y guardamos. Repetimos con las 3 texturas 

restantes. Si abrimos el directorio TEXTURAS LEBA, debemos de tener 8 archivos: 

 

Como habéis visto, no hemos creado texturas para las bases de las cabeceras 03 y 21 ni para la via de servicio. La 

respuesta es que viendo los valores RGB de esas zonas, se parecen bastante a algunas de las texturas ya creadas, así 

la cabecera 03 le asignaremos la LEBA_asfalto_baseapron3, a la cabecera de la 21, LEBA_asfalto_baseapron1, y a la 

via de servicio LEBA_asfalto_baseapron2. 

Ahora los copiamos de la siguiente forma: los 4 con extensión BMP, al directorio Textures_Dpy de ADE, y los 4 con 

extensión DDS, al directorio Textures de ADE. Y abrimos ADE. Vamos a crear los archivos de definición de texturas, 

para que el editor de GP pueda leerlos correctamente. Hacemos Tools->GP Texture Editor. 



 

Si pinchamos en la persiana desplegable selectora, nos aparece un listado de las texturas disponibles en el directorio 

Textures de ADE, pero vemos que las 4 que hemos creado tienen una coletilla (No Def). Eso es porque no se han 

definido sus características en el archivo Textures_Def.txt. Lo haremos ahora. Seleccionamos una cualquiera de 

nuestras texturas, y marcamos Yes en la casilla Uniform, con lo que haremos una textura dimensionada. A 

continuación pinchamos en M.(Metros), y veis que le hemos asignado unos valores de anchura y altura de 71,68 

metros. ¿Por qué esas dimensiones? Pues simplemente porque FSX admite una resolución máxima para texturas de 

7 cm/pixel. Como tenemos una hoja de 1024 pixeles, con una simple regla de 3, nos resulta que a esa resolución 

máxima, 1024 píxeles nos cubre 71,68 metros (1024 px*0,07m/px=71,68 m). El apartado Pos in List lo dejamos como 

está, simplemente es para el orden en que se nos mostrarán las texturas en el editor, y los campos que hay bajo Line 

Style Definition no los tocaremos, ya que eso es para texturas con patrones, y la nuestra es uniforme. Por último, 

pulsamos en Update Definition Files. Repetimos el proceso para las 3 restantes. Listo, ya tenemos nuestras texturas 

preparadas. 

-Creación de los GP: Ahora tenemos que generar los GP. Empecemos por la pista. Pinchamos en el icono Add Custom 

Ground Poly, y empezamos a dibujar el contorno de la pista, os podéis guiar por la pequeña franja blanca que la 

bordea. Recordad, doble click para el último punto y cerrar el GP. En las zonas curvas, no separéis los vértices 

demasiado para que no se noten quiebros bruscos. Una vez cerrado el polígono, se nos abre automáticamente el GP 

Editor: 

 

Vemos que la capa asignada es la correcta (24), así que solamente escogemos la textura leba_asfalto_baserwy en la 

pestaña Main Texture, y comprobamos que los valores de Main Texture Size son de 71,68 m. Pulsamos OK, y 

tenemos nuestro primer GP: 



 

Como veis, aparece resaltado en un color verde intenso, si queréis ponerlo transparente, simplemente los 

seleccionamos, y pulsamos Shift+O varias veces. Una cosa fundamental es bloquear el GP para evitar 

desplazamientos involuntarios del mismo cuando trabajemos encima. Seleccionamos el GP, hacemos click derecho y 

pulsamos en Lock Object. 

Repetimos la operación para los GP de las Aprons, asignándole su textura correspondiente, y las zonas de cabeceras, 

teniendo en cuenta que éstas últimas van en la capa 20, ya que la pista se superpone sobre ellas. Para la vía de 

servicio, usamos una GL, ya que tenemos un ancho uniforme, de 6,90 m. Ahora grabamos y compilamos para ver 

resultados. Veremos que al compilar nos sale un cuadro de diálogo: 

 

Esto es porque ADE compila los GP en un archivo independiente, llamado LEBA_ADEX_xx_GP.bgl, y para nuestro 

aeropuerto vamos a dejar las opciones de este cuadro tal y como están. La segunda opción la usaremos cuando 

tengamos varios GP situados a distintas alturas, que no es nuestro caso. Abrid FSX y comprobad el resultado. Anotad 

si veis zonas que no se superponen bien, para después ajustarlas en ADE como ya sabemos, moviendo vértices. 

Ahora mismo en ADE debemos de tener algo parecido a esto: 

 

En las vías de servicio que conectan con la pista, el ancho es un poco superior, en torno a 7,20 m. Fijaros también 

que hemos creado unos pequeños GP en los encuentros de las vías de servicio interiores con las exteriores, a modo 

de chaflán. También hay una pequeña via de servicio en la parte inferior que conecta con un hangar, con un ancho 

de 11,60 m. 

18.5.2.GP/GL DE LAS MARCAS DE PISTA 

Ahora vamos a meternos con las marcas de pista. Como veis en la hoja de Excel, aquí tenemos tanto GP como GL. 

Para las GL usaremos una textura que trae ADE por defecto, y para los GP la crearemos nosotros, pero no ahora, ya 

que intentaremos aprovechar la hoja de textura para incluir más cosas. 

Una cosa importante, ahora la pista que hicimos en ADE nos va a molestar para visualizar la imagen aérea que queda 

por debajo. Yo lo que hago, provisionalmente es darle un ancho de 0 m., para que no se vea. Vamos a Lists-



>Runways, y la seleccionamos y editamos. Le ponemos un ancho de 0 m., y eliminamos todas las marcas en la 

pestaña Markings, en la pestaña Lights todas las luces. 

-Faja Lateral: Son las líneas que discurren paralelas por los bordes de la pista, de punta a punta. Creamos una GL, y le 

damos un ancho de 1,00 m. Le asignamos la capa 40, como textura escogemos la gp_White_20F. Damos a OK y 

hacemos lo mismo para la otra línea, o simplemente copiamos y pegamos.  

Si compilamos, y vamos a FSX, observamos que la línea no es totalmente blanca. Esto es porque esa textura tiene un 

modo de compresión DXT3, y su canal alpha es un tono grisáceo, o sea que tiene cierto grado de transparencia. A mí 

personalmente no me gusta como queda, así que las haremos totalmente blancas. Para eso, tenéis que abrir 

DXTBMP, cargad la textura que se encuentra en el directorio Textures de ADE (gp_White_20F), y en el recuadro de la 

parte superior derecha, donde aparece el canal alpha, pulsáis el botón Send to Editor. Se os abrirá el Photoshop o el 

Gimp, solamente mostrando el canal alpha. Para eliminar la transparencia simplemente transformar toda la hoja en 

blanco, y la grabamos. En DXTBMP, pulsamos el icono “Refresh after Edit”, y la grabamos machacando la anterior. 

Siempre hacedlo en el directorio Textures de ADE. 

-Umbral de pista: Son las franjas paralelas que se encuentran al comienzo de cada pista, al estilo de un paso de 

cebra. Lo haremos con un GP, pero como no tenemos textura aún, lo que haremos será crear una Helper Shape, y 

después la transformaremos en GP. Nos vamos al display de ADE, damos click derecho->Add Helper Shape. Nos sale 

un menú: 

 

Introducimos Rectangle, y las dimensiones del umbral, que son 19,80x30,00 metros. También le damos la 

orientación (Heading) que tiene la pista (28,88°). Como en total hay 4 iguales, si seleccionamos el rectángulo hasta 

quedar amarillo, damos click derecho y copiamos y pegamos los 3 restantes. 

 

-Faja transversal: Es la línea horizontal que marca el comienzo de pista, en nuestro caso, solo el de la pista 21. Lo 

haremos con una GL, de 3,00 metros de anchura, capa 40 y textura gp_White_20F. 

-Designadores de pista: Son los números de pista que aparecen en las cabeceras. Al ser un GP, lo que haremos será 

las Helpers Shapes, la de la pista 03 de dimensiones 13,00x15,00 metros, la de la 21 de 10,80x15,00 metros. 



-Eje de pista: Cada línea de eje la haremos con una GL independiente. Tenemos 26 unidades, con un ancho de 0,50 

m. Para crearla con su longitud correspondiente, que son 30 metros, nos podemos guiar con una Guideline, que 

dibujaremos próxima a una de las líneas de eje de la imagen aérea, hasta que en el marcador de la parte superior 

izquierda del display nos marque 30,00 metros. Posteriormente creamos la GL, con anchura de 0,50 m. Le asignamos 

la capa 40, la textura gp_White_20F, y vamos copiando las líneas hasta que cubramos las 26. Costará algo de trabajo 

el colocarlas en su sitio, ya que la imagen aérea de fondo no es de mucha calidad en las zonas centrales de pista. Si 

cuando compiléis y abráis FSX notáis que la línea de ejes esta serpenteando, corregid un poco su posición en ADE. 

-Franjas de toma de contacto: Estas franjas son juegos pareados de líneas blancas, que sirven de guía para tomar 

tierra. Tenemos dos tipos distintos en LEBA, uno con 3 franjas y otro con 2. Las haremos con Helpers Shape 

rectangulares a la espera de crear la textura y convertirlas a GP. Las de 3 franjas miden 8,40x22,50 m. y las de 2 

franjas 5,10x22,50 m. Del primer tipo tenemos 4 unidades y del segundo 8. 

-Marcas de punto de visada: Estas son las dos franjas anchas donde se supone que acaba la senda de planeo. Sirven 

también de referencia al piloto. Existen un par en la pista 03 y otro en la 21. Lo haremos con GP, pero basándonos en 

una Helper Shape. Primero creamos una Helper Shape rectangular, de dimensiones 10,00x45,00 metros (recordad 

siempre darle la orientación de 28,88°). La situamos en su posición. La seleccionamos y damos click derecho, y 

marcamos la opción “Make Custom Ground Poly”. Nos aparece el editor de GP, le asignamos la capa 40, la textura 

gp_White_20F, y damos OK. Ahora copiamos ese GP a las otras 3 ubicaciones. 

-Ejes de umbral desplazado: Estas son las flechas que marcan la zona de umbral desplazado. Las haremos con Helper 

Shapes, para convertirlas a GP posteriormente. Son 11 flechas, y la dimensión del rectángulo que engloba el eje y la 

punta de la flecha es de 3,60x30,00 metros. 

18.5.3.GP/GL DE RODAJES Y PLATAFORMAS 

Esta es la parte donde nos espera un poco más de trabajo. Veamos uno por uno los componentes: 

-Eje de rodajes: Es una línea amarilla bordeada con un fondo oscuro. Lógicamente la haremos con GL, pero aquí el 

problema es hacer un trazado lo más acorde posible a la realidad, en especial en las curvas. Para facilitar el trabajo, 

vamos a crear 4 Helpers Shape con la forma de arco, dándole un diámetro de 20,00 metros, que cubra 90°, y a cada 

una le daremos una orientación de 28,88°, 118,88°, 208,88° y 298,88°. Con esto haremos las guías de todas las 

curvas de la zona de plataformas, a excepción de alguna que tienen un diámetro mayor. Las vamos copiando y 

situando en su sitio. 

 



Ahora a dibujar. Escogemos GL, y vamos marcando toda la línea de ejes, si bien tendremos que hacer varias debido a 

los ramales que surgen. Cuando terminemos la primera, en el GL Editor, escogemos la capa 36, le damos un ancho 

de 0,20 m., la textura principal será gp_PatternedLines_40F, en patrón de línea escogemos Single (Yellow), en ancho 

de fondo (Backing Width), le damos 0,30 m., y la textura de ese fondo (Backing Texture) será la gp_LineBase. 

Esa textura es un ejemplo de textura dimensionada y de patrón, ya que nos permite escoger un tipo concreto de 

línea dentro de la propia hoja de textura. 

Recordad el dibujar del mismo modo las zonas de viraje en las cabeceras, las zonas de los parkings 1 y 2 con sus 

flechas, y las entradas a pista de las calles de rodaje. 

 

-Borde de rodaje y plataforma: Es una doble línea amarilla bordeada con fondo oscuro. Recorre todo el perímetro de 

la plataforma, las calles de rodaje y las zonas de viraje. La haremos con GL. Asignamos la capa 36, le damos un ancho 

de 0,45 m., con la textura gp_PatternedLines_40F, patrón Double (Yellow), ancho de fondo 0,60 m. y textura de 

fondo gp_LineBase. 

-Puntos de espera: Son dos líneas transversales que existen en las calles de rodaje A y B, con el símbolo de punto de 

espera. La hacemos con GL, capa 36, con un ancho de 2,10 m., textura gp_PatternedLines_40F, patrón Hold Short, y 

damos a OK. Veamos cómo queda. 

 

Tenemos dos problemas, uno que están al revés (las barras cortas deben apuntar hacia la pista), y otro que en LEBA 

real existen 9 tramos cortos de franjas, y aquí solo tenemos 6. Vamos a corregir eso. Volvemos a ADE y 

seleccionamos nuestra GL para que nos salga el editor. Para corregir la orientación de las barras cortas, simplemente 

en el display del editor hacemos click y hacemos una ventana que nos englobe los 4 vértices. Los veremos marcados 

en rojo. A continuación pulsamos en el botón de control “Flip Horizontal” , y nos aparecerá un cuadro de 

diálogo que nos indica que se han invertido horizontalmente los vértices. Para corregir la escala, y que nos aparezcan 



9 barras en lugar de 6, primero debemos hacer un cálculo para averiguar el factor. Si nos fijamos en el editor, vemos 

que la textura abarca verticalmente 12,19 metros (Parte inferior derecha, en Main Texture Size, casilla Y). En esos 

12,19 metros, nos representa 4 módulos de barra-hueco. Por lo tanto cada módulo abarca 3,048 m. Nosotros 

necesitaremos 9 módulos barra-hueco, que a 3,048 m. implica un total de 27,4275 m. Pero como nuestra longitud 

total de barra de extremo a extremo es de 17,00 metros, simplemente dividiendo 27,4275/17,00=1,613. Ese es 

nuestro factor. Para incorporarlo al GP editor, nos aseguramos de tener seleccionados los 4 vértices, y pulsamos el 

botón de control “Resize Vertical” , y haciendo click derecho en el icono nos aparece un cuadro 

de diálogo para que introduzcamos el factor de escala. Le introducimos 1,613 y Continuar. Por último, solo nos 

queda situar verticalmente nuestro punto de espera para que comience en el centro de un módulo hueco. 

Seleccionamos los vértices, y a continuación el icono “Drag Vertical” , y arrastramos los vértices 

hasta que nos quede el comienzo en el eje de uno de los huecos. 

 

Con esto debería de bastar. Repetimos los mismos pasos para el otro punto de espera. 

 

-Márgenes pavimentados: Esto se refiere a las barras amarillas que existen en las zonas de viraje de cabeceras de 

pista, perpendiculares al margen que queda entre el borde y la marca de borde. Son en total 33 unidades, que se 

situan adaptándose a la curva. Haremos una GL guiándonos por la imagen aérea, e iremos repitiéndola. La capa 

asignada es la 36, ancho 0,85 m. y la textura gp_Yellow_20F. 



 

-Línea de seguridad de plataforma: Es una línea en plataforma, que bordea el área destinada al movimiento de 

aeronaves en los puestos de estacionamiento. Es una línea roja bordeada con blanco. La hacemos con una GL, capa 

32 (queda debajo de las líneas de rodaje), ancho 0,20 m., textura gp_PatternedLines_40F, patrón Single (Red), ancho 

de reborde 0,60 m, textura de reborde gp_White_20F. 

 

-Areas de prohibición de aparcamiento: Estas áreas son zonas donde los vehículos no pueden estacionar, por ser 

zonas de movimiento de aeronaves. En LEBA tenemos dos, una entre las plazas 1 y 2 de aparcamiento y otra en la 

zona inferior derecha de la plataforma A, junto a la zona de repostaje de combustible (aunque curiosamente en la 

foto aérea aparece estacionada una avioneta justo encima). Están marcadas con un rayado rojo a 45°, y bordeadas 

con línea roja también. La segunda zona presenta un rayado a cuadros. Vamos con la primera, que la haremos con 

un GP, en la capa 28, le asignamos la textura gp_CrossHatch_Red, le marcamos un ancho de reborde de 0,20 m. 

(Outline Width), y la textura de la línea de reborde será la gp_Red_20F. Ahora seleccionamos todos los vértices, y los 

vamos a rotar 286,12° (el rayado de la textura es vertical, para colocarlo en su posición, restamos a 45° los 28,88° de 

orientación de la pista, que son 16,12°, y le sumamos 270° para que el rayado tenga la misma orientación que en la 

realidad). También con los vértices seleccionados, los escalamos con un factor de 0,6, para que el espaciado sea el 

adecuado. 



 

Para la segunda zona, creamos un Helper Shape rectangular, de 20,20x20,20 m., orientado a 28,88°. Lo movemos a 

su sitio, y lo transformamos en un GP (click derecho con el rectángulo seleccionado->Make Custom Ground Poly). Lo 

editamos, asignándole la capa 28, textura gp_CrossHatch_Red, ancho de reborde 0,20 m., textura de reborde 

gp_Red_20F. Seleccionamos los cuatro vértices y los rotamos 16,12°. Los seleccionamos de nuevo y le damos un 

factor de escala de 0,60. Damos a OK. Con esto tenemos hecho el reborde y uno de los rayados. Para hacer el otro 

rayado, seleccionamos el GP, lo copiamos y lo pegamos separado del original. Lo editamos en el GP editor, y le 

quitamos el ancho de reborde (para no duplicarlo), seleccionamos los cuatro vértices y lo giramos 270°. Lo 

colocamos justo encima del primer GP, y listo. 

 

-Señal de máxima envergadura: Es la señal que tenemos previa a la entrada de la calle de rodaje A, que indica “MAX 

SPAN 25M”, en fondo amarillo con reborde y caracteres negros. Como no tenemos textura para eso de momento, 

haremos un Helper Shape, rectangular de dimensiones 18,80x4,00 m. y lo colocamos en su sitio. 

-Señales de entrada a puesto: Son las dos que tenemos para indicarnos la entrada a los parkings. Hacemos igual que 

antes, Helper Shape rectangular de 3,50x4,00 m. Hacemos las dos. 

-Señales de puesto de estacionamiento: Son las dos pequeñitas, estas en fondo negro con caracteres amarillos. 

Hacemos dos Helper Shape rectangulares, de dimensiones 1,30x1,90 m. 

18.5.4.GP/GL DE VIAS DE SERVICIO 

Las vías de servicio son las carreteras por donde se desplazan los vehículos del aeropuerto para sus diversas 

funciones de apoyo a aeronaves, vigilancia, etc. Ya teníamos creada la base con un GL, y ahora crearemos las marcas. 



-Borde de vía exterior: Es el borde de las vías perimetrales del aeropuerto, y consiste en una línea blanca continua, 

que se interrumpe solamente en los encuentros con las puertas del vallado perimetral del aeropuerto. Por lo tanto 

tendremos 7 tramos, que haremos con GL, capa 28, ancho 0,25 m., textura gp_PatternedLines_40F y patrón Single 

(White). También haremos la parte interior de las líneas, que se interrumpen en los encuentros con las vías de 

servicio interiores que comunican con la pista. Por lo tanto 4 tramos más, hechos del mismo modo que los 

anteriores. 

-Borde de vía interior: En las vías de servicio que comunican la vía perimetral con la pista, las líneas de borde son 

dobles, blancas. Las dibujamos, y le asignamos capa 28, ancho 0,60, textura gp_PatternedLines_40F y patrón Double 

(White). Observad que no llegan al final de las vías, se quedan justo en un poste de control que podemos usar de 

guía en la foto aérea. Comprobad en FSX que las uniones con los bordes sencillos quedan bien, y si falla algo lo 

ajustáis en ADE. 

-Eje de vía de servicio: En la vía perimetral es una línea blanca discontinua que discurre por toda su longitud. 

Dibujamos la GL por el eje de la vía exterior, le asignamos capa 28, ancho 0,25 m., textura gp_PatternedLines_40F, 

patrón Dashed 5F/1,5M (White). Para las vías interiores, vemos que hay una zona sin eje, más próxima a la pista, una 

zona con línea discontinua y una zona con línea continua. Dibujamos éstas dos últimas. 

-Borde vía de servicio en cruce con plataforma: Con estas marcas nos referimos a las que se encuentran en las vías 

interiores, en el tramo que comunica con la pista. Si os fijáis en la vista aérea, está formada por una línea alterna 

discontinua blanca. 

 

Si vemos la hoja de texturas gp_PatternedLines_40F, ese tipo de línea no existe. Lo que vamos a hacer es intentar 

crearla, e incorporarla. Para ello, lo que necesitamos modificar es el canal alpha de esa hoja. Estudiando un poco la 

textura, vemos que los canales RGB están formados por 3 bandas anchas de colores amarillo, blanco y rojo. Es con el 

canal alpha con lo que se van dibujando los distintos tipos de línea, dejando en blanco lo que queremos que sea 

opaco (las líneas en sí), y en negro las zonas transparentes, con lo que no veremos color alguno, sino el elemento 

que tengamos debajo. Se que es algo complicado de entender. Lo primero que haremos será abrir DXTBMP, y 

cargamos la textura gp_PatternedLines_40F que se encuentra en el directorio Textures dentro del directorio de ADE. 

Veremos algo como esto: 

 



Lo que estamos viendo en el display principal es el canal RGB (colores de fondo). En el recuadro superior izquierdo 

vemos el canal alpha. Ese es el que modificaremos. Justo debajo de ese recuadro, hay un botón que indica “Send to 

Editor”, lo pulsamos y se nos abrirá Photoshop, con el canal alpha cargado. 

 

Véis una zona blanca ancha en la parte central, pues en esa zona, pegado al lateral derecho vamos a crear el patrón 

buscado. Lo hacemos ahí porque esa zona está libre en la definición de patrones original (Lines_Def.txt), y el fondo 

es blanco (el fondo RGB, no el alpha). Para crear patrones es fundamental controlar los píxeles que usemos, ya que 

después tendremos que introducirlos en el GP Texture Editor. Por lo tanto debemos de tener activadas las reglas de 

píxeles en el programa que estemos usando de edición (Photoshop o Gimp). Ahora vamos a replantear las 

dimensiones que le vamos a dar a la línea, en especial la que debe de preocuparnos es la dimensión vertical, ya que 

al ser una textura de línea, ésta hoja se va a ir repitiendo hasta completar la longitud de línea que tengamos. Eso 

significa que longitudinalmente tienen que ser módulos exactos, a no ser que queramos ver cosas raras en FSX, tales 

como líneas más cortas que otras. En el editor de GP de ADE, vemos que es una textura dimensionada verticalmente, 

y que cubre 12,20 m. Como la textura es de 256 píxeles verticales, la resolución es de 4,77 m/pixel. Para buscar un 

módulo exacto de líneas verticales, en 256 píxeles nos caben 16 piezas de 16 píxeles. Con la resolución que 

disponemos, 16 píxeles nos representan algo más de 76 cms., lo que creo que es adecuado para las dimensiones 

reales de las marcas que queremos dibujar. Para la dimensión horizontal no nos debemos de preocupar demasiado, 

ya que recordad que las GL nos pide un espesor de línea, y por tanto se adaptará al ancho que dibujemos. Le 

daremos 8 píxeles de ancho.  

Ahora vamos a dibujar un rectángulo negro de 18 píxeles de ancho por 256 de alto (2 anchos de nuestra línea de 8 

píxeles más uno de borde por cada lado). Si ampliamos en Photoshop la franja negra donde vamos a comenzar 

nuestra línea vemos que está comienza en el píxel 265. Hacemos un rectángulo de selección pinchando en el píxel 

264, y arrastramos horizontalmente hasta el 247, y verticalmente hasta que nos cubra la hoja. Ahora vamos a 

Edición->Rellenar, y seleccionamos Negro al 100% de opacidad. 



 

A continuación nos vamos al borde inferior de la hoja, y hacemos un rectángulo de selección de 8x16 píxeles, 

dejando uno de margen lateralmente. Lo rellenamos de blanco. Lo vamos copiando pulsando Alt+Click en el 

rectángulo y lo colocamos en su sitio. 

 

Si todo ha ido bien, al acabar de colocar el último rectángulo, éste debería de llegar justo al borde superior de la hoja 

de texturas. Fijaros en un detalle, y es que en la hoja original, los bordes de las líneas están difuminados con tonos 

grisáceos. Si queréis podéis hacerlo, pero yo no me complicaría la vida y lo dejaría tal cual. 

 



Ahora vamos a Archivo->Guardar, y entramos de nuevo en DXTBMP. En los botoncitos debajo del recuadro del canal 

alpha, pulsamos en “Refresh after edit”, y veremos nuestra nueva línea creada. En DXTBMP, vamos a File->Save, y lo 

guardamos con el mismo nombre, en la pregunta que nos aparece de si deseamos reemplazar el existente damos 

que sí. 

Con esto ya tenemos el archivo grabado en el directorio Textures, pero recordad que para que en el editor de GP nos 

lo muestre, debemos de grabar una versión BMP de 24 bits, en el directorio “Textures_Dpy”. Para ello, en DXTBMP, 

y con nuestro archivo abierto, vamos a Alpha->Apply Alpha to Image. Como vemos, nos ha superpuesto el canal 

alpha, pero en un tono grisáceo. Vamos a cambiarlo a negro. Hacemos Image->Send to Editor, y se nos abre la 

imagen con el tono gris. Seleccionamos todo lo gris con la herramienta “Varita Mágica”, que está en el menú de la 

izquierda .  Pinchamos en cualquier zona en gris, hasta que todas estén seleccionadas. Después, vamos a 

Edición->Rellenar, y seleccionamos Negro, 100%. Por último vamos a Guardar como, buscamos el directorio 

“Textures_Dpy” dentro del directorio de ADE, y machacamos el archivo “gp_PatternedLines_40F”, grabándolo como 

BMP en 24 bits. 

Abrimos ADE, y hacemos Tools->GP Texture Editor. Seleccionamos la textura gp_PatternedLines_40F, en “Uniform“ 

pulsamos “Yes”, en “Height”, dejamos la que tiene (12,192 m.), pulsamos el botón “M” en vez de “Ft”, en la persiana 

“Line Style Definition”, escribimos un nombre, yo en concreto le he llamado “Borde_Mixto_Blanco”, en “Start Pixel” 

anotamos 248, que es donde comienza nuestra línea, en “Width/Height”, ponemos 16, que son los píxeles que 

abarca, en “Insert at Posn”, anotamos 1 por ejemplo, y en “Style Orientation”, marcamos “Vert.”. Por último le 

damos a “Update Definition Files”. 

 

Ya sólo nos queda dibujar nuestras GL, como siempre, seleccionamos la capa 28, ancho 0,60 m., textura 

gp_PatternedLines_40F, patrón Borde_Mixto_Blanco, y ...voilá!: 

 



-Banda de parada: Esta es la pequeña línea que nos marca el ceda el paso en las vías de servicio interiores. Solo en el 

carril derecho. Pintamos la GL, escogemos capa 28, ancho 0,50 m., textura gp_PatternedLines_40F, patrón Single 

(White). 

-Banda Ceda el Paso: Estas bandas se encuentran en el cruce de las vías interiores con la perimetral. Es una línea 

ancha discontinua. La dibujamos, capa 28, ancho 0,45 m., textura gp_PatternedLines_40F, patrón Dashed 5F/1,5M 

(White). 

-Banda cruce con puertas: Son unas líneas discontinuas blancas que se encuentran en el borde exterior de la vía de 

servicio perimetral, en el encuentro con las puertas. La dibujamos  en la capa 28, ancho 0,25 m.,  textura 

gp_PatternedLines_40F, patrón Dashed 5F/1,5M (White). 

-Señal de ceda el paso: Las haremos las 3 con Helpers Shapes rectangulares, de dimensiones 1,40x3,80 m. 3 

unidades. 

-Flechas de dirección: También con Helpers Shapes, de 5,00x1,00 m. Hay 24 unidades 

-Señal Stop Paso de Aviones: Helpers Shapes de 2,00x2,00 m. 3unidades. 

A éstas tres últimas les crearemos la textura junto con las restantes que nos faltan. Para ubicarlas en su posición, 

como el GL de la vía de servicio nos ocultará la imagen de fondo, podemos ayudarnos con marcas de ayuda, 

tomando previamente las coordenadas de SAS Planet. Ojo con la orientación de los Helpers Shapes. 

18.6. CREACION DE HOJA DE TEXTURA 

Ahora mismo tenemos todos los GP/GL situados en su sitio, algunos de ellos totalmente terminados y otros a los que 

aún nos queda transformarlos en GP y aplicarles una textura. Pero eso no lo hemos hecho aún porque nos falta crear 

una hoja de textura propia que se ajuste a nuestras necesidades. Vamos a repasar qué nos falta por texturizar: 

-Marcas de umbral de pista 

-Marcas de designadores de pista 

-Marcas de toma de contacto de pista 

-Marcas de eje de umbral desplazado 

-Señal de máxima envergadura 

-Señal de entrada a puesto 

-Señal de puesto de estacionamiento 

-Señal de ceda el paso 

-Flechas de dirección 

-Señal de Stop paso de aviones 

Lo primero que vamos a hacer es replantearnos las dimensiones que queremos darle. Partimos que la resolución 

máxima de FSX es de 7cm/pixel. Como tenemos las medidas de cada elemento a diseñar, podemos calcular cuántos 

píxeles necesitaremos para cada uno de ellos a máxima resolución. Lo podemos hacer en una hoja de Excel. 



 

Las columnas ancho/alto van en metros, y en las columnas ancho px/alto px, se ha redondeado a la cifra exacta 

superior. A continuación tenemos que decidir que tamaño le daremos a la hoja de textura. Como sabemos, FSX solo 

admite hojas con tamaño en potencia de 2, así que en principio deberíamos optar por una de 1024x1024 píxeles o 

una de 512x512. Podemos hacer un cálculo rápido, tomando como referencia las superficies que ocupan las 

texturas. Si multiplicamos las columnas ancho px por alto px, y sumamos los totales nos arroja un valor de 301.231 

px². La hoja de 512x512 tiene 262.144 px², por lo tanto se nos queda pequeña. Optamos por hacerla en 1024x1024, 

aunque nos sobre mucho espacio, ya veremos como aprovecharlo. 

Vamos a dibujar cada elemento por separado, y después los uniremos. Abrimos Photoshop. 

-Umbral de pista: Vamos a Archivo->Nuevo, y creamos una imagen de 283 píxeles de ancho por 429 píxeles de alto. 

Ahora Edición->Rellenar y escogemos un negro 100% opaco. Si nos fijamos en nuestra imagen a dibujar, vemos que 

se compone de 6 barras blancas de 1,80 m. de ancho y 5 huecos de 1,80 m. también. Para que nos quede exacto, 

calculamos cuantos pixeles ocupan 1,80 m. 1,80/0,07=25,71 px, o sea 26 px. Así que 6 barras+5 huecos de 26 px, nos 

da un ancho total de 286 px. Modificamos el tamaño de imagen, vamos a Imagen->Tamaño de imagen, desactivamos 

la casilla “Restringir proporciones”, e introducimos un ancho de 286 píxeles, manteniendo la altura inicial. 

Ahora dibujemos las barras. Para ello, vamos a seleccionar la herramienta “Marco Rectangular” . Hacemos 

estos pasos: 

 

Hacemos zoom en la imagen en la esquina superior izquierda, hasta que veamos la guía de píxeles claramente, y 

pinchamos en el primer píxel (0,0). Se nos debería de dibujar un marco de selección que representa la primera banda 

blanca. 



 

Ahora, ayudándonos con la guía superior vamos pinchando en los píxeles 52, 104, 156, 208 y 260 de la fila superior. 

Cuando acabemos tendremos seleccionadas todas las bandas, y el último rectángulo debería de terminar justo en el 

límite del dibujo. 

Seleccionamos la herramienta “Borrador Mágico” , y pinchamos en el interior de una de las barras que están 

seleccionadas. Vemos que nos las ha hecho transparentes: 

 

Debemos rellenar esas zonas transparentes, bien con blanco, o bien con la textura de blanco que ADE trae como 

ejemplo, que tiene cierta “textura” rugosa. Vamos a abrir el archivo gp_White_20F.bmp, que se halla dentro del 

directorio Textures_Dpy de ADE. Hacemos Selección->Todo, y después Edición->Copiar, y cerramos el archivo. Ahora 

vamos a Edición->Pegar,  dentro de nuestro dibujo. Veremos como en el menú de capas, de la parte inferior derecha 

nos ha creado una nueva, con la imagen que hemos copiado. Lo que ocurre es que ésta es mas pequeña que nuestro 

dibujo, por lo tanto vamos a copiarla más veces. Pulsamos en la herramienta Selección , y arrastramos la 

imagen que hemos pegado hasta la parte superior izquierda. Debemos haber activado previamente la opción Ajustar 

dentro del menú Vista. Una vez en la esquina, hacemos Alt+Click izquierdo, con lo que copiamos la imagen hasta 

arrastrarla justo debajo. Repetimos la operación por la parte derecha, con lo cual ahora no vemos nuestras barras, 

sino la textura blanca de fondo que hemos copiado. Vemos en el menú capas que cada vez que hemos copiado nos 

ha creado una nueva capa. Ahora vamos a combinar las 4 que forman nuestra textura blanca. Para ello, hacemos 



Shift+Click izquierdo en todas las capas a excepción de la Capa 0, que es nuestro fondo de barras. Cuando tengamos 

las 4 seleccionadas (Capa 1, Capa 1 copia, Capa 1 copia 2 y Capa 1 copia 3), hacemos click derecho y elegimos 

Combinar Capas. Ahora solo nos quedan 2 capas, pero aún no vemos nuestras barras. Simplemente tenemos que 

ordenarlas, para lo cual pinchamos click izquierdo en Capa 0, y la arrastramos hasta que quede por encima de Capa 1 

copia 3. Ahora ya si vemos lo que queríamos: 

 

Por último, en el menú capas hacemos click derecho en cualquiera de ellas y seleccionamos Combinar Visibles. 

Después hacemos de nuevo click derecho en la capa y damos “Acoplar Imagen”. Solo nos queda guardar nuestra 

textura. Para ello, vamos a Archivo->Guardar como. Lo vamos a incluir en el directorio “TEXTURAS LEBA”, le 

llamaremos “umbraltwy”, con extensión BMP y en 24 bits. 

-Designadores de pista: Aquí tenemos que hacer dos texturas, una para la 03 y otra para la 21. El mismo proceso nos 

valdrá para las dos. Abrimos un archivo nuevo en Photoshop, de 186 px de ancho y 215 de alto. Lo rellenamos de 

negro. Ahora sería interesante buscar una plantilla con la numeración típica de pistas. Buscando en internet yo 

encontré ésta: 

https://www.tc.gc.ca/media/images/ca-publications/figure5-2a.gif 

 



Nos puede valer, pero hay muchas otras formas de hacer la plantilla, como por ejemplo tomar una imagen de 

SASPlanet, o de cualquier documento de texto que tenga la numeración normalizada.  

Abrimos esa imagen de plantilla, y la vamos a invertir para que los números queden en blanco. Vamos a Imagen-

>Ajustes->Invertir, y con la herramienta “Varita Mágica”, seleccionamos el número 0. Si os selecciona algunas partes 

más, id ajustándolas con las herramientas de selección “Añadir a selección” o “Restar de la selección”. Cuando la 

tengamos, nos vamos a Edición->Copiar, y en nuestro dibujo pegamos la imagen. La arrastramos hasta la esquina 

inferior izquierda, y la ajustamos de tamaño en Edición->Transformación Libre. Con Shift+Click izquierdo arrastramos 

la esquina superior derecha hasta que lleguemos al borde superior de nuestra imagen.  

Hacemos lo mismo con el número 3. Vemos en el menú de capas que tendremos 3 distintas, así que las combinamos 

todas en una sola (Combinar Visibles). Con la herramienta “Borrador Mágico” pinchamos en las partes blancas, 

dejándonos transparente esas partes: 

 

Ahora repetimos la operación que hicimos para el umbral, de asignarle un fondo blanco “texturado” a las partes 

transparentes. Pegamos la imagen, cambiamos el orden de capas, las combinamos y las acoplamos. Lo guardamos 

como “desig03.bmp” en el directorio “Texturas LEBA”. Para el 21 repetimos los mismos pasos, y lo grabamos como 

“desig21.bmp”. 

 



-Marcas de toma de contacto: Para éstas dos marcas repetimos lo que hicimos con las de umbral de pista, y nos 

quedarán dos archivos “tomcont3.bmp” y tomcont2.bmp”. 

 

-Eje de umbral desplazado: Aquí haremos un proceso parecido al de los designadores, es decir, buscar una plantilla 

adecuada. La llamaremos “umbrdespl.bmp”. 

 

-Señal de máxima envergadura: Aquí debemos de combinar varias de las técnicas que ya hemos visto. Por un lado 

usaremos de plantilla los caracteres que aparecen en alguno de los documentos de Aena que existen en Internet: 

http://www.seguridadaerea.gob.es/media/4159060/insa_12_ins_14_1_0.pdf 

En las páginas 73 a 77 existe un alfabeto tipo. También lo obtenemos aquí: 

http://www.alphabetsigns.com/mm5/graphics/00000041/faa-120-letters-number-stencils-alt1.jpg 

Por otro lado, crearemos el reborde usando la técnica que vimos en los umbrales desplazados. Toqueteando un poco 

nos queda algo así: 

 

Es importante que toméis las medidas que os hagan falta en SASPlanet, y transformarlo todo a píxeles, simplemente 

dividiendo la medida en metros por 0,07. Así tendréis la referencia de altura de caracteres, separación, etc. El 

archivo de textura se llamará "maxspan25m.bmp". 



-Señales de entrada a puesto: Son dos, numeradas 1 y 2. Aquí podemos usar la imagen anterior de la señal de 

máxima envergadura para retocarla. Crearemos dos archivos, "entrpuesto1.bmp" y "entrpuesto2.bmp". 

 

-Señales de puesto de estacionamiento: Hacemos igual que las anteriores, pero ahora con los fondos invertidos. Los 

grabamos como "puestoestac1.bmp" y "puestoestac2.bmp". 

 

-Señal de ceda el paso: Nos buscamos una plantilla, y la hacemos igual que las marcas de umbral. 

http://www.bloquesautocad.com/wp-content/uploads/2013/09/flechas03.jpg 

Estas tres últimas marcas que nos quedan (ceda el paso, flecha de dirección y stop paso de aviones), al ser tan 

pequeñas, si le damos el tamaño que establecimos en la hoja de Excel quedan con poca definición. Así que la 

aumentaremos al doble (en éste caso la haremos de 40x110 px). Lo llamamos "cedaelpaso.bmb". 

 

Flechas de dirección: Hacemos doble su tamaño también (30x144 px). Aquí tenemos una plantilla: 

http://www.miliarium.com/Proyectos/Detalles/AyuntamientoMadrid/SV%204.GIF 

 



Le hemos llamado "flecha.bmp". 

-Señal Stop Paso de aviones: También duplicamos su tamaño (58x58 px). 

https://commons.wikimedia.org/wiki/File:Airport_stop_sign_%28type_1%29.svg 

 

Le llamamos "stopaviones.bmp". 

Ahora tenemos un montón de archivos bmp, dispersos en el directorio "TEXTURAS LEBA". Así no nos valen, tenemos 

que agruparlos en un único archivo de imagen. Para ello, en Photoshop abrimos un archivo nuevo, y le damos de 

tamaño 1024x1024 px. Ya comentamos que nos va a sobrar imagen, pero ahora la rellenaremos con otra cosa. 

Abrimos también todos nuestros archivos bmp, y simplemente vamos copiando y pegando dentro de nuestra nueva 

imagen. Como vemos, cada archivo que pegamos nos crea una nueva capa, así que id seleccionando cada una y la 

vais disponiendo como si fuera un puzzle. A mí me ha quedado algo así: 

 

Me he dado cuenta de que nos sobraba un bmp, concretamente el "tomcont2", ya que nos puede valer el de las tres 

barras, sólo que seleccionaremos dos al aplicar la textura correspondiente. Tenemos un enorme hueco, casi las 3/4 

partes de la hoja. Pero podemos hacer algo al respecto. 

Si comparamos el aspecto de nuestra pista y plataformas en FSX con las reales de LEBA, nos falta un detalle. La pista 

por ejemplo, presenta un rayado vertical, que nosotros no vemos, de igual forma que en la plataforma 2. También la 

plataforma 3, al ser muy vieja, tiene numerosas marcas de reparaciones o "cracks" en el pavimento. Podemos 

aprovechar estos huecos en la hoja de texturas para crear 3 nuevas, semitransparentes, que acoplaremos en unos 

GP que haremos sobre los de base. 

En primer lugar nos hará falta un software para capturar imágenes. Hay cientos de ellos gratuitos, yo en concreto 

uso Screen Capturer: 



http://screencapturer.com/ 

Ahí podéis descargarlo, y tras un registro gratuito descargarlo. Todos más o menos sabéi

tipo de programas. Vamos a SASPlanet, y capturamos 3 imágenes en las zonas que hemos comentado. También 

vamos a capturar una imagen en la zona de la cabecera 03 y otra en la 21, para superponerlas a las plataformas de 

seguridad. Las grabamos en el directorio "TEXTURAS LEBA" por ejemplo, y les llamamos 

"imgrwy","imgapron2","imgapron3","imgcabec03" e "imgcabec21". Todas en formato bmp.

El primer problema que tenemos que resolver es la orientación, para 

abrimos en Photoshop la primera de ellas. Hacemos Selección

casilla "Rotar" , escribimos 

quedarán rectas. Ahora damos a Selección

Pretendemos coger esa zona rebordeada, para repetirla. Pero nos están sobrando las líneas de eje. Eliminarlas es 

sencillo, simplemente seleccionáis una zona rectangular a la derecha o izquierda de la línea de ejes, y con un ancho 

Ahí podéis descargarlo, y tras un registro gratuito descargarlo. Todos más o menos sabéi

tipo de programas. Vamos a SASPlanet, y capturamos 3 imágenes en las zonas que hemos comentado. También 

vamos a capturar una imagen en la zona de la cabecera 03 y otra en la 21, para superponerlas a las plataformas de 

Las grabamos en el directorio "TEXTURAS LEBA" por ejemplo, y les llamamos 

"imgrwy","imgapron2","imgapron3","imgcabec03" e "imgcabec21". Todas en formato bmp.

El primer problema que tenemos que resolver es la orientación, para colocarlas en posición ortogonal. Para ello, 

abrimos en Photoshop la primera de ellas. Hacemos Selección->Todo, y Edición->Transformación libre. Ahora en la 

, escribimos -28,88°, que como sabemos es la orientación de la pista. Con ésto se 

quedarán rectas. Ahora damos a Selección->Deseleccionar Todo. Vamos a centrarnos en la imagen de la pista:

 

Pretendemos coger esa zona rebordeada, para repetirla. Pero nos están sobrando las líneas de eje. Eliminarlas es 

una zona rectangular a la derecha o izquierda de la línea de ejes, y con un ancho 

Ahí podéis descargarlo, y tras un registro gratuito descargarlo. Todos más o menos sabéis el funcionamiento de éste 

tipo de programas. Vamos a SASPlanet, y capturamos 3 imágenes en las zonas que hemos comentado. También 

vamos a capturar una imagen en la zona de la cabecera 03 y otra en la 21, para superponerlas a las plataformas de 

"imgrwy","imgapron2","imgapron3","imgcabec03" e "imgcabec21". Todas en formato bmp. Yo he obtenido éstas: 

 

 

colocarlas en posición ortogonal. Para ello, 

>Transformación libre. Ahora en la 

28,88°, que como sabemos es la orientación de la pista. Con ésto se 

>Deseleccionar Todo. Vamos a centrarnos en la imagen de la pista: 

 

Pretendemos coger esa zona rebordeada, para repetirla. Pero nos están sobrando las líneas de eje. Eliminarlas es 

una zona rectangular a la derecha o izquierda de la línea de ejes, y con un ancho 



mayor que el de dichas líneas. Haciendo click derecho en la selección, elegís "Capa Via Copiar", con lo que habremos 

creado una nueva capa copiada de nuestra selección. La movemos encima de los ejes, y desaparecen. Id eliminando 

imperfecciones de esta forma hasta que tengáis una zona rectangular limpia, combináis todas las capas, y hacéis una 

selección exclusivamente de la zona que queremos conservar. Vamos a Edición->Copiar, después a Archivo->Nuevo, 

y dejamos las dimensiones que nos vengan por defecto, ya que serán las de la selección que hicimos. Ahora hacemos 

Edición->Pegar, combinamos de nuevo las capas y guardamos nuestro archivo como bmp, machacando el que 

teníamos (imgrwy.bmp). Nos queda otro detalle. Al ser imágenes que se van a repetir longitudinalmente, si no 

igualamos las tonalidades de los extremos, se notará bastante los cambios. La mejor solución para eso es hacer una 

simetría. Si tenemos que nuestra imagen es de AxB píxeles, creamos una nueva imagen con Ax2B píxeles. Copiamos 

la original dentro de ésta nueva, la duplicamos y la colocamos en la parte libre. Con esa capa seleccionada, vamos a 

Edición->Transformar->Voltear Vertical, combinamos capas y machacamos nuestro archivo. Ya tenemos una imagen 

simétrica respecto al eje horizontal. 

 

Ahora volvemos a nuestro puzzle de texturas, y vemos en qué lugar podemos colocarla. En principio la colocaremos 

en la esquina inferior izquierda, en un tamaño aproximado de 534x534 px. Para adaptarla la imagen de la pista a esa 

medida, vamos a Imagen->Tamaño de imagen y modificamos sus valores. 

Al ser esta parte de la textura una zona semitransparente, lo que nos interesa es aumentar su contraste, para que se 

note el rayado. Incluso podemos convertirla a Blanco y Negro, con lo que notaremos más aun ese cambio de 

contraste. Para pasarla a B/N, vamos a Imagen->Ajustes->Blanco y Negro. Después a Imagen->Ajustes-

>Brillo/Contraste, hasta que nos guste el resultado. 

 



Hacemos más o menos algo parecido con la zona de la plataforma 2, y con la 3 lo que he hecho es hacerle simetría 

tanto vertical como horizontal, para ampliar la zona. Después con la varita mágica he seleccionado los "cracks" del 

pavimento para darles mayor contraste. 

 

Una vez acopladas todas las imágenes y combinadas las capas, me quedó algo así: 

 

Tenemos que grabar el archivo en bmp de 24 bits en el directorio "Textures_Dpy", dentro de ADE. Lo llamamos 

"LEBA_Marcas.bmp". A continuación vamos a crear el canal alfa. Pero hay que tener claro que vamos a hacer. En 

nuestra hoja de textura, sabemos que hay zonas que deben ser totalmente transparentes, que actualmente estamos 

viendo en negro, por ejemplo la zona entre barras blancas del umbral, las zonas entre números designadores, etc. 

Después habrá zonas que serán semitransparentes, como las zonas de coberturas de pista y plataformas. Iremos 

paso a paso.  

Lo primero que haremos será crear el canal alfa en Photoshop. Con nuestra imagen abierta, nos vamos a la zona del 

menú de capas, y pulsamos en la pestaña "Canales". Vemos los que tenemos actualmente, los RGB. Si vemos en la 

parte inferior a la derecha hay unos pequeñísimos iconos, y uno de ellos es "Crear canal nuevo" . Lo pulsamos y 

se nos crea el canal alfa, que actualmente vemos totalmente en negro, con el nombre "Alfa 1". Ahora volvemos a 

hacer click en el canal RGB, y lo que haremos será seleccionar cuidadosamente todas aquellas zonas que queremos 

que sean totalmente transparentes. 

En nuestro caso no es muy difícil, ya que son todas las zonas totalmente negras. Seleccionamos la herramienta de 

selección varita mágica y pinchamos en un punto negro. Tenemos que asegurarnos que solo seleccionamos las 

partes negras, que no haya "intromisiones" en bordes de otro color. Si tenemos que corregir algo, lo haremos con las 



herramientas de selección, sumando o restando áreas. Cuando estemos seguros, vamos de nuevo al canal alfa. 

Vemos que nuestra selección se mantiene. Lo que haremos será Selección->Invertir, con lo ahora tenemos 

seleccionado toda la imagen excepto las partes negras, y con el selector de color seleccionamos el color frontal como 

blanco total. Ahora vamos a Edición->Rellenar->Escogemos color frontal. Vemos que se ha rellenado de blanco 

(zonas opacas en FSX, es decir que veremos lo que tengamos dibujado en la textura) las zonas no transparentes. A 

continuación vamos al selector de color, y escogemos como color frontal un gris 50% (en el selector podéis ver el 

porcentaje de negro), y vamos a seleccionar en el canal RGB las zonas de pavimentos (rwy, apron2, apron3, cabec03 

y cabec21). Vamos al canal alfa, y rellenamos con ese gris. Por último, vamos al canal RGB de nuevo, y vamos a 

seleccionar con la varita mágica los cracks de la zona de la plataforma 3. Repasadlo con cuidado, y cuando lo 

tengamos, vamos a escoger un gris al 20% de negro (queremos que sean menos transparentes que el fondo). En el 

canal alfa rellenamos esa selección. A mí me ha quedado un canal alfa así: 

 

Lo vamos a grabar en formato BMP de 32 bits, en el directorio "TEXTURAS LEBA", con el mismo nombre que le dimos 

a la versión en 24 bits. (LEBA_Marcas). 

Ahora abrimos DXTBMP, y cargamos nuestro archivo. Comprobamos que el canal alfa está correcto, desactivamos la 

casilla "Include when saving" en el cuadro de la parte superior derecha "Mipmaps" (MUY IMPORTANTE), y nos 

vamos a File->Save as. En el cuadro de selección, lo grabamos con extensión  "Extended Bitmap" (.bmp), y 

compresión DXT3 (ya que tenemos varios grises en el canal alfa), en el directorio "Textures" de ADE. 

A continuación, abrimos ADE y vamos a Tools->GP Texture Editor. En la persiana desplegable aparecerá nuestro 

archivo "LEBA_Marcas", con el comentario (No Def) a la derecha. La seleccionamos, como no uniforme (no 

necesitamos darle una medida predefinida), y damos a "Update Definition Files". Ya podremos elegirla en el GP 

Editor. 

18.7.ASIGNACION DE TEXTURA A GROUND POLYGONS 

El paso siguiente es asignar la textura a cada GP que fuimos creando. Mejor dicho, lo que hicimos fueron Helpers 

Shapes, que podemos transformar en GP seleccionándola, hacemos click derecho y “Make Custom Ground Poly”. 

Ahora nos sale el editor de GP. Vamos a ver un ejemplo de como colocar correctamente los vértices en relación a 

nuestra textura. Si nos centramos en las marcas de umbral de pista, vemos que nuestros vértices están girados con 

respecto a la textura. Esto es debido a la orientación del GP. En el display, hacemos una ventana de selección que 

englobe los 4 vértices y cuando éstos se vean en rojo, pulsamos el botón de control “Rotate”. Introducimos -28,88°, y 



ya tendremos alineados los vértices. Ahora, seleccionando vértices de dos en dos, y con los botones de control 

“Drag”, los situamos enmarcados dentro de nuestra parte de la textura que queremos que use nuestro GP. 

 

Cuando tengamos uno hecho, lo vamos copiando y pegando, haciendo que las Helpers Shapes nos sirvan de guía. 

Cuando acabemos, borramos todas las Helpers Shapes. Tened cuidado con asignar siempre la capa correspondiente, 

y en las orientaciones de algunos objetos (Por ejemplo el designador de la pista 21, los vértices habrán de ser 

“volteados” horizontal y verticalmente).  

Con un poco de paciencia, lograremos asignar todas y cada una de las texturas a los GP. Borramos las Helpers 

Shapes, las marcas de referencia que tengamos, y también podemos eliminar las plataformas (Aprons), ya que las 

tenemos creadas de ésta nueva manera. 

Ahora nos queda aplicar texturas “superpuestas” a la pista, las plataformas 2 y 3, y las cabeceras de las pistas. Para la 

pista, lo que vamos a hacer es crear 4 GP, dividiendo la pista longitudinalmente. Esto lo haremos para que la textura 

no se “estire” demasiado, cosa que ocurriría si solo hiciéramos un único GP.  Si trazamos una guía de referencia 

desde el comienzo de pista hasta el final, vemos que ésta tiene 2285 m. de longitud. Si hacemos 4 GP de 572x60 

metros la dividiremos. Lo hacemos con Helpers Shapes. No preocuparos de las zonas de viraje de los extremos. Le 

asignamos la capa 26, para que no se vean afectadas las marcas, y ajustamos los vértices. Copiamos ese GP hasta 

completar la pista.  

Para las zonas de plataformas haremos lo mismo, lo único es que la plataforma 3 (la de los cracks en la superficie), 

también la he subdividido en 4 GP, para que se vean las marcas con más fidelidad. 

Completamos con las zonas de cabeceras y con la plataforma 2. Ya hemos acabado. Si queréis podéis ajustar los 

valores de transparencia del canal alfa, y la distribución de vértices respecto de la textura, hasta que consigáis un 

resultado que os guste. Aquí entra de lleno vuestra capacidad artística. 

Ahora vemos un pequeño reportaje de cómo ha quedado la cosa. 



 

 



Antes de terminar con los GP, os propongo un ejercicio. Podéis crear todos los polígonos de suelo que forman la 

entrada principal al aeropuerto, la carretera de acceso, la rotonda que tiene un avioncito como estatua, etc, con 

todas sus marcas. También los suelos de los edificios. Controlad bien las capas, los anchos de línea, las texturas de 

fondo, etc, y cuando terminéis tendréis un dominio total de ésta potente herramienta de ADE. 

 

 

 

19. OBJETOS DE ESCENARIO 

Este es el último procedimiento que ADE nos permite para generar escenarios. Ya sabemos que los objetos de 

escenario son modelos 3D, a los que se les aplica una textura, para incorporarlos al FSX. ADE no nos permite el crear 

esos objetos, ya que eso es tarea para un software mucho más específico, de diseño 3D (Gmax, 3DSMax, 

Sketchup,etc.). Pero si nos permite ciertas cosas. En principio, ADE establece 3 tipos de objetos de escenario: 



-Edificios Genéricos (Generic Buildings): Nos permite colocar edificios que ya tiene FSX creados en sus bases de 

datos. Estos edificios son en cierto modo “moldeables”, y lo podemos hacer con otro tipo de programas, pero no con 

ADE, que tan solo tiene una librería, que lo que nos permitirá será colocarlos en nuestro escenario. 

-Objetos de librería (Library Objects): Aquí lo que nos va a permitir es usar librerías de objetos, tanto de FSX como de 

terceras personas, y que normalmente son elementos sencillos de uso habitual en escenarios o aeropuertos 

(antenas, vegetación, personas, vehículos, aviones estáticos, estaciones de radioayudas, etc). Las librerías son 

archivos .bgl que contienen modelos (archivos .mdl) que son objetos creados por software de diseño 3D. Tiene 

muchas ventajas el usar objetos de librería, ya que afecta menos al rendimiento. En principio nosotros podremos 

usar las librerías que trae FSX por defecto, o bien la librería que dispone AHSC.  

-Modelos de Usuario (User Models): ADE también nos va a permitir el colocar objetos que hayamos diseñado 

nosotros con software externo, si creamos una librería. 

Esta parte de objetos de escenario de ADE la usaremos, pero más adelante, en el capítulo de Acabados y Detalles. 

Con esto hemos terminado por el momento con ADE. A continuación entraremos en uno de los procedimientos 

fundamentales en el diseño de aeropuertos para FSX, que es el modelado y texturizado de objetos (edificios 

principalmente). 

CREACION DE OBJETOS Y EDIFICIOS DEL AEROPUERTO 

Entramos de lleno en el paso clave para la realización de nuestro aeropuerto. Realmente es lo que va a diferenciarlos 

del resto, y es la creación de edificios. Esto se hará a través de un software de diseño 3D, le aplicaremos texturas, lo 

grabaremos, compilaremos y lo colocaremos en su sitio. 

Existen numerosas alternativas para el software que usaremos en nuestro diseño tales como Sketchup, GMax, 

3DSMax, Blender, Maya, Cinema4D, etc. Algunos son gratuitos y otros de pago, pero todos tienen en común una 

cosa, y es que no es fácil su uso hasta que no nos acostumbramos. Yo usaré GMax, que es una especie de adaptación 

más ligera del todopoderoso 3DSMax, pero que es gratuito, viene adaptado para trabajar con FSX, y sobre todo 

porque es el que más he usado. Para descargar GMax: 

http://www.turbosquid.com/gmax 

Os tendréis que registrar, pero como hemos comentado es gratuito. Una vez que lo instaléis, tendremos que hacer 

unas cuantas cosas: 

-1. Tendremos que cambiar la configuración regional de Windows, para indicarle que el símbolo de decimal sea un 

punto en lugar de una coma. Para ello, en Windows, vamos al menú Inicio->Panel de Control->Configuración regional 

y de idioma. En la pestaña Formatos, pulsamos el botón “Configuración adicional”, en la casilla “Símbolo decimal”, 

ponemos el punto en lugar de la coma que viene preestablecida. Aplicamos cambios y salimos. Esto es para 

Windows 7, que es el que yo uso, me imagino que para otras versiones será algo parecido. 

-2. Ahora tendremos que instalar el FSX GMax Gamepack, que es un añadido que tenemos dentro del SDK que 

instalamos al principio de todo, y que nos permitirá hacer determinadas operaciones para FSX dentro de GMax. Lo 

primero que tenemos que hacer es arrancar Gmax una vez. Lo primero que nos preguntará GMax será que 

configuración queremos para el visor. Elegimos el que sea 3D. Una vez que arranque, vamos a Customize->Units 

Setup, y seleccionamos Metric (Meters). Cerramos GMax. 

Ahora, tenemos que copiar el directorio FSX_GmaxGamePack, que se encuentra en Microsoft  Flight Simulator X 

SDK-> SDK-> Environment Kit-> Modeling SDK, al directorio gamepacks que se ubica en el directorio de instalación de 

GMax.  Dentro de éste mismo directorio también tenemos un acceso directo que se llama FSX_Gmax. Lo copiamos 

en nuestro escritorio y lo ejecutamos. Si arranca GMax, para asegurarnos que está bien configurado, deberá 

aparecernos un nuevo menú llamado “FSTools”, con cuatro herramientas dentro: 



 

Si no arranca GMax desde el acceso directo que hemos creado, es porque el gamepack asume que lo tenemos 

instalado en el directorio C:\gmax. Si lo tenemos en otro distinto, debemos de abrir el fichero gmax.ini dentro del 

directorio FSX Gamepack que tenemos en el de instalación de gmax, y modificar todas las rutas que apuntan 

erróneamente, y anotar la ruta correcta. 

1.CONSIDERACIONES PREVIAS 

Como ya hemos comentado, el diseño 3D de objetos no es una tarea fácil, debido a la innumerable cantidad de 

variables que intervienen en los programas que permiten realizar éstos objetos. Yo voy a usar GMax, que no es en 

absoluto el más simple, pero si los edificios que hagamos no tienen formas complicadas, podemos ir adaptándonos 

poco a poco. En principio, el aeropuerto de Córdoba no tiene muchas dificultades, y para no extendernos en el 

tutorial, aquí crearemos el edificio Terminal, que quizá sea el más representativo.  Después vosotros tendréis que 

crear el resto, siguiendo el mismo procedimiento. 

Lo primero que tenemos que hacer es conseguirnos un plano detallado del aeropuerto, y vamos a marcar todos y 

cada uno de los edificios que lo componen, y que tendréis que ir haciendo. Podemos usar una foto aérea, el plano de 

AENA, etc. Les pondremos un nombre a cada uno. Tened en cuenta que habrá determinados edificios o instalaciones 

que quizá no tengamos que hacer, ya que podremos usar objetos de librería (casetas del VOR y del NDB, estación de 

combustibles, etc.). 



 

Hemos dividido en dos zonas, la del aeropuerto propiamente y las del aeroclub, que también haremos debido a su 

cercanía y a su belleza. 

Ahora viene el proceso de documentación para poder reproducir lo más fielmente posible las instalaciones. 

Debemos de buscar fotos de todos los edificios. Podemos intentarlo primero con Google, en la sección de imágenes, 

en las fotos de Panoramio de Google Earth, en AENA, dentro de la sección Aeropuertos, en Bing Maps, 

especialmente en la vista de pájaro, en páginas web particulares (por ejemplo la del Real Aeroclub de Córdoba, la de 

Trabajos Aéreos Espejo, etc.), en páginas web de aviación (AviationCorner.net, Airliners.net o JetPhotos.net, 

realizamos búsquedas por aeropuerto). Recopilad todas las que podáis que seguro que os faltarán aún más. 

Almacenad todas en una carpeta que se llame “Fotos LEBA” o algo así. Dentro de ésta carpeta si queremos podemos 

subdividirla por edificios, con una carpeta “Terminal”, o “Hangares”, o “Vistas generales”. 

También necesitaremos medir, tanto en fotos aéreas como en fotografías de fachadas, con el método que usamos 

anteriormente para calcular alturas. Pues también sirve para calcular anchos, longitudes, etc, pero ojo con la 

distorsión que genera la perspectiva de las fotos. Nos puede llevar a confusiones. Para medir en aéreo, podemos 

usar Google Earth, SASPlanet, o incluso la página del Catastro. Todo vale. También suelen haber muchos planos en 

los Planes Directores de los Aeropuertos, que AENA y el Ministerio de Fomento ponen a nuestra disposición. 

Con todo esto recopilado, comenzamos con el primer edificio. Haremos la Terminal, que presenta este aspecto 

desde el lado aire: 



 

Y éste desde el lado tierra: 

 

Vemos que es un edificio de planta rectangular, de tres alturas, más la antigua torre de control que actualmente no 

está en uso. Tiene una cubierta volada, con dos aguas y pendiente hacia el centro del edificio. Casi todos son 

volúmenes simples. Tenemos que crearnos bocetos de plantas y alzados, e ir anotando las medidas que podamos 

tomar. Los bocetos los podemos hacer a mano, o bien si disponéis de un software de diseño CAD, mucho mejor. De 

todas formas, seguro que tendremos que ir improvisando algunas medidas al ir creando el modelo en GMax. Cread 

tantos bocetos como creáis que vayáis a necesitar, nunca os sobrarán, creedme. A continuación, las próximas hojas 

serán los bocetos que cree en formato CAD, que usaremos de apoyo. 
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Ya tenemos todo listo para empezar a trabajar con GMax. 

2.GMAX 

El proceso de creación de objetos para escenarios de FSX sigue una secuencia determinada: 

1.Modelado del objeto: Se hace en Gmax, a base de crear primitivas de objetos y modificarlas hasta obtener el 

resultado requerido. Iremos grabando archivos con extensión .gmax, preferentemente en el directorio Scenes que 

existe dentro de \gmax\gamepacks\FSX_GMaxGamePack 

2.Texturizado del objeto: Primero crearemos la hoja de texturas, con programas de edición gráfica (PhotoShop, 

GIMP, etc.). Las grabaremos en formato .bmp de 24 bits, para que las pueda leer GMax. Es bueno que éstas texturas 

las almacenemos en el directorio Textures dentro de \gmax\gamepacks\FSX_GMaxGamePack. A continuación 

iremos asignando éstas texturas como materiales, que se irán incorporando al archivo .gmax. Por otra parte, 

tendremos que crear la versión extendida de las hojas de texturas, formato DXT1, DXT3 o DXT5, con DXTBMP. 

Importante que no variemos el nombre de éstas texturas extendidas con respecto a las originales, así que las 

guardaremos en un directorio Textures independiente (en el escritorio por ejemplo, en un directorio 

\LEBA_TexturasExtendidas). 

3.Exportación del objeto: Una vez modelado y texturizado completamente, debemos de exportarlo con Gmax, hasta 

obtener un archivo con extensión .mdl (Modelo de FSX). 

4.Creación de librería de objetos: Cuando hayamos creado todos nuestros edificios, con sus correspondientes 

archivos .mdl, usaremos un software como Library Creator XML, que los aglutinará y compilará como archivos de 

librería de objetos  (.bgl). Es bueno no confundir éste archivo .bgl de librería con el .bgl que resulte al final del 

proceso de compilación, por lo que podemos llamarlo por ejemplo LEBA_libreria.bgl. 

5.Emplazamiento de los objetos: Usando un software como ADE, podemos cargar nuestra librería de objetos, e ir 

incorporando los modelos a nuestro escenario, uno a uno, colocándolos en su posición y orientación correcta.  

6.Compilado final: Por último, compilando en ADE, obtendremos nuestro escenario definitivo con todos los objetos 

que le hayamos incorporado. Aquí obtendremos el archivo definitivo, dentro de \LEBA\Scenery. Tenemos que 

incorporar las texturas extendidas dentro de \LEBA\Textures. 

Todo parece un poco enrevesado, y efectivamente lo es, pero aunque no lo parezca, es posible hacerlo. 

2.1.INTRODUCCION A GMAX 

GMax en un programa de modelado 3D, gratuito, y que surgió como hermano pequeño del todopoderoso 3DSMax, 

de la casa Autodesk, y que se destinó fundamentalmente para que desarrolladores de juegos realizaran sus 

aportaciones a nivel particular. En un principio surgió para FS2004, ya que incluso venía incorporado en su SDK. Pero 

la casa comercializadora dejó de prestar soporte, y su uso fue decayendo. Aunque aún es posible emplearlo para 

FSX. 

La forma de trabajo no es demasiado cómoda, y lo notaréis si sois usuarios de otros tipos de programas de modelado 

3D. Yo por ejemplo uso AutoCAD para mi trabajo, y aunque no es un programa enfocado para el 3D, su modo de 

usarlo es infinitamente más intuitivo y sencillo que GMax.  

No se si seré capaz de mostraros paso a paso la realización del edificio terminal, pero lo intentaré. Lo que sí me 

resulta imposible es explicar detalladamente cada menú, cada orden que tengamos que darle. Os mostraré un poco 

en plan general la interfaz de usuario, y los pasos que se suelen dar. 

Comentaros que en líneas generales, GMax usa para modelar objetos lo que se llaman “primitivas”. Las primitivas 

son formas básicas desde las que se parte para tras su edición convertirlas en otras más complicadas. Pueden ser por 



ejemplo un cubo, una esfera, una pirámide, un rectángulo, una línea, etc. A partir de éstas primitivas se empieza por 

la edición de las mismas, ya que se pueden modificar en cuanto a tamaño, posición, orientación, etc. Una vez que la 

primitiva está definida, normalmente se transforma en formas editables, que pueden ser “Editable Shapes”, 

“Editable Polys” o “Editable Mesh”. Una vez transformadas, podemos acceder a las subdivisiones de éstas formas, es 

decir, podremos seleccionar vértices, aristas, caras o elementos completos.  A éstos elementos se le pueden aplicar 

“modificadores”, que prácticamente te permiten realizar todo tipo de operaciones algo más complejas, como doblar, 

torsionar, deformar, plegar, etc. 

Además también se pueden realizar operaciones booleanas, que son aquellas que permiten formar un objeto a 

partir de otros dos existentes, mediante suma de esos objetos, sustracción o interferencia de unos con otros. 

Una vez tenemos nuestras formas definidas, podemos unir varias, separarlas, cortarlas, hasta obtener nuestro 

modelo definitivo. El siguiente paso es el texturizado, que es la aplicación de materiales a los objetos. Materiales que 

en nuestro caso serán hojas de texturas, y que de igual forma que con los objetos en sí, también se pueden 

proyectar de diferentes formas, escalarlas, asignar mapeos diferentes a cada elemento, etc, de una forma parecida a 

cómo hacíamos con los Ground Polys en ADE. 

Por último solo nos quedaría el exportarlo a FSX, que se realiza en un par de pasos relativamente simples, para 

obtener nuestro archivo de modelo .mdl, listo para ser incorporado a una librería. 

Veamos el interfaz de ususario de Gmax: 

 

1.Barra de menús: Como en cualquier software, aquí van los menús más generales, donde podremos grabar, 

exportar, configurar el programa, la ayuda (que tendréis que usar muy a menudo), etc. 



2.Paneles de comandos:  Aquí se encuentran las pestañas de creación, modificación, jerarquías (que sólo usaremos 

cuando queramos modificar el sistema de referencia con respecto a un objeto), movimientos (que no usaremos 

nunca), pantalla (para mostrar u ocultar determinados elementos que nos molesten en un momento dado), y 

utilidades (que nos servirán de apoyo en ciertas ocasiones, por ejemplo para contar cuántos polígonos tenemos en 

nuestros objetos). 

3.Categorías de objetos: Este panel solo aparece en el comando de creación, y es donde escogeremos que es lo que 

queremos crear, objetos 3D, formas 2D, luces (no lo usamos), cámaras (tampoco), ayudas (por ejemplo una cinta 

métrica), y sistemas (que no usaremos tampoco). Cada una de éstas categorías tiene justo debajo un menú donde se 

subdivide los tipos de elementos disponibles para crear. 

4.Persianas: Es la zona donde se nos abren todas las posibilidades de acciones que tenemos disponibles para el tipo 

de elemento que tengamos seleccionado en las categorías de objetos. Algunos tienen tantas persianas que 

tendremos que desplazar éstas hacia abajo para verlas todas. Es lo que más usaremos. 

5.Ventanas de visión: Es la zona donde se nos muestra gráficamente nuestro objeto. Son totalmente configurables, 

así que podremos elegir cuántas ventanas queremos, su disposición, el punto de vista, etc. La ventana activa aparece 

con un sombreado a su alrededor. 

6.Navegación de las ventanas de visión: Estos pequeños iconos nos permitirán realizar operaciones en las ventanas, 

como ampliarlas todas al máximo, rotar el punto de vista, etc. 

7.Controles de tiempo: No lo usaremos, ya que se emplea sólo para animaciones. 

8.Snaps: Esto nos permite seleccionar elementos singulares cuando usemos comandos de edición en los objetos, por 

ejemplo, referirnos a un vértice, a un punto medio, a un centro de un círculo, etc. 

9.Degradation override: No lo usamos. 

10.Ventana/Cruce: Esto nos permite diferenciar si preferimos seleccionar los objetos que íntegramente entren 

dentro de una ventana de selección o que tan sólo con que toque esa ventana quede seleccionado. 

11.Atajos de teclado: Esto activa o desactiva si queremos usar teclas para ejecutar algunas acciones. 

12.Display de coordenadas: Esto es fundamental, ya que aquí trabajaremos con las coordenadas de nuestros objetos 

para cualquier acción que hagamos sobre ellos. Tiene un pequeño icono a la izquierda que nos permitirá establecer 

si trabajamos en coordenadas absolutas respecto al sistema de coordenadas general, o bien en coordenadas 

relativas, respecto al eje de coordenadas que se centra en cada objeto individualmente.  

13.Barra de status/comando activo: Nos dice que tenemos seleccionado, y que comando está en ejecución. 

14.MaxScript Listener: No lo usamos. 

15.Barra de progreso: No se usa, tan solo para animaciones. 

16.Barra de tiempo: No se usa. 

17.Cajas de herramientas: Aquí tenemos una serie de botones que son usados frecuentemente para editar los 

objetos, y que nos facilitan el trabajo. Podemos quitar o añadir los que queramos. 

Lo primero que haremos será configurar un poquito GMax para empezar a trabajar. Vamos al menú Customize-

>Units Setup, y establecemos Metric, y Meters como opciones. Ahora volvemos a Customize->Grid and Snap 

Settings, y en la pestaña Snaps, desactivamos Grid Points, y marcamos Vertex. En Customize->Viewport 

Configuration, en la pestaña Rendering Method, lo dejamos como está, pero marcamos Shade Selected Faces. En la 

pestaña Layout podemos cambiar si queremos la configuración de las ventanas, pero yo os recomiendo dejarla así de 



momento. Por último en Customize->Preferences, e

Scale, 1 unidad sea igual a 1 metro. 

Ya lo tenemos configurado, así que comenzamos. Lo primero será grabar la escena. Vamos a FIle

del subdirectorio Scenes del FSX_GmaxGamePack, lo

Sería interesante que vieráis algún tutorial de modelado en Gmax. Hay infinidad de ellos en Internet, pero a mí me 

gusta uno en particular, donde el mago Arno Gerretsen crea una iglesia sencilla. Olvidaros de los últimos pasos

da en el video referente al posicionamiento de objetos, ya que actualmente se hace de una manera más simple.

http://www.fsdeveloper.com/wiki/index.php?title=Creating_a_simple_object_in_GMax_video_tutorial

1.MODELADO 

Haremos el cubo de la planta baja. Sus dimensiones son 51,40x13,40m., con una altura que es variable debido al 

cambio de pendiente de la cubierta. Vamos al panel de comando Creation

Desplegamos la persiana Keyboard Entry, y en las coordenadas dejamos 0,0,0 (ojo con las coordenadas en GMax, 

que lo que hará será situar esas coordenadas en el centro geométrico del objeto, no en una esquina), y anotam

valores Lenght=51.40, Width=13.40, Height=8.00. Más abajo, en la persiana Parameters, ponemos en Width Segs=2. 

Pulsamos Create, y nos aparecerá el cubo.

Le hemos dado 8,00 metros de altura porque después lo recortaremos con la cubierta, y hemos 

segmentos en el ancho porque tenemos un quiebro en el cambio de pendiente. Ahora, con el objeto seleccionado, 

nos vamos al display, y hacemos click derecho. En la opción Convert to, elegimos Convert to editable poly. Si os fijáis 

ahora en los paneles de comandos, se nos ha cambiado a Modificación, y vemos en la persiana que podemos elegir 

subelementos para modificarlos (vértices, aristas, caras o elementos). Justo debajo del panel de comandos aparece 

el nombre del objeto (que ahora será Box01), y

color menos llamativo. 

Vamos con la cubierta. Creamos un Box, de dimensiones 53,60x17,60x0,20 metros, en las coordenadas 0,0,0 

también. Le damos también dos segmentos en el ancho. Vemos que

normal. Lo convertimos a Editable Poly. Ahora vamos a crear el quiebro de la cubierta. En la pestaña de selección de 

subelementos, seleccionamos Vertex. Vemos que se nos resaltan en azul. Ahora solo podemos sel

manipular vértices. En la Ventana Front, seleccionamos con una ventana los dos vértices centrales (aunque en 

>Preferences, en la pestaña General, nos aseguramos que en System Units 

Ya lo tenemos configurado, así que comenzamos. Lo primero será grabar la escena. Vamos a FIle

del subdirectorio Scenes del FSX_GmaxGamePack, lo llamamos LEBAterminal.gmax.  

Sería interesante que vieráis algún tutorial de modelado en Gmax. Hay infinidad de ellos en Internet, pero a mí me 

gusta uno en particular, donde el mago Arno Gerretsen crea una iglesia sencilla. Olvidaros de los últimos pasos

da en el video referente al posicionamiento de objetos, ya que actualmente se hace de una manera más simple.

index.php?title=Creating_a_simple_object_in_GMax_video_tutorial

Haremos el cubo de la planta baja. Sus dimensiones son 51,40x13,40m., con una altura que es variable debido al 

cambio de pendiente de la cubierta. Vamos al panel de comando Creation->Geometry->Standard Primitives

Desplegamos la persiana Keyboard Entry, y en las coordenadas dejamos 0,0,0 (ojo con las coordenadas en GMax, 

que lo que hará será situar esas coordenadas en el centro geométrico del objeto, no en una esquina), y anotam

Lenght=51.40, Width=13.40, Height=8.00. Más abajo, en la persiana Parameters, ponemos en Width Segs=2. 

Pulsamos Create, y nos aparecerá el cubo. 

Le hemos dado 8,00 metros de altura porque después lo recortaremos con la cubierta, y hemos 

segmentos en el ancho porque tenemos un quiebro en el cambio de pendiente. Ahora, con el objeto seleccionado, 

nos vamos al display, y hacemos click derecho. En la opción Convert to, elegimos Convert to editable poly. Si os fijáis 

neles de comandos, se nos ha cambiado a Modificación, y vemos en la persiana que podemos elegir 

subelementos para modificarlos (vértices, aristas, caras o elementos). Justo debajo del panel de comandos aparece 

el nombre del objeto (que ahora será Box01), y el color. Yo se lo he cambiado a “plantabaja”, y he escogido otro 

Vamos con la cubierta. Creamos un Box, de dimensiones 53,60x17,60x0,20 metros, en las coordenadas 0,0,0 

también. Le damos también dos segmentos en el ancho. Vemos que se nos crea a nivel de suelo también, que es 

Lo convertimos a Editable Poly. Ahora vamos a crear el quiebro de la cubierta. En la pestaña de selección de 

subelementos, seleccionamos Vertex. Vemos que se nos resaltan en azul. Ahora solo podemos sel

manipular vértices. En la Ventana Front, seleccionamos con una ventana los dos vértices centrales (aunque en 

n la pestaña General, nos aseguramos que en System Units 

Ya lo tenemos configurado, así que comenzamos. Lo primero será grabar la escena. Vamos a FIle->Save as, y dentro 

Sería interesante que vieráis algún tutorial de modelado en Gmax. Hay infinidad de ellos en Internet, pero a mí me 

gusta uno en particular, donde el mago Arno Gerretsen crea una iglesia sencilla. Olvidaros de los últimos pasos que 

da en el video referente al posicionamiento de objetos, ya que actualmente se hace de una manera más simple. 

index.php?title=Creating_a_simple_object_in_GMax_video_tutorial 

Haremos el cubo de la planta baja. Sus dimensiones son 51,40x13,40m., con una altura que es variable debido al 

>Standard Primitives->Box. 

Desplegamos la persiana Keyboard Entry, y en las coordenadas dejamos 0,0,0 (ojo con las coordenadas en GMax, 

que lo que hará será situar esas coordenadas en el centro geométrico del objeto, no en una esquina), y anotamos los 

Lenght=51.40, Width=13.40, Height=8.00. Más abajo, en la persiana Parameters, ponemos en Width Segs=2. 

 

Le hemos dado 8,00 metros de altura porque después lo recortaremos con la cubierta, y hemos puesto dos 

segmentos en el ancho porque tenemos un quiebro en el cambio de pendiente. Ahora, con el objeto seleccionado, 

nos vamos al display, y hacemos click derecho. En la opción Convert to, elegimos Convert to editable poly. Si os fijáis 

neles de comandos, se nos ha cambiado a Modificación, y vemos en la persiana que podemos elegir 

subelementos para modificarlos (vértices, aristas, caras o elementos). Justo debajo del panel de comandos aparece 

el color. Yo se lo he cambiado a “plantabaja”, y he escogido otro 

Vamos con la cubierta. Creamos un Box, de dimensiones 53,60x17,60x0,20 metros, en las coordenadas 0,0,0 

se nos crea a nivel de suelo también, que es 

Lo convertimos a Editable Poly. Ahora vamos a crear el quiebro de la cubierta. En la pestaña de selección de 

subelementos, seleccionamos Vertex. Vemos que se nos resaltan en azul. Ahora solo podemos seleccionar y 

manipular vértices. En la Ventana Front, seleccionamos con una ventana los dos vértices centrales (aunque en 



realidad estamos seleccionando 4, ya que también marcará los que están al fondo). Se nos marcan en rojo y nos sale 

una cruz de desplazamiento. Pero aún no podemos desplazar nada, ya que tenemos que seleccionar en la caja de 

herramientas el icono “Select and Move”. Ahora nos cambia la cruz y salen unas flechitas. Vamos a desplazar esos 

cuatro vértices 1,00 metro hacia abajo. Para hacerlo, n

Absolut Mode Trasform hasta que se nos ponga en Offset Mode Transform (

En la ventana del eje Y ponemos -1.00. Vemos que se nos desplazan hacia abajo.

Y os preguntaréis ¿por qué hemos introducido 

las alturas?. Pues es otra peculiaridad de GMax, y es que cuando desplacemos elementos, en coordenadas relativas, 

siempre se refiere a las coordenadas de la ventana activa. 

corresponde a la anchura, y la Y a la altura. Si estuviéramos en la vista Top, el eje X es la anchura y la Y la longitud.

Ahora vamos a elevar la cubierta, como si tuviéramos una g

de “Vertex”, y en Front seleccionamos el elemento de la cubierta, que ahora mismo es todo el objeto. Veremos que 

se nos marca en rojo. Ahora en la ventana de coordenadas, en la Y, ponemos 5,00 m. Ya es

Desactivamos la selección “Elements”, para no mover nada que no queramos, y nos fijamos en la ventana 

Perspective. Se aprecia que aunque está hecho el quiebro en la cubierta, GMax nos “suaviza” es quiebro y lo deja en 

un cambio suave y gradual. Como no queremos eso, vamos a solucionarlo. Activamos “Elements” de nuevo, hasta 

realidad estamos seleccionando 4, ya que también marcará los que están al fondo). Se nos marcan en rojo y nos sale 

iento. Pero aún no podemos desplazar nada, ya que tenemos que seleccionar en la caja de 

herramientas el icono “Select and Move”. Ahora nos cambia la cruz y salen unas flechitas. Vamos a desplazar esos 

cuatro vértices 1,00 metro hacia abajo. Para hacerlo, nos vamos al display de coordenadas, y marcamos el icono 

Absolut Mode Trasform hasta que se nos ponga en Offset Mode Transform ( ), que son las coordenadas relativas. 

1.00. Vemos que se nos desplazan hacia abajo. 

untaréis ¿por qué hemos introducido -1,00 m. en la ventana del eje Y, cuando en realidad es el eje Z el de 

las alturas?. Pues es otra peculiaridad de GMax, y es que cuando desplacemos elementos, en coordenadas relativas, 

s de la ventana activa. En esta caso la ventana activa es Front, y el eje X 

corresponde a la anchura, y la Y a la altura. Si estuviéramos en la vista Top, el eje X es la anchura y la Y la longitud.

Ahora vamos a elevar la cubierta, como si tuviéramos una grua. Seleccionamos los subelementos “Element” en lugar 

de “Vertex”, y en Front seleccionamos el elemento de la cubierta, que ahora mismo es todo el objeto. Veremos que 

se nos marca en rojo. Ahora en la ventana de coordenadas, en la Y, ponemos 5,00 m. Ya es

Desactivamos la selección “Elements”, para no mover nada que no queramos, y nos fijamos en la ventana 

Se aprecia que aunque está hecho el quiebro en la cubierta, GMax nos “suaviza” es quiebro y lo deja en 

l. Como no queremos eso, vamos a solucionarlo. Activamos “Elements” de nuevo, hasta 

realidad estamos seleccionando 4, ya que también marcará los que están al fondo). Se nos marcan en rojo y nos sale 

iento. Pero aún no podemos desplazar nada, ya que tenemos que seleccionar en la caja de 

herramientas el icono “Select and Move”. Ahora nos cambia la cruz y salen unas flechitas. Vamos a desplazar esos 

os vamos al display de coordenadas, y marcamos el icono 

), que son las coordenadas relativas. 

 

1,00 m. en la ventana del eje Y, cuando en realidad es el eje Z el de 

las alturas?. Pues es otra peculiaridad de GMax, y es que cuando desplacemos elementos, en coordenadas relativas, 

En esta caso la ventana activa es Front, y el eje X 

corresponde a la anchura, y la Y a la altura. Si estuviéramos en la vista Top, el eje X es la anchura y la Y la longitud. 

rua. Seleccionamos los subelementos “Element” en lugar 

de “Vertex”, y en Front seleccionamos el elemento de la cubierta, que ahora mismo es todo el objeto. Veremos que 

se nos marca en rojo. Ahora en la ventana de coordenadas, en la Y, ponemos 5,00 m. Ya está elevado. 

 

Desactivamos la selección “Elements”, para no mover nada que no queramos, y nos fijamos en la ventana 

Se aprecia que aunque está hecho el quiebro en la cubierta, GMax nos “suaviza” es quiebro y lo deja en 

l. Como no queremos eso, vamos a solucionarlo. Activamos “Elements” de nuevo, hasta 



que se vea en rojo, y en las persianas desplegables, bajamos abajo del todo hasta “Surface Properties”. Ahí vemos 

unos cuadritos con muchos números, y vemos que algunos fal

impone, que viene muy bien para elementos esféricos o cilíndricos, pero para nada para éste objeto. Debajo de esos 

cuadritos numerados pulsamos en “Clear All”, y vemos como desaparece el suavizado y aparec

Veis que se ven las aristas resaltadas, eso es muy útil porque vemos las subdivisiones de los elementos. Para lograrlo, 

solo tenemos que hacer click derecho sobre la palabra “Persepective”, y activar la casilla “Edged Faces”.

Otra cosa importante es que vayamos grabando continuamente, ya que GMax tiene la bonita costumbre de cerrarse 

sin venir a cuento, y con ello perder muchos datos.

Este objeto lo llamaremos “cubiertabaja”. Si nos fijamos en los alzados que tenemos de plantilla, ve

vuelos de la cubierta no son simétricos respecto de la anchura del edificio, sino que por el lado aire tenemos 0,60 m. 

y por el lado tierra 3,60 m. O desplazamos la cubierta o desplazamos el edificio. Yo he escogido desplazar el edificio, 

por el sencillo motivo de que el centro de coordenadas será en un futuro el punto de inserción de nuestro objeto en 

el escenario, y si nos guiamos por la foto aérea en ADE, lo que estamos viendo es la cubierta realmente, no el 

edificio, así que será mas fácil centrarla. ¿Qué cantidad tenemos que desplazarlo?. Pues si actualmente los vuelos 

tienen por cada lado 17,60-13,40=4,20/2=2,10 metros, y tiene que estar uno a 3,60, pues tenemos que moverlo 1,50 

metros a la derecha. Para hacerlo, nos vamos a la ventana Fron

“Elements”, y marcamos hasta que se nos marque en rojo. A continuación, nos aseguramos que está seleccionada la 

herramienta “Select and Move”, y en las coordenadas relativas, ponemos en la X=1,50 m. Vemos que efect

se ha desplazado, pero también hemos desplazado 

seleccionamos “Vertex”, y marcamos los vértices centrales. Los desplazamos X=

izquierda. 

que se vea en rojo, y en las persianas desplegables, bajamos abajo del todo hasta “Surface Properties”. Ahí vemos 

unos cuadritos con muchos números, y vemos que algunos faltan. Esos son los grupos de suavizado que Gmax nos 

impone, que viene muy bien para elementos esféricos o cilíndricos, pero para nada para éste objeto. Debajo de esos 

cuadritos numerados pulsamos en “Clear All”, y vemos como desaparece el suavizado y aparec

Veis que se ven las aristas resaltadas, eso es muy útil porque vemos las subdivisiones de los elementos. Para lograrlo, 

solo tenemos que hacer click derecho sobre la palabra “Persepective”, y activar la casilla “Edged Faces”.

osa importante es que vayamos grabando continuamente, ya que GMax tiene la bonita costumbre de cerrarse 

sin venir a cuento, y con ello perder muchos datos. 

Este objeto lo llamaremos “cubiertabaja”. Si nos fijamos en los alzados que tenemos de plantilla, ve

respecto de la anchura del edificio, sino que por el lado aire tenemos 0,60 m. 

y por el lado tierra 3,60 m. O desplazamos la cubierta o desplazamos el edificio. Yo he escogido desplazar el edificio, 

l sencillo motivo de que el centro de coordenadas será en un futuro el punto de inserción de nuestro objeto en 

el escenario, y si nos guiamos por la foto aérea en ADE, lo que estamos viendo es la cubierta realmente, no el 

entrarla. ¿Qué cantidad tenemos que desplazarlo?. Pues si actualmente los vuelos 

13,40=4,20/2=2,10 metros, y tiene que estar uno a 3,60, pues tenemos que moverlo 1,50 

metros a la derecha. Para hacerlo, nos vamos a la ventana Front, seleccionamos el objeto, seleccionamos 

“Elements”, y marcamos hasta que se nos marque en rojo. A continuación, nos aseguramos que está seleccionada la 

herramienta “Select and Move”, y en las coordenadas relativas, ponemos en la X=1,50 m. Vemos que efect

se ha desplazado, pero también hemos desplazado la línea que parte en dos segmentos el objeto. Para corregir eso, 

seleccionamos “Vertex”, y marcamos los vértices centrales. Los desplazamos X=-1,50 m, para que vayan a la 

que se vea en rojo, y en las persianas desplegables, bajamos abajo del todo hasta “Surface Properties”. Ahí vemos 

tan. Esos son los grupos de suavizado que Gmax nos 

impone, que viene muy bien para elementos esféricos o cilíndricos, pero para nada para éste objeto. Debajo de esos 

cuadritos numerados pulsamos en “Clear All”, y vemos como desaparece el suavizado y aparecen todos los números. 

 

Veis que se ven las aristas resaltadas, eso es muy útil porque vemos las subdivisiones de los elementos. Para lograrlo, 

solo tenemos que hacer click derecho sobre la palabra “Persepective”, y activar la casilla “Edged Faces”. 

osa importante es que vayamos grabando continuamente, ya que GMax tiene la bonita costumbre de cerrarse 

Este objeto lo llamaremos “cubiertabaja”. Si nos fijamos en los alzados que tenemos de plantilla, vemos que los 

respecto de la anchura del edificio, sino que por el lado aire tenemos 0,60 m. 

y por el lado tierra 3,60 m. O desplazamos la cubierta o desplazamos el edificio. Yo he escogido desplazar el edificio, 

l sencillo motivo de que el centro de coordenadas será en un futuro el punto de inserción de nuestro objeto en 

el escenario, y si nos guiamos por la foto aérea en ADE, lo que estamos viendo es la cubierta realmente, no el 

entrarla. ¿Qué cantidad tenemos que desplazarlo?. Pues si actualmente los vuelos 

13,40=4,20/2=2,10 metros, y tiene que estar uno a 3,60, pues tenemos que moverlo 1,50 

t, seleccionamos el objeto, seleccionamos 

“Elements”, y marcamos hasta que se nos marque en rojo. A continuación, nos aseguramos que está seleccionada la 

herramienta “Select and Move”, y en las coordenadas relativas, ponemos en la X=1,50 m. Vemos que efectivamente 

la línea que parte en dos segmentos el objeto. Para corregir eso, 

1,50 m, para que vayan a la 



Nos queda cerciorarnos que la cubierta está a su altura correspondiente. Si miramos el alzado, vemos que el 

encuentro del vuelo del lado aire con el edificio tiene que estar a 4,00 metros del suelo. Para ver cuanto tenemos 

actualmente, vamos a las coordenadas y pulsamos

nos vamos a la ventana Front. Vamos ampliando al máximo el zoom hasta que veamos la coordenada Z que tiene ese 

encuentro. A mí me sale 4,591 m., o sea que está 0,591 m. más alta de la cuenta.

relativas, seleccionamos la cubierta, y lo bajamos esa cantidad. Nos aseguramos que ahora está a 4,00 m.

Yo se que estáis deseando de eliminar ese trozo de edificio que sobresale de la cubierta, y vamos a hacerlo ahora. 

Pero vamos a pensar como. Podríamos seleccionar los vértices dos a dos e ir bajándolos manualmente hasta su 

colocación definitiva, sabiendo la coordenada Z de cada uno de los 3 puntos de quiebro. Sabemos que los dos 

vértices de la izquierda hay que bajarlos a 4,0

ahora mismo están los 3 grupos a 8,00 m, calculamos las diferencias y los bajamos. Pero si ampliamos al máximo 

esas zonas vemos que no es una operación exacta, ya que por el redondeo o bie

metemos dentro del edificio. Os propongo un método exacto, que es hacerlo con una operación booleana. Lo que 

quiero decir con esto es que se creará un objeto nuevo fruto de una operación entre otros dos (unión, diferencia o

intersección). En éste caso, y actualmente no nos valdría ninguno, ya que si al edificio le restamos la cubierta, lo que 

vamos a obtener es un nuevo edificio con un hueco en medio, además de que la cubierta desparecería. Pero, ¿y si 

creamos una cubierta nueva, copia de la anterior, le subimos las dos caras superiores hasta que sobrepasen la altura 

del edificio, y los restamos?. Pensadlo bien, porque esa es la solución correcta. 

Primero colocamos los vértices donde estaban, haciendo Undo tres veces. Primer

copia quedará en el mismo sitio. Para ello, en la ventana Perspective, la seleccionamos, y con la herramienta “Select 

and Move” activada, hacemos Shift+Click en cualquier punto de la cubierta, pero sin desplazar el ratón. 

el cuadro “Clone Options”, marcamos “Copy”, y dejamos el nombre que nos sugiere, que es “cubiertabaja01”. 

Damos a OK. Aparentemente no vemos nada cambiado, pero realmente la copia está ahí pisando el objeto original. 

Ahora vamos a seleccionar las caras superiores de ese objeto copia, hasta que estén en rojos. Para seleccionar las 

caras, tenemos que elegir “polygons” en el menú de selección de subelementos. Ahora las desplazamos hacia arriba 

lo que nos de la gana, pero que sobrepase el bloque del

iorarnos que la cubierta está a su altura correspondiente. Si miramos el alzado, vemos que el 

encuentro del vuelo del lado aire con el edificio tiene que estar a 4,00 metros del suelo. Para ver cuanto tenemos 

actualmente, vamos a las coordenadas y pulsamos el icono para ponerlas en absolutas (Absolut Mode Transform), y 

nos vamos a la ventana Front. Vamos ampliando al máximo el zoom hasta que veamos la coordenada Z que tiene ese 

encuentro. A mí me sale 4,591 m., o sea que está 0,591 m. más alta de la cuenta. Cambiamos las coordenadas a 

relativas, seleccionamos la cubierta, y lo bajamos esa cantidad. Nos aseguramos que ahora está a 4,00 m.

Yo se que estáis deseando de eliminar ese trozo de edificio que sobresale de la cubierta, y vamos a hacerlo ahora. 

Podríamos seleccionar los vértices dos a dos e ir bajándolos manualmente hasta su 

colocación definitiva, sabiendo la coordenada Z de cada uno de los 3 puntos de quiebro. Sabemos que los dos 

vértices de la izquierda hay que bajarlos a 4,00 m. Los del centro a 3,409 m., y los de la derecha a 

ahora mismo están los 3 grupos a 8,00 m, calculamos las diferencias y los bajamos. Pero si ampliamos al máximo 

esas zonas vemos que no es una operación exacta, ya que por el redondeo o bien nos quedamos cortos o bien nos 

metemos dentro del edificio. Os propongo un método exacto, que es hacerlo con una operación booleana. Lo que 

quiero decir con esto es que se creará un objeto nuevo fruto de una operación entre otros dos (unión, diferencia o

intersección). En éste caso, y actualmente no nos valdría ninguno, ya que si al edificio le restamos la cubierta, lo que 

vamos a obtener es un nuevo edificio con un hueco en medio, además de que la cubierta desparecería. Pero, ¿y si 

ueva, copia de la anterior, le subimos las dos caras superiores hasta que sobrepasen la altura 

, y los restamos?. Pensadlo bien, porque esa es la solución correcta.  

Primero colocamos los vértices donde estaban, haciendo Undo tres veces. Primero copiaremos la cubierta, pero la 

copia quedará en el mismo sitio. Para ello, en la ventana Perspective, la seleccionamos, y con la herramienta “Select 

and Move” activada, hacemos Shift+Click en cualquier punto de la cubierta, pero sin desplazar el ratón. 

el cuadro “Clone Options”, marcamos “Copy”, y dejamos el nombre que nos sugiere, que es “cubiertabaja01”. 

Damos a OK. Aparentemente no vemos nada cambiado, pero realmente la copia está ahí pisando el objeto original. 

as caras superiores de ese objeto copia, hasta que estén en rojos. Para seleccionar las 

caras, tenemos que elegir “polygons” en el menú de selección de subelementos. Ahora las desplazamos hacia arriba 

lo que nos de la gana, pero que sobrepase el bloque del edificio.  

 

iorarnos que la cubierta está a su altura correspondiente. Si miramos el alzado, vemos que el 

encuentro del vuelo del lado aire con el edificio tiene que estar a 4,00 metros del suelo. Para ver cuanto tenemos 

el icono para ponerlas en absolutas (Absolut Mode Transform), y 

nos vamos a la ventana Front. Vamos ampliando al máximo el zoom hasta que veamos la coordenada Z que tiene ese 

Cambiamos las coordenadas a 

relativas, seleccionamos la cubierta, y lo bajamos esa cantidad. Nos aseguramos que ahora está a 4,00 m. 

Yo se que estáis deseando de eliminar ese trozo de edificio que sobresale de la cubierta, y vamos a hacerlo ahora. 

Podríamos seleccionar los vértices dos a dos e ir bajándolos manualmente hasta su 

colocación definitiva, sabiendo la coordenada Z de cada uno de los 3 puntos de quiebro. Sabemos que los dos 

0 m. Los del centro a 3,409 m., y los de la derecha a 4,341 m. Como 

ahora mismo están los 3 grupos a 8,00 m, calculamos las diferencias y los bajamos. Pero si ampliamos al máximo 

n nos quedamos cortos o bien nos 

metemos dentro del edificio. Os propongo un método exacto, que es hacerlo con una operación booleana. Lo que 

quiero decir con esto es que se creará un objeto nuevo fruto de una operación entre otros dos (unión, diferencia o 

intersección). En éste caso, y actualmente no nos valdría ninguno, ya que si al edificio le restamos la cubierta, lo que 

vamos a obtener es un nuevo edificio con un hueco en medio, además de que la cubierta desparecería. Pero, ¿y si 

ueva, copia de la anterior, le subimos las dos caras superiores hasta que sobrepasen la altura 

o copiaremos la cubierta, pero la 

copia quedará en el mismo sitio. Para ello, en la ventana Perspective, la seleccionamos, y con la herramienta “Select 

and Move” activada, hacemos Shift+Click en cualquier punto de la cubierta, pero sin desplazar el ratón. Nos aparece 

el cuadro “Clone Options”, marcamos “Copy”, y dejamos el nombre que nos sugiere, que es “cubiertabaja01”. 

Damos a OK. Aparentemente no vemos nada cambiado, pero realmente la copia está ahí pisando el objeto original. 

as caras superiores de ese objeto copia, hasta que estén en rojos. Para seleccionar las 

caras, tenemos que elegir “polygons” en el menú de selección de subelementos. Ahora las desplazamos hacia arriba 



 

Antes de nada seleccionamos el objeto “plantabaja”, que es el primario al que le vamos a hacer la operación 

(Operand A). Ahora crearemos el objeto booleano. Como tal, es un objeto nuevo, por lo tanto vamos al panel de 

comando Creation->Geometry, y en lugar de una “Standard Primitive”, en la persiana elegimos “Compound Objects”. 

Un poco más abajo, en “Object Type”, marcamos “Boolean”

marcamos “Pick Operand B”, y seleccionamos la cubierta sobree

operación “Substraction (A-B)”. Ya vemos el resultado. Pero aún no está todo hecho. Si vamos al 

“Modify”, vemos en el recuadro de la lista de modificadores que aparece “Boolean”. Para hacerlo defin

hacemos click derecho sobre ésta palabra y le damos a “Converto to editable poly”. Listo.

Ahora vamos a darle un “bocado” al vuelo del lado aire. Si os fijáis en las fotos, la parte central de éste vuelo no 

existe, desaparece. Ese bocado empieza l

y se extiende durante 18,67 metros, justo lo que tiene de largo la planta primera. Para ello haremos también una 

Antes de nada seleccionamos el objeto “plantabaja”, que es el primario al que le vamos a hacer la operación 

Ahora crearemos el objeto booleano. Como tal, es un objeto nuevo, por lo tanto vamos al panel de 

try, y en lugar de una “Standard Primitive”, en la persiana elegimos “Compound Objects”. 

Un poco más abajo, en “Object Type”, marcamos “Boolean”. En las persianas, en el apartado “Pick Boolean”, 

marcamos “Pick Operand B”, y seleccionamos la cubierta sobreelevada. Aseguramos que tenemos marcado la 

B)”. Ya vemos el resultado. Pero aún no está todo hecho. Si vamos al 

“Modify”, vemos en el recuadro de la lista de modificadores que aparece “Boolean”. Para hacerlo defin

hacemos click derecho sobre ésta palabra y le damos a “Converto to editable poly”. Listo.

Ahora vamos a darle un “bocado” al vuelo del lado aire. Si os fijáis en las fotos, la parte central de éste vuelo no 

existe, desaparece. Ese bocado empieza longitudinalmente a 15,17 metros del extremo sur del vuelo de la cubierta, 

y se extiende durante 18,67 metros, justo lo que tiene de largo la planta primera. Para ello haremos también una 

 

Antes de nada seleccionamos el objeto “plantabaja”, que es el primario al que le vamos a hacer la operación 

Ahora crearemos el objeto booleano. Como tal, es un objeto nuevo, por lo tanto vamos al panel de 

try, y en lugar de una “Standard Primitive”, en la persiana elegimos “Compound Objects”. 

. En las persianas, en el apartado “Pick Boolean”, 

levada. Aseguramos que tenemos marcado la 

B)”. Ya vemos el resultado. Pero aún no está todo hecho. Si vamos al panel de comando 

“Modify”, vemos en el recuadro de la lista de modificadores que aparece “Boolean”. Para hacerlo definitivo, 

hacemos click derecho sobre ésta palabra y le damos a “Converto to editable poly”. Listo. 

 

Ahora vamos a darle un “bocado” al vuelo del lado aire. Si os fijáis en las fotos, la parte central de éste vuelo no 

ongitudinalmente a 15,17 metros del extremo sur del vuelo de la cubierta, 

y se extiende durante 18,67 metros, justo lo que tiene de largo la planta primera. Para ello haremos también una 



operación booleana, crearemos un bloque ficticio que será el bocado, 

restaremos. Vamos a crear el bloque “fantasma”. Creamos un “Box”, en 0,0,0 de coordenadas, de dimensiones 18,67 

de longitud, de anchura la que queramos, por ejemplo 10,00 metros y de altura la que queramos siempre que 

sobrepase la de la cubierta, por ejemplo 15,00 metros. En los segmentos, todos a 1. Vemos que no está colocado en 

su sitio. Nos vamos a la vista Front, y vemos que la coordenada X de la pared izquierda del bloque es 

pared izquierda debe alinearse con la pared derecha del edificio, y su coordenada X es 8,20 m. Por lo tanto debemos 

desplazarlo a la izquierda 13,20 metros. Ahora nos vamos a la vista Top, y vemos que la coordenada Y de la parte 

superior de la cubierta es 26,80 m. La Y de la parte sup

cuando debería ser de 15,17 m. Por lo tanto debemos subirlo hacia arriba 2,295 m. Comprobamos las coordenadas.

Hacemos el booleano como antes y lo tendremos.

Ahora vamos a crear las vigas que hay bajo la cubierta. Para ello realizamos una copia del objeto “cubiertabaja”. En 

el cuadro “Clone options”, lo llamamos “viga”, y a continuación lo desplazamos en la ventana Front 

Y, para que nos quede justo debajo de la cubierta. Es bueno

tiene 0,20 m. de grosor, y nosotros necesitamos que sea 0,15, que es el grosor de la viga en los extremos. Por lo 

tanto seleccionamos los dos polígonos inferiores, y los desplazamos 0,05 m. en el eje 

operación booleana, crearemos un bloque ficticio que será el bocado, seleccionaremos la cubierta y se lo 

restaremos. Vamos a crear el bloque “fantasma”. Creamos un “Box”, en 0,0,0 de coordenadas, de dimensiones 18,67 

de longitud, de anchura la que queramos, por ejemplo 10,00 metros y de altura la que queramos siempre que 

brepase la de la cubierta, por ejemplo 15,00 metros. En los segmentos, todos a 1. Vemos que no está colocado en 

y vemos que la coordenada X de la pared izquierda del bloque es 

e con la pared derecha del edificio, y su coordenada X es 8,20 m. Por lo tanto debemos 

desplazarlo a la izquierda 13,20 metros. Ahora nos vamos a la vista Top, y vemos que la coordenada Y de la parte 

superior de la cubierta es 26,80 m. La Y de la parte superior del bloque es 9,335. Hay un desfase de 17,465 m., 

cuando debería ser de 15,17 m. Por lo tanto debemos subirlo hacia arriba 2,295 m. Comprobamos las coordenadas.

Hacemos el booleano como antes y lo tendremos. 

bajo la cubierta. Para ello realizamos una copia del objeto “cubiertabaja”. En 

el cuadro “Clone options”, lo llamamos “viga”, y a continuación lo desplazamos en la ventana Front 

Y, para que nos quede justo debajo de la cubierta. Es bueno cambiarle el color también. Esa copia que hemos creado 

tiene 0,20 m. de grosor, y nosotros necesitamos que sea 0,15, que es el grosor de la viga en los extremos. Por lo 

tanto seleccionamos los dos polígonos inferiores, y los desplazamos 0,05 m. en el eje Y, en la vista Front.

seleccionaremos la cubierta y se lo 

restaremos. Vamos a crear el bloque “fantasma”. Creamos un “Box”, en 0,0,0 de coordenadas, de dimensiones 18,67 

de longitud, de anchura la que queramos, por ejemplo 10,00 metros y de altura la que queramos siempre que 

brepase la de la cubierta, por ejemplo 15,00 metros. En los segmentos, todos a 1. Vemos que no está colocado en 

y vemos que la coordenada X de la pared izquierda del bloque es -5,00 m. Esa 

e con la pared derecha del edificio, y su coordenada X es 8,20 m. Por lo tanto debemos 

desplazarlo a la izquierda 13,20 metros. Ahora nos vamos a la vista Top, y vemos que la coordenada Y de la parte 

erior del bloque es 9,335. Hay un desfase de 17,465 m., 

cuando debería ser de 15,17 m. Por lo tanto debemos subirlo hacia arriba 2,295 m. Comprobamos las coordenadas. 

 

 

bajo la cubierta. Para ello realizamos una copia del objeto “cubiertabaja”. En 

el cuadro “Clone options”, lo llamamos “viga”, y a continuación lo desplazamos en la ventana Front -0,20 m. en el eje 

cambiarle el color también. Esa copia que hemos creado 

tiene 0,20 m. de grosor, y nosotros necesitamos que sea 0,15, que es el grosor de la viga en los extremos. Por lo 

Y, en la vista Front. 



A continuación tenemos que cortar la viga longitudinalmente, ya que ahora mismo ocupa la misma extensión que 

toda la cubierta. Nosotros necesitamos que la viga tenga un ancho de 0,30 m. Para cortarla, seleccionamos el objeto 

“viga”, y dentro de ella el subelemento “Elements” que nos coge todo el objeto, hasta que se vea rojo. En la persiana 

“Edit Geometry” encontramos un cuadro con las opciones “Slice Plane”, y “

determinar la posición del plano de corte, y cuando lo teng

recuadro “Split”, para que divida el objeto, a continuación “Slice Plane”, y nos aparecerá un cuadrado amarillo, que 

es el plano de corte. Como vemos, ahora aparece en posición

con respecto al eje X 90°, en la vista Perspective

a “Select and Move”, e introducimos en la coordenada X relativa 90.0, en la ventan

plano ha girado, pero está desplazado, ya que está en el origen. Tenemos que desplazarlo 

ventana Perspective. Ahora está en su sitio.

Le damos a Slice, con la opción Split marcada. Nos ha dividido 

el sobrante y lo eliminamos. Al eliminar, nos aparecerá una pregunta de si queremos eliminar también los vértices 

aislados que quedan, y le damos a “Sí”. 

Ahora vemos que las cabezas de las vigas llega

m. hacia el interior del vuelo. Así que siguiendo el procedimiento anterior, cortamos esas dos cabezas sobrantes. 

Para ello seleccionamos el elemento “viga”, damos a Reset Slice Plane, l

A continuación tenemos que cortar la viga longitudinalmente, ya que ahora mismo ocupa la misma extensión que 

toda la cubierta. Nosotros necesitamos que la viga tenga un ancho de 0,30 m. Para cortarla, seleccionamos el objeto 

dentro de ella el subelemento “Elements” que nos coge todo el objeto, hasta que se vea rojo. En la persiana 

“Edit Geometry” encontramos un cuadro con las opciones “Slice Plane”, y “Slice”. El Slice Plane lo que hace es 

corte, y cuando lo tengamos en su sitio, le damos a Slice

recuadro “Split”, para que divida el objeto, a continuación “Slice Plane”, y nos aparecerá un cuadrado amarillo, que 

es el plano de corte. Como vemos, ahora aparece en posición horizontal, así que no nos vale. Tenemos que rotarlo 

Perspective. Para rotarlo, seleccionamos la herramienta “Rotate”, que está junto 

a “Select and Move”, e introducimos en la coordenada X relativa 90.0, en la ventana Perspective. Vemos como el 

plano ha girado, pero está desplazado, ya que está en el origen. Tenemos que desplazarlo 

Ahora está en su sitio. 

Le damos a Slice, con la opción Split marcada. Nos ha dividido al elemento original en dos, con lo que seleccionamos 

el sobrante y lo eliminamos. Al eliminar, nos aparecerá una pregunta de si queremos eliminar también los vértices 

 

Ahora vemos que las cabezas de las vigas llegan al extremo de los vuelos, y eso no es así. Están retranqueadas 0,20 

m. hacia el interior del vuelo. Así que siguiendo el procedimiento anterior, cortamos esas dos cabezas sobrantes. 

Para ello seleccionamos el elemento “viga”, damos a Reset Slice Plane, lo rotamos 90° en el eje X, y 90° en el eje Z, y 

A continuación tenemos que cortar la viga longitudinalmente, ya que ahora mismo ocupa la misma extensión que 

toda la cubierta. Nosotros necesitamos que la viga tenga un ancho de 0,30 m. Para cortarla, seleccionamos el objeto 

dentro de ella el subelemento “Elements” que nos coge todo el objeto, hasta que se vea rojo. En la persiana 

”. El Slice Plane lo que hace es 

amos en su sitio, le damos a Slice. Primero pinchamos el 

recuadro “Split”, para que divida el objeto, a continuación “Slice Plane”, y nos aparecerá un cuadrado amarillo, que 

horizontal, así que no nos vale. Tenemos que rotarlo 

. Para rotarlo, seleccionamos la herramienta “Rotate”, que está junto 

a Perspective. Vemos como el 

plano ha girado, pero está desplazado, ya que está en el origen. Tenemos que desplazarlo -26,50 m. en el eje Y de la 

 

al elemento original en dos, con lo que seleccionamos 

el sobrante y lo eliminamos. Al eliminar, nos aparecerá una pregunta de si queremos eliminar también los vértices 

 

n al extremo de los vuelos, y eso no es así. Están retranqueadas 0,20 

m. hacia el interior del vuelo. Así que siguiendo el procedimiento anterior, cortamos esas dos cabezas sobrantes. 

o rotamos 90° en el eje X, y 90° en el eje Z, y 



lo desplazamos -8.60 m. en la coordenada X. Le damos a Slice, y volvemos a desplazarlo 17.20 m. en el eje Y. Slice de 

nuevo, y eliminamos las cabezas sobrantes y los vértices aislados.

Pero con éstas operaciones tenemos un pequeño problema, y es que al cortar, nos elimina las caras de cierre del 

elemento. Para verlo más claro vamos a ocultar el resto de objetos, excepto “viga”. Para ello, la seleccionamos, y en 

la ventana “Perspective”, hacemos click d

Ahí vemos el problema. Lo que vamos a hacer es eliminar todos los subelementos que sobran, hasta quedarnos solo 

con las dos caras laterales de la viga. Marcamos la selección “Polygons”,

aislados, y nos quedamos con esto nada más:

Ahora lo que tenemos es una forma plana.

es así. La sección va aumentando hasta su parte central. La referencia qu

edificio, la sección tiene unos 30 cms. Para modificarla, lo primero es activar todos los ojetos. Marcamos click 

derecho en la ventana Perspective, y marcamos “Unhide All”. Si miramos las coordenadas, actualmente la 

ese punto es de 15 cms. Vamos a crear una herramienta de ayuda, para que nos sirva de referencia en ese punto. 

Vamos al panel de comando “Create”, y en el submenú “Helpers”, escogemos “Tape”. En la vista “Front” trazamos 

una línea con la cinta métrica a la altura 15 cms. más baja que la que tenemos actualmente en el encuentro viga

edificio. A continuación, seleccionamos “Vertex”, escogemos los dos centrales, y vamos tirando hacia abajo, 

8.60 m. en la coordenada X. Le damos a Slice, y volvemos a desplazarlo 17.20 m. en el eje Y. Slice de 

nuevo, y eliminamos las cabezas sobrantes y los vértices aislados. 

operaciones tenemos un pequeño problema, y es que al cortar, nos elimina las caras de cierre del 

elemento. Para verlo más claro vamos a ocultar el resto de objetos, excepto “viga”. Para ello, la seleccionamos, y en 

la ventana “Perspective”, hacemos click derecho, y en el menú marcamos “Hide Unselected”.

Ahí vemos el problema. Lo que vamos a hacer es eliminar todos los subelementos que sobran, hasta quedarnos solo 

con las dos caras laterales de la viga. Marcamos la selección “Polygons”, borramos las caras 

y nos quedamos con esto nada más: 

Ahora lo que tenemos es una forma plana. Vemos que nuestra viga tiene una sección constante, pero realmente no 

es así. La sección va aumentando hasta su parte central. La referencia que tenemos es que en el encuentro con el 

edificio, la sección tiene unos 30 cms. Para modificarla, lo primero es activar todos los ojetos. Marcamos click 

derecho en la ventana Perspective, y marcamos “Unhide All”. Si miramos las coordenadas, actualmente la 

Vamos a crear una herramienta de ayuda, para que nos sirva de referencia en ese punto. 

Vamos al panel de comando “Create”, y en el submenú “Helpers”, escogemos “Tape”. En la vista “Front” trazamos 

étrica a la altura 15 cms. más baja que la que tenemos actualmente en el encuentro viga

edificio. A continuación, seleccionamos “Vertex”, escogemos los dos centrales, y vamos tirando hacia abajo, 

8.60 m. en la coordenada X. Le damos a Slice, y volvemos a desplazarlo 17.20 m. en el eje Y. Slice de 

operaciones tenemos un pequeño problema, y es que al cortar, nos elimina las caras de cierre del 

elemento. Para verlo más claro vamos a ocultar el resto de objetos, excepto “viga”. Para ello, la seleccionamos, y en 

erecho, y en el menú marcamos “Hide Unselected”. 

 

Ahí vemos el problema. Lo que vamos a hacer es eliminar todos los subelementos que sobran, hasta quedarnos solo 

borramos las caras superiores y los vértices 

 

Vemos que nuestra viga tiene una sección constante, pero realmente no 

e tenemos es que en el encuentro con el 

edificio, la sección tiene unos 30 cms. Para modificarla, lo primero es activar todos los ojetos. Marcamos click 

derecho en la ventana Perspective, y marcamos “Unhide All”. Si miramos las coordenadas, actualmente la sección en 

Vamos a crear una herramienta de ayuda, para que nos sirva de referencia en ese punto. 

Vamos al panel de comando “Create”, y en el submenú “Helpers”, escogemos “Tape”. En la vista “Front” trazamos 

étrica a la altura 15 cms. más baja que la que tenemos actualmente en el encuentro viga-

edificio. A continuación, seleccionamos “Vertex”, escogemos los dos centrales, y vamos tirando hacia abajo, 



manteniendo el cursor sobre la barra del eje Y de la cruceta

Nos quedará algo así: 

Borramos la herramienta cinta métrica. Ahora vamos a cortar la parte central de la viga, que no nos sirve. 

Seleccionamos el elemento, creamos el Slice Plane, lo giramos y po

Pero recordad que lo que tenemos es una forma plana. Tenemos que darle el grosor de 30 cms, que perdimos al 

cortar la figura. Tenemos que hacerlo en varios pasos, debido también a la peculiar forma de extrui

Primero seleccionamos los dos elementos que forman la viga. En la persiana “Edit Geometry”, tenemos un cuadro 

que marca “Extrude”, y una casilla “Extrusion”. En ésta casilla ponemos 0.30, y pulsamos Extrude. Nos ha extruido la 

figura, pero no la cierra por la cara posterior. Para cerrarla, lo que hacemos es seleccionar las dos caras anteriores, y 

las copiamos. Marcamos la opción “Clone to element”, y lo desplazamos 0.30 en el eje Y de la ventana Perspective. 

Aunque sigamos sin ver la cara, está ahí, lo que pasa es que está invertida, o sea que la cara mira hacia el interior de 

la viga. Para cambiarlo, seleccionamos los dos elementos nuevos (las caras que hemos copiado ahora son elementos 

independientes), y en las persianas, dentro de “Surfa

caras interiores. 

manteniendo el cursor sobre la barra del eje Y de la cruceta, hasta que la arista de la viga corte a la cinta métrica. 

Borramos la herramienta cinta métrica. Ahora vamos a cortar la parte central de la viga, que no nos sirve. 

Seleccionamos el elemento, creamos el Slice Plane, lo giramos y posicionamos en ambos extremos, y damos a Slice.

Pero recordad que lo que tenemos es una forma plana. Tenemos que darle el grosor de 30 cms, que perdimos al 

Tenemos que hacerlo en varios pasos, debido también a la peculiar forma de extrui

Primero seleccionamos los dos elementos que forman la viga. En la persiana “Edit Geometry”, tenemos un cuadro 

que marca “Extrude”, y una casilla “Extrusion”. En ésta casilla ponemos 0.30, y pulsamos Extrude. Nos ha extruido la 

o no la cierra por la cara posterior. Para cerrarla, lo que hacemos es seleccionar las dos caras anteriores, y 

las copiamos. Marcamos la opción “Clone to element”, y lo desplazamos 0.30 en el eje Y de la ventana Perspective. 

está ahí, lo que pasa es que está invertida, o sea que la cara mira hacia el interior de 

la viga. Para cambiarlo, seleccionamos los dos elementos nuevos (las caras que hemos copiado ahora son elementos 

independientes), y en las persianas, dentro de “Surface Properties”, pulsamos “Flip Normals”. Ya por fin vemos las 

, hasta que la arista de la viga corte a la cinta métrica. 

 

Borramos la herramienta cinta métrica. Ahora vamos a cortar la parte central de la viga, que no nos sirve. 

sicionamos en ambos extremos, y damos a Slice. 

 

Pero recordad que lo que tenemos es una forma plana. Tenemos que darle el grosor de 30 cms, que perdimos al 

Tenemos que hacerlo en varios pasos, debido también a la peculiar forma de extruir que tiene GMax. 

Primero seleccionamos los dos elementos que forman la viga. En la persiana “Edit Geometry”, tenemos un cuadro 

que marca “Extrude”, y una casilla “Extrusion”. En ésta casilla ponemos 0.30, y pulsamos Extrude. Nos ha extruido la 

o no la cierra por la cara posterior. Para cerrarla, lo que hacemos es seleccionar las dos caras anteriores, y 

las copiamos. Marcamos la opción “Clone to element”, y lo desplazamos 0.30 en el eje Y de la ventana Perspective. 

está ahí, lo que pasa es que está invertida, o sea que la cara mira hacia el interior de 

la viga. Para cambiarlo, seleccionamos los dos elementos nuevos (las caras que hemos copiado ahora son elementos 

ce Properties”, pulsamos “Flip Normals”. Ya por fin vemos las 



Ahora, esas caras interiores son elementos independientes aún. Si queremos agruparlos con el resto del objeto, 

seleccionamos todos los vértices de cada viga, y en la persiana

“Weld Selected”, con lo que los vértices quedan soldados, y los elementos independientes se unen.

Para colocar las vigas en su sitio, las seleccionamos y las desplazamos en la ventana Top, 1,40 m. en el eje

Para copiar esa viga a lo largo de todo el vuelo, nos interesa tener separados las dos partes, la viga lado aire y la viga 

lado tierra. Para ello, seleccionamos una de las partes, la que queramos, y en la persiana “Edit Geometry”, pulsamos 

“Detach”. Nos pedirá de qué forma queremos separarla, elegimos “As Object”, y le ponemos el nombre 

“vigaladoaire” o “vigaladotierra”, según la que hayamos elegido.

Primero vamos a centrarnos en el lado tierra. Como vemos en nuestro croquis, la distancia entre ejes d

4,59 m., pero ojo, porque no podemos copiarlas a todo el largo. Si os fijáis, hay dos vigas dobles que interrumpen la 

secuencia. Veamos como lo vamos a hacer. Si empezamos a copiar desde la fachada norte, vemos que tenemos 5 

vigas, así que realizamos esas 5 copias como ya sabemos, y las vamos desplazando a 4,59 m., hasta llegar a la 5ª. 

Ahora empezamos por la fachada sur. Copiamos una viga al extremo de la fachada, y hacemos copias hasta llegar a la 

6ª. Medimos el hueco que queda entre las dos

centro de ese hueco, tenemos que copiar la última de un lado 4,895 m. en el eje Y de la vista Top. Así se nos queda 

centrada. Ahora copiamos esa viga central a ambos lados a la distancia de 4

Repetimos el proceso para las vigas del lado aire.

Ahora, esas caras interiores son elementos independientes aún. Si queremos agruparlos con el resto del objeto, 

seleccionamos todos los vértices de cada viga, y en la persiana “Edit Geometry”, en el apartado “Weld”, marcamos 

“Weld Selected”, con lo que los vértices quedan soldados, y los elementos independientes se unen.

Para colocar las vigas en su sitio, las seleccionamos y las desplazamos en la ventana Top, 1,40 m. en el eje

Para copiar esa viga a lo largo de todo el vuelo, nos interesa tener separados las dos partes, la viga lado aire y la viga 

lado tierra. Para ello, seleccionamos una de las partes, la que queramos, y en la persiana “Edit Geometry”, pulsamos 

Nos pedirá de qué forma queremos separarla, elegimos “As Object”, y le ponemos el nombre 

“vigaladoaire” o “vigaladotierra”, según la que hayamos elegido. 

Primero vamos a centrarnos en el lado tierra. Como vemos en nuestro croquis, la distancia entre ejes d

, pero ojo, porque no podemos copiarlas a todo el largo. Si os fijáis, hay dos vigas dobles que interrumpen la 

secuencia. Veamos como lo vamos a hacer. Si empezamos a copiar desde la fachada norte, vemos que tenemos 5 

alizamos esas 5 copias como ya sabemos, y las vamos desplazando a 4,59 m., hasta llegar a la 5ª. 

Ahora empezamos por la fachada sur. Copiamos una viga al extremo de la fachada, y hacemos copias hasta llegar a la 

6ª. Medimos el hueco que queda entre las dos vigas de cada lado. A mí me sale 9,79 m. Como una viga va en el 

centro de ese hueco, tenemos que copiar la última de un lado 4,895 m. en el eje Y de la vista Top. Así se nos queda 

centrada. Ahora copiamos esa viga central a ambos lados a la distancia de 4,59. Ya tenemos las vigas dobles.

Repetimos el proceso para las vigas del lado aire. 

 

Ahora, esas caras interiores son elementos independientes aún. Si queremos agruparlos con el resto del objeto, 

“Edit Geometry”, en el apartado “Weld”, marcamos 

“Weld Selected”, con lo que los vértices quedan soldados, y los elementos independientes se unen. 

Para colocar las vigas en su sitio, las seleccionamos y las desplazamos en la ventana Top, 1,40 m. en el eje Y. 

 

Para copiar esa viga a lo largo de todo el vuelo, nos interesa tener separados las dos partes, la viga lado aire y la viga 

lado tierra. Para ello, seleccionamos una de las partes, la que queramos, y en la persiana “Edit Geometry”, pulsamos 

Nos pedirá de qué forma queremos separarla, elegimos “As Object”, y le ponemos el nombre 

Primero vamos a centrarnos en el lado tierra. Como vemos en nuestro croquis, la distancia entre ejes de vigas es de 

, pero ojo, porque no podemos copiarlas a todo el largo. Si os fijáis, hay dos vigas dobles que interrumpen la 

secuencia. Veamos como lo vamos a hacer. Si empezamos a copiar desde la fachada norte, vemos que tenemos 5 

alizamos esas 5 copias como ya sabemos, y las vamos desplazando a 4,59 m., hasta llegar a la 5ª. 

Ahora empezamos por la fachada sur. Copiamos una viga al extremo de la fachada, y hacemos copias hasta llegar a la 

. A mí me sale 9,79 m. Como una viga va en el 

centro de ese hueco, tenemos que copiar la última de un lado 4,895 m. en el eje Y de la vista Top. Así se nos queda 

,59. Ya tenemos las vigas dobles. 



A continuación crearemos la segunda planta. Dibujaremos un bloque de dimensiones 

coordenadas 0,0,0., y de 1 solo segmento en cada dimensió

vista Top 4,10 m. en la X y 2,295 en la Y. Vamos a crear una copia, para darle un nuevo bocado a la cubierta, y 

restarle a ésta la parte que ocupa el edificio.

La planta baja y la 1ª se solapan, porque hemos creado ésta última desde la cota 0. Seleccionamos los vértices 

inferiores y los colocamos justo donde acaban los de la planta baja. Podemos ayudarnos de los “Snaps”, para 

moverlos de una forma más precisa. Cuando acabemos, ocultar todos los objetos menos la planta 1, debe de quedar 

algo así: 

A continuación crearemos la segunda planta. Dibujaremos un bloque de dimensiones 18,67x8,20x6,89 metros, en las 

coordenadas 0,0,0., y de 1 solo segmento en cada dimensión. Ahora lo colocamos en su sitio, desplazándolo en la 

vista Top 4,10 m. en la X y 2,295 en la Y. Vamos a crear una copia, para darle un nuevo bocado a la cubierta, y 

restarle a ésta la parte que ocupa el edificio. Haciendo una operación booleana de sustra

La planta baja y la 1ª se solapan, porque hemos creado ésta última desde la cota 0. Seleccionamos los vértices 

inferiores y los colocamos justo donde acaban los de la planta baja. Podemos ayudarnos de los “Snaps”, para 

a forma más precisa. Cuando acabemos, ocultar todos los objetos menos la planta 1, debe de quedar 

 

18,67x8,20x6,89 metros, en las 

n. Ahora lo colocamos en su sitio, desplazándolo en la 

vista Top 4,10 m. en la X y 2,295 en la Y. Vamos a crear una copia, para darle un nuevo bocado a la cubierta, y 

Haciendo una operación booleana de sustracción, lo obtenemos. 

 

La planta baja y la 1ª se solapan, porque hemos creado ésta última desde la cota 0. Seleccionamos los vértices 

inferiores y los colocamos justo donde acaban los de la planta baja. Podemos ayudarnos de los “Snaps”, para 

a forma más precisa. Cuando acabemos, ocultar todos los objetos menos la planta 1, debe de quedar 



Y así si ocultamos solo la cubierta: 

Para crear la cubierta de la segunda planta, solo tenemos que crear un bloque de dimensiones 19,97x9,50x0,3

metros, y lo desplazamos a su sitio. Recordad siempre que hagáis un elemento nuevo convertirlo a Editable Poly y 

cambiarle el nombre. 

Para crear la cubierta de la segunda planta, solo tenemos que crear un bloque de dimensiones 19,97x9,50x0,3

metros, y lo desplazamos a su sitio. Recordad siempre que hagáis un elemento nuevo convertirlo a Editable Poly y 

 

 

Para crear la cubierta de la segunda planta, solo tenemos que crear un bloque de dimensiones 19,97x9,50x0,30 

metros, y lo desplazamos a su sitio. Recordad siempre que hagáis un elemento nuevo convertirlo a Editable Poly y 



Para la segunda planta creamos un bloque de 10,35x8,20x2,70 metros, pero lo hacemos con 3 segmentos en el largo, 

para después poder desplazar las caras y adaptarlas a su posición.

1.865 en el eje Y y 7.19 en el eje Z. 

Una vez en su sitio, seleccionamos las 3 caras que dan al aldo aire, y las desplazamos en el eje X 

queden alineadas con la parte más estrecha.

Ahora seleccionamos la cara que aparece más a la izquierda en la imagen de arriba, en la persiana Edit Geometry, 

anotamos en la casilla Extrusión el valor 6.90 m, y pulsamos Extrude. En la cara más 

con un valor de 2.40 m. 

Para la segunda planta creamos un bloque de 10,35x8,20x2,70 metros, pero lo hacemos con 3 segmentos en el largo, 

después poder desplazar las caras y adaptarlas a su posición. Tendremos que desplazarlo 4,10 m. en el eje X, 

Una vez en su sitio, seleccionamos las 3 caras que dan al aldo aire, y las desplazamos en el eje X 

queden alineadas con la parte más estrecha. 

Ahora seleccionamos la cara que aparece más a la izquierda en la imagen de arriba, en la persiana Edit Geometry, 

anotamos en la casilla Extrusión el valor 6.90 m, y pulsamos Extrude. En la cara más a la derecha hacemos lo mismo 

 

Para la segunda planta creamos un bloque de 10,35x8,20x2,70 metros, pero lo hacemos con 3 segmentos en el largo, 

Tendremos que desplazarlo 4,10 m. en el eje X, -

Una vez en su sitio, seleccionamos las 3 caras que dan al aldo aire, y las desplazamos en el eje X -6,90 m. para que se 

 

Ahora seleccionamos la cara que aparece más a la izquierda en la imagen de arriba, en la persiana Edit Geometry, 

a la derecha hacemos lo mismo 



Si os fijáis en los planos veréis que el módulo de la izquierda de la imagen es un poco más alto que los de la derecha, 

0,30 m. concretamente. Así que seleccionamos las dos caras superiores que forman

esa distancia. Si queréis podéis eliminar las aristas que sobran, aunque no nos supondrá gran ventaja.

Sólo nos queda corregir los anchos de los módulos, que lo realizamos desplazando vértices. El módulo de la izquierda 

tiene 4,00 m., y el de la derecha 1,60 m. 

Para crear los techos lo haremos de forma independiente, ya que están a dos niveles. El del nivel superior es un 

bloque de 5,30x9,50x0,30, de 1 segmento.

metros, con dos segmentos en la longitud.

módulo derecho. 

Ahora toca el fanal de la antigua torre de control, que tiene 3 partes,

forma de tronco de pirámide invertida y la cubierta. Para la base creamos un bloque de dimensiones 4,00x4,00x1,20 

Si os fijáis en los planos veréis que el módulo de la izquierda de la imagen es un poco más alto que los de la derecha, 

0,30 m. concretamente. Así que seleccionamos las dos caras superiores que forman el techo y lo extruimos también 

Si queréis podéis eliminar las aristas que sobran, aunque no nos supondrá gran ventaja.

Sólo nos queda corregir los anchos de los módulos, que lo realizamos desplazando vértices. El módulo de la izquierda 

 

Para crear los techos lo haremos de forma independiente, ya que están a dos niveles. El del nivel superior es un 

5,30x9,50x0,30, de 1 segmento. Para el nivel inferior crearemos un bloque de dimensiones 6,65x1,90x0,30 

metros, con dos segmentos en la longitud. Desplazamos a su sitio, ajustamos las dimensiones y extruimos la cara del 

Ahora toca el fanal de la antigua torre de control, que tiene 3 partes, una base cúbica, la zona central de ventanas en 

forma de tronco de pirámide invertida y la cubierta. Para la base creamos un bloque de dimensiones 4,00x4,00x1,20 

 

Si os fijáis en los planos veréis que el módulo de la izquierda de la imagen es un poco más alto que los de la derecha, 

el techo y lo extruimos también 

Si queréis podéis eliminar las aristas que sobran, aunque no nos supondrá gran ventaja. 

Sólo nos queda corregir los anchos de los módulos, que lo realizamos desplazando vértices. El módulo de la izquierda 

Para crear los techos lo haremos de forma independiente, ya que están a dos niveles. El del nivel superior es un 

crearemos un bloque de dimensiones 6,65x1,90x0,30 

Desplazamos a su sitio, ajustamos las dimensiones y extruimos la cara del 

 

una base cúbica, la zona central de ventanas en 

forma de tronco de pirámide invertida y la cubierta. Para la base creamos un bloque de dimensiones 4,00x4,00x1,20 



m. y lo colocamos en su sitio. Para el fanal, copiamos la base del fanal, lo desplazamos vert

ensanchamiento de la parte superior, elegimos desplazar aristas o vértices a sus respectivas dimensiones.

Para la cubierta del fanal, copiamos la base del fanal, la desplazamos verticalmente hacia arriba y la ensanchamos.

Nos falta por crear el balcón de la planta 1ª, que está formado por dos bloques, en L.

m. y lo colocamos en su sitio. Para el fanal, copiamos la base del fanal, lo desplazamos vert

ensanchamiento de la parte superior, elegimos desplazar aristas o vértices a sus respectivas dimensiones.

Para la cubierta del fanal, copiamos la base del fanal, la desplazamos verticalmente hacia arriba y la ensanchamos.

de la planta 1ª, que está formado por dos bloques, en L. 

m. y lo colocamos en su sitio. Para el fanal, copiamos la base del fanal, lo desplazamos verticalmente y para crear el 

ensanchamiento de la parte superior, elegimos desplazar aristas o vértices a sus respectivas dimensiones. 

 

Para la cubierta del fanal, copiamos la base del fanal, la desplazamos verticalmente hacia arriba y la ensanchamos. 

 



A continuación crearemos el bordillo de la terminal. Lo primero será elegir en la vista Front todos los objetos y 

elevarlos 0,15 m. Después dibujamos un bloque de dimensio

longitud. Lo desplazamos -0,30 en el eje X y 

Vamos a posicionar los segmentos longitudinalmente. El primero empezando por 

m. de ancho. Seleccionamos vértices en la vista Top y los movemos. 

el cuarto 6,80 m. lo que hace el total de 57,60 m. Las caras frontales del 1º y 3º segmento se extruyen hacia el 

interior 2,20 m. 

Para redondear la arista del bordillo que hay en la esquina suroeste, la seleccionamos, y en Edit Geometry, en 

Chamfer ponemos 1,00 m, y pulsamos Chamfer. Después ponemos 0,50 m. y volvemos a pulsar.

A continuación crearemos el bordillo de la terminal. Lo primero será elegir en la vista Front todos los objetos y 

elevarlos 0,15 m. Después dibujamos un bloque de dimensiones 57,60x21,00x0,15 m, con 4 segmentos en su 

0,30 en el eje X y -2,00 en el eje Y (En la vista Top). Lo convertimos en Editable Poly. 

Vamos a posicionar los segmentos longitudinalmente. El primero empezando por la fachada sur (ar

m. de ancho. Seleccionamos vértices en la vista Top y los movemos. El segundo tiene 36,4

el cuarto 6,80 m. lo que hace el total de 57,60 m. Las caras frontales del 1º y 3º segmento se extruyen hacia el 

Para redondear la arista del bordillo que hay en la esquina suroeste, la seleccionamos, y en Edit Geometry, en 

Chamfer ponemos 1,00 m, y pulsamos Chamfer. Después ponemos 0,50 m. y volvemos a pulsar.

 

A continuación crearemos el bordillo de la terminal. Lo primero será elegir en la vista Front todos los objetos y 

nes 57,60x21,00x0,15 m, con 4 segmentos en su 

2,00 en el eje Y (En la vista Top). Lo convertimos en Editable Poly. 

la fachada sur (arriba), tiene 1,70 

El segundo tiene 36,40 m., el tercero 12,70 m. y 

el cuarto 6,80 m. lo que hace el total de 57,60 m. Las caras frontales del 1º y 3º segmento se extruyen hacia el 

 

Para redondear la arista del bordillo que hay en la esquina suroeste, la seleccionamos, y en Edit Geometry, en 

Chamfer ponemos 1,00 m, y pulsamos Chamfer. Después ponemos 0,50 m. y volvemos a pulsar. 



También haremos las rampas de las aceras, en

arista superior y la unimos con la inferior. Es bueno que después seleccionemos los vértices y los soldemos con la 

opción “Weld”. 

También hacemos las jardineras, con bloques.

cierta libertad a la hora de crearlos. 

También haremos las rampas de las aceras, en concreto hay 3. Las hacemos con bloques, y después seleccionamos la 

arista superior y la unimos con la inferior. Es bueno que después seleccionemos los vértices y los soldemos con la 

También hacemos las jardineras, con bloques. Estos aspectos son más decorativos que otra cosa, y podemos tener 

 

concreto hay 3. Las hacemos con bloques, y después seleccionamos la 

arista superior y la unimos con la inferior. Es bueno que después seleccionemos los vértices y los soldemos con la 

 

ctos son más decorativos que otra cosa, y podemos tener 



Por último realizaremos las barandillas del edificio, y la escalera que conduce al fanal. Estos elementos serán 

transparentes en parte, y tendrán su correspond

objetos planos, de dos dimensiones. 

La primera barandilla que haremos será la que está en la cubierta del fanal. Como vemos tiene forma octogonal, con 

un díametro aproximado de 5,40 m., centrado

del centro. Si seleccionamos ese objeto, con la herramienta selección, en la ventana de coordenadas nos aparecen 

las del centro del objeto: X:6.20,Y:-5.04,Z:13.74. Nos vamos al panel de

“Shapes”. Pulsamos en “NGon”, y en la persiana “Keyboard Entry”, escribimos esas coordenadas, sólo que la altura 

será 14.04 m., para situarla sobre la cubierta. En “Parameters”, escribimos un radio de 2.70 m., y Sides=

que nos ha dibujado el octógono, pero está girado. Seleccionamos rotación, y le damos un valor Z=22.5°. 

el click derecho, la convertimos en SPline. La seleccionamos, y en la lista de modificadores, añadimos “Extrude” a la 

lista. Quitamos las marcas de las casillas “Cap Start” y “Cap End”, para evitar que nos realice las t

le damos 1,20 m. Lo tenemos. Ahora en la lista de modificadores, nos aparece “Extrude” con una bombillita al lado. 

Hacemos click derecho, y elegimos “Collapse All”, para mezclarlo con la SPline. En el cuadro de diálogo, le damos a 

que sí, y lo convertimos a Editable Poly. Vemos que nos ha creado las caras exteriores, pero no las interiores. Para 

hacerlas, seleccionamos como elemento, lo copiamos como el

Normals”. 

Por último realizaremos las barandillas del edificio, y la escalera que conduce al fanal. Estos elementos serán 

transparentes en parte, y tendrán su correspondiente canal alfa en la textura, pero además lo crearemos como 

La primera barandilla que haremos será la que está en la cubierta del fanal. Como vemos tiene forma octogonal, con 

un díametro aproximado de 5,40 m., centrado en la cubierta. Lo primero que nos interesa saber son las coordenadas 

jeto, con la herramienta selección, en la ventana de coordenadas nos aparecen 

5.04,Z:13.74. Nos vamos al panel de comandos “Creation”, y seleccionamos 

“Shapes”. Pulsamos en “NGon”, y en la persiana “Keyboard Entry”, escribimos esas coordenadas, sólo que la altura 

será 14.04 m., para situarla sobre la cubierta. En “Parameters”, escribimos un radio de 2.70 m., y Sides=

que nos ha dibujado el octógono, pero está girado. Seleccionamos rotación, y le damos un valor Z=22.5°. 

el click derecho, la convertimos en SPline. La seleccionamos, y en la lista de modificadores, añadimos “Extrude” a la 

las marcas de las casillas “Cap Start” y “Cap End”, para evitar que nos realice las t

0 m. Lo tenemos. Ahora en la lista de modificadores, nos aparece “Extrude” con una bombillita al lado. 

Collapse All”, para mezclarlo con la SPline. En el cuadro de diálogo, le damos a 

que sí, y lo convertimos a Editable Poly. Vemos que nos ha creado las caras exteriores, pero no las interiores. Para 

hacerlas, seleccionamos como elemento, lo copiamos como elemento también, y en las persianas buscamos “Flip 

 

Por último realizaremos las barandillas del edificio, y la escalera que conduce al fanal. Estos elementos serán 

iente canal alfa en la textura, pero además lo crearemos como 

La primera barandilla que haremos será la que está en la cubierta del fanal. Como vemos tiene forma octogonal, con 

en la cubierta. Lo primero que nos interesa saber son las coordenadas 

jeto, con la herramienta selección, en la ventana de coordenadas nos aparecen 

comandos “Creation”, y seleccionamos 

“Shapes”. Pulsamos en “NGon”, y en la persiana “Keyboard Entry”, escribimos esas coordenadas, sólo que la altura 

será 14.04 m., para situarla sobre la cubierta. En “Parameters”, escribimos un radio de 2.70 m., y Sides=8. Vemos 

que nos ha dibujado el octógono, pero está girado. Seleccionamos rotación, y le damos un valor Z=22.5°. Ahora con 

el click derecho, la convertimos en SPline. La seleccionamos, y en la lista de modificadores, añadimos “Extrude” a la 

las marcas de las casillas “Cap Start” y “Cap End”, para evitar que nos realice las tapas, y en cantidad 

0 m. Lo tenemos. Ahora en la lista de modificadores, nos aparece “Extrude” con una bombillita al lado. 

Collapse All”, para mezclarlo con la SPline. En el cuadro de diálogo, le damos a 

que sí, y lo convertimos a Editable Poly. Vemos que nos ha creado las caras exteriores, pero no las interiores. Para 

emento también, y en las persianas buscamos “Flip 



Repetimos éste proceso con todas las barandillas, pero en vez de usar la forma “NGon”, lo haremos con líneas. Por lo 

demás es igual. 

 Añadimos el toldo que hay bajo el balcón, y la escalera 

dividiéndolo en dos segmentos transversales y moviendo los vértices, y la escalera con un bloque al que le hemos 

eliminado la cara anterior, y duplicado las restantes para que se vean las dos cara

Y nos falta el detalle final, el rótulo “AEROPUERTO DE CORDOBA” que luce sobre el balcón. Para ello, lo primero que 

haremos será hacer click derecho en la palabra “Left” de la ventana de visualización, y seleccionamos Views

Seguidamente nos vamos al panel “Creation”, y en “Shapes” tenemos una herramienta “Text”. La seleccionamos, y 

desplegamos la persiana “Interpolation”. En “Steps” ponemos 1 y marcamos solamente la casilla “Optimize”. Esto es 

MUY importante, ya que si no lo hacemos nos creará infinidad de vértices y polígonos en el rótulo. En “Parameters” 

elegimos “Size” igual a 0,80 m., y en el recuadro de texto escribimos en mayúsculas. Dejamos el tipo de fuente en 

Arial. Ahora hacemos click en cualquier punto de la v

Editable Poly, las extruimos 0,15 m. y la posicionamos en su sitio.

Repetimos éste proceso con todas las barandillas, pero en vez de usar la forma “NGon”, lo haremos con líneas. Por lo 

ñadimos el toldo que hay bajo el balcón, y la escalera que sube al fanal. El toldo lo hemos realizado con “Plane”, 

dividiéndolo en dos segmentos transversales y moviendo los vértices, y la escalera con un bloque al que le hemos 

eliminado la cara anterior, y duplicado las restantes para que se vean las dos cara (igual que las barandillas).

Y nos falta el detalle final, el rótulo “AEROPUERTO DE CORDOBA” que luce sobre el balcón. Para ello, lo primero que 

haremos será hacer click derecho en la palabra “Left” de la ventana de visualización, y seleccionamos Views

Seguidamente nos vamos al panel “Creation”, y en “Shapes” tenemos una herramienta “Text”. La seleccionamos, y 

desplegamos la persiana “Interpolation”. En “Steps” ponemos 1 y marcamos solamente la casilla “Optimize”. Esto es 

no lo hacemos nos creará infinidad de vértices y polígonos en el rótulo. En “Parameters” 

elegimos “Size” igual a 0,80 m., y en el recuadro de texto escribimos en mayúsculas. Dejamos el tipo de fuente en 

Arial. Ahora hacemos click en cualquier punto de la ventana “Right”, y tenemos nuestras letras. 

Editable Poly, las extruimos 0,15 m. y la posicionamos en su sitio. 

 

Repetimos éste proceso con todas las barandillas, pero en vez de usar la forma “NGon”, lo haremos con líneas. Por lo 

 

El toldo lo hemos realizado con “Plane”, 

dividiéndolo en dos segmentos transversales y moviendo los vértices, y la escalera con un bloque al que le hemos 

(igual que las barandillas). 

Y nos falta el detalle final, el rótulo “AEROPUERTO DE CORDOBA” que luce sobre el balcón. Para ello, lo primero que 

haremos será hacer click derecho en la palabra “Left” de la ventana de visualización, y seleccionamos Views->Right. 

Seguidamente nos vamos al panel “Creation”, y en “Shapes” tenemos una herramienta “Text”. La seleccionamos, y 

desplegamos la persiana “Interpolation”. En “Steps” ponemos 1 y marcamos solamente la casilla “Optimize”. Esto es 

no lo hacemos nos creará infinidad de vértices y polígonos en el rótulo. En “Parameters” 

elegimos “Size” igual a 0,80 m., y en el recuadro de texto escribimos en mayúsculas. Dejamos el tipo de fuente en 

entana “Right”, y tenemos nuestras letras. La convertimos a 



Para no hacer la textura de nuestra acera demasiado grande, quitamos toda aquella zona que queda bajo el edificio. 

Podemos hacerlo con una operación booleana de sustracción, creando previamente un bloque de las mismas 

dimensiones que el edificio, y quitándoselo a la acera.

Un par de cosas más antes de finalizar. Es interesante que toda nuestra terminal sea un solo objeto. Para

seleccionamos cualquiera de los objetos, y en la persiana “Edit Geometry”, seleccionamos “Attach List”. Marcamos 

todos los objetos, y damos a OK. Ahora todo es de un color, y se llama como el objeto que seleccionamos. Le 

cambiamos el nombre a “terminal”, y si queremos el color también.

También, me he dado cuenta que hemos creado toda la terminal con la fachada Norte orientada hacia la parte 

inferior del display. Debemos girarla 180°. Seleccionamos nuestro objeto terminal y lo giramos. Para con

las operaciones que hemos hecho de escalado, giros, etc, conviene que vayamos al panel de comandos, y en 

“Utilities”, usamos “Reset XForm”. Pulsamos en “Reset Selected”, y en la ventana de modificadores aplicados, 

hacemos click derecho y le damos a “Collapse All”.

Para no hacer la textura de nuestra acera demasiado grande, quitamos toda aquella zona que queda bajo el edificio. 

hacerlo con una operación booleana de sustracción, creando previamente un bloque de las mismas 

dimensiones que el edificio, y quitándoselo a la acera. 

Un par de cosas más antes de finalizar. Es interesante que toda nuestra terminal sea un solo objeto. Para

seleccionamos cualquiera de los objetos, y en la persiana “Edit Geometry”, seleccionamos “Attach List”. Marcamos 

todos los objetos, y damos a OK. Ahora todo es de un color, y se llama como el objeto que seleccionamos. Le 

“terminal”, y si queremos el color también. 

También, me he dado cuenta que hemos creado toda la terminal con la fachada Norte orientada hacia la parte 

inferior del display. Debemos girarla 180°. Seleccionamos nuestro objeto terminal y lo giramos. Para con

las operaciones que hemos hecho de escalado, giros, etc, conviene que vayamos al panel de comandos, y en 

“Utilities”, usamos “Reset XForm”. Pulsamos en “Reset Selected”, y en la ventana de modificadores aplicados, 

mos a “Collapse All”. 

 

 

Para no hacer la textura de nuestra acera demasiado grande, quitamos toda aquella zona que queda bajo el edificio. 

hacerlo con una operación booleana de sustracción, creando previamente un bloque de las mismas 

Un par de cosas más antes de finalizar. Es interesante que toda nuestra terminal sea un solo objeto. Para hacerlo así, 

seleccionamos cualquiera de los objetos, y en la persiana “Edit Geometry”, seleccionamos “Attach List”. Marcamos 

todos los objetos, y damos a OK. Ahora todo es de un color, y se llama como el objeto que seleccionamos. Le 

También, me he dado cuenta que hemos creado toda la terminal con la fachada Norte orientada hacia la parte 

inferior del display. Debemos girarla 180°. Seleccionamos nuestro objeto terminal y lo giramos. Para conjuntar todas 

las operaciones que hemos hecho de escalado, giros, etc, conviene que vayamos al panel de comandos, y en 

“Utilities”, usamos “Reset XForm”. Pulsamos en “Reset Selected”, y en la ventana de modificadores aplicados, 



Ya hemos concluido con la fase de modelado. Grabamos nuestro archivo “LEBAterminal.gmax”.

2.TEXTURIZADO 

Por texturizar entendemos el aplicar acabados sobre los objetos modelados con GMax. Como vemos en la imagen 

superior, ahora mismo tenemos todos los volúmenes definidos, pero nos falta “pintarlos” para que su aspecto se 

asemeje lo más posible al real. Esta parte también es algo compleja, ya que dependerá en gran modo de nuestra 

capacidad artística para crear hojas de texturas. Veamo

En primer lugar, en GMax no se aplican texturas, sino materiales.

el mecanismo adecuado para darle el acabado al edificio. Los materiales son los elementos que hacen que un obje

presente un acabado determinado. Pero a éstos materiales de GMax, nosotros podemos indicarle que en lugar de un 

acabado uniforme, que puede a su vez tener diferentes variables de brillo, reflexión, relieve, etc, nos adopte una 

imagen bitmap que nosotros hayamos creado. Esta imagen bitmap es lo que se llama hoja de texturas. GMax 

dispone de herramientas para posicionar cada elemento de nuestro objeto dentro de la hoja de texturas, para 

asignarle su posición en dicha hoja. Esta operación de posicionar se l

nosotros queremos que en FSX nuestra terminal presente un acabado como el de las imágenes que hemos ido 

viendo anteriormente (color uniforme por cada elemento que creábamos), deberíamos de ir creando un material 

por cada objeto, aplicárselo con las variables que deseáramos (color, brillo, etc.), y no necesitaríamos mapear los 

objetos, ya que cada uno es en sí uniforme. Pero ésta opción peca de poco realismo, ya que no vemos por ejemplo 

los detalles de las fachadas, además de ser una locura para el simulador debido a la cantidad de materiales que 

usaríamos. Esto penaliza enormemente el rendimiento.

de texturas, donde literalmente iremos dibujando las fachada

dotarlo de un acabado mucho más real. 

Hay que tener ciertos conceptos claros en cuanto a las texturas y materiales, ya que un mal uso de ellas va a 

provocar una caída importante en el rendimiento del simu

- Es importante no asignar más de un material a un mismo objeto. Si lo hacemos, GMAx creará un tipo de 

material llamado “MultiMaterial”, que es un verdadero asesino de frames. Si es necesario, dividimos los 

objetos y a cada uno su material

- Es mejor tener una hoja de texturas de 1024x1024 que cuatro de 512x512. Así que crearemos hojas de éste 

tamaño. Lo importante es que a un único

podemos usarla para más objetos. 

Ya hemos concluido con la fase de modelado. Grabamos nuestro archivo “LEBAterminal.gmax”.

Por texturizar entendemos el aplicar acabados sobre los objetos modelados con GMax. Como vemos en la imagen 

o tenemos todos los volúmenes definidos, pero nos falta “pintarlos” para que su aspecto se 

asemeje lo más posible al real. Esta parte también es algo compleja, ya que dependerá en gran modo de nuestra 

capacidad artística para crear hojas de texturas. Veamos algunos conceptos previos.  

En primer lugar, en GMax no se aplican texturas, sino materiales. Esta diferenciación es clave para que entendamos 

el mecanismo adecuado para darle el acabado al edificio. Los materiales son los elementos que hacen que un obje

presente un acabado determinado. Pero a éstos materiales de GMax, nosotros podemos indicarle que en lugar de un 

acabado uniforme, que puede a su vez tener diferentes variables de brillo, reflexión, relieve, etc, nos adopte una 

hayamos creado. Esta imagen bitmap es lo que se llama hoja de texturas. GMax 

dispone de herramientas para posicionar cada elemento de nuestro objeto dentro de la hoja de texturas, para 

asignarle su posición en dicha hoja. Esta operación de posicionar se llama “mapeo”. Vamos a poner un ejemplo. Si 

nosotros queremos que en FSX nuestra terminal presente un acabado como el de las imágenes que hemos ido 

viendo anteriormente (color uniforme por cada elemento que creábamos), deberíamos de ir creando un material 

or cada objeto, aplicárselo con las variables que deseáramos (color, brillo, etc.), y no necesitaríamos mapear los 

objetos, ya que cada uno es en sí uniforme. Pero ésta opción peca de poco realismo, ya que no vemos por ejemplo 

además de ser una locura para el simulador debido a la cantidad de materiales que 

usaríamos. Esto penaliza enormemente el rendimiento. La otra opción, que es la que usaremos, será crear una hoja 

de texturas, donde literalmente iremos dibujando las fachadas que delimitan el edificio, para, usando el mapeo, 

 

Hay que tener ciertos conceptos claros en cuanto a las texturas y materiales, ya que un mal uso de ellas va a 

provocar una caída importante en el rendimiento del simulador. En general: 

Es importante no asignar más de un material a un mismo objeto. Si lo hacemos, GMAx creará un tipo de 

material llamado “MultiMaterial”, que es un verdadero asesino de frames. Si es necesario, dividimos los 

objetos y a cada uno su material correspondiente. 

Es mejor tener una hoja de texturas de 1024x1024 que cuatro de 512x512. Así que crearemos hojas de éste 

a un único objeto le sea asignado una única hoja. Sin embargo esa hoja, 

para más objetos. No se si me he explicado bien, quizá con un ejemplo se vea mejor. 

Ya hemos concluido con la fase de modelado. Grabamos nuestro archivo “LEBAterminal.gmax”. 

 

Por texturizar entendemos el aplicar acabados sobre los objetos modelados con GMax. Como vemos en la imagen 

o tenemos todos los volúmenes definidos, pero nos falta “pintarlos” para que su aspecto se 

asemeje lo más posible al real. Esta parte también es algo compleja, ya que dependerá en gran modo de nuestra 

Esta diferenciación es clave para que entendamos 

el mecanismo adecuado para darle el acabado al edificio. Los materiales son los elementos que hacen que un objeto 

presente un acabado determinado. Pero a éstos materiales de GMax, nosotros podemos indicarle que en lugar de un 

acabado uniforme, que puede a su vez tener diferentes variables de brillo, reflexión, relieve, etc, nos adopte una 

hayamos creado. Esta imagen bitmap es lo que se llama hoja de texturas. GMax 

dispone de herramientas para posicionar cada elemento de nuestro objeto dentro de la hoja de texturas, para 

lama “mapeo”. Vamos a poner un ejemplo. Si 

nosotros queremos que en FSX nuestra terminal presente un acabado como el de las imágenes que hemos ido 

viendo anteriormente (color uniforme por cada elemento que creábamos), deberíamos de ir creando un material 

or cada objeto, aplicárselo con las variables que deseáramos (color, brillo, etc.), y no necesitaríamos mapear los 

objetos, ya que cada uno es en sí uniforme. Pero ésta opción peca de poco realismo, ya que no vemos por ejemplo 

además de ser una locura para el simulador debido a la cantidad de materiales que 

La otra opción, que es la que usaremos, será crear una hoja 

s que delimitan el edificio, para, usando el mapeo, 

Hay que tener ciertos conceptos claros en cuanto a las texturas y materiales, ya que un mal uso de ellas va a 

Es importante no asignar más de un material a un mismo objeto. Si lo hacemos, GMAx creará un tipo de 

material llamado “MultiMaterial”, que es un verdadero asesino de frames. Si es necesario, dividimos los 

Es mejor tener una hoja de texturas de 1024x1024 que cuatro de 512x512. Así que crearemos hojas de éste 

una única hoja. Sin embargo esa hoja, 

No se si me he explicado bien, quizá con un ejemplo se vea mejor. 



Imaginaros que tenemos nuestra terminal y un hangar (dos objetos independientes). Y tenemos una hoja de 

texturas con las fachadas de ambos edificios. Esto es perfecto, ya que a la terminal solo le asignamos una 

hoja, y al hangar una hoja también (aunque sean la misma). Lo que no es nada recomendable es que 

tuviéramos dos hojas distintas para representar las fachadas de la terminal, o del hangar. 

- Es bueno también no abusar de las propiedades que tienen los materiales para FSX, tales cómo relieve 

(Bump), Brillos (Specular), etc. Tened en cuenta que éstas propiedades conllevan el tener que crear canales 

alfa adicionales en nuestras hojas de texturas, y nosotros en principio los usaremos para las transparencias. 

- Si tenemos un elemento de nuestro objeto que usa un color uniforme, no creamos un material o una hoja de 

textura nueva para aplicarlo. Tan solo tenemos que pintar en nuestra hoja de texturas un pequeño recuadro 

de 16x16 píxeles por ejemplo, de ese color uniforme, y al mapear introducimos todo ese elemento dentro 

del recuadro. Funcionará a la perfección. 

Tenemos claro pues, que lo primero que tenemos que hacer es crear nuestra hoja de texturas. Cómo hemos 

comentado antes, es preferible hacerla de gran tamaño, para que nos quepan todas las fachadas de al menos un 

edificio. La parte de hoja que nos sobre, la emplearemos para ir creando fachadas de edificios que estén cerca de la 

terminal. Pero nunca dejemos a medio hacer unas texturas de un edificio para terminarlas en otra. 

Para trabajar con hojas de texturas nos resultará indispensable el disponer de un software de edición gráfica con 

capacidad para crear capas y canales. Como ya vimos en partes anteriores, se puede usar PhotoShop (el que yo uso), 

o Gimp (gratuito), o Paint.Net (gratuito también). Aquí es donde se va a poner en relevancia nuestra capacidad 

artística. Yo me veo absolutamente incapaz de explicaros paso a paso como crear una hoja de texturas, pero sí dar 

unas pinceladas de cómo lo hago personalmente. 

Primero creamos un archivo nuevo, con dimensiones 1024x1024 píxeles. Ahora, con todo el fondo blanco da un poco 

de pánico pensar que tenemos que llenarlo de texturas, pero poco a poco se irá haciendo casi solo. Yo lo que suelo 

hacer es crear una especie de plantilla, donde creo los espacios que van a ir ocupando cada elemento de nuestro 

objeto. Lo fundamental en primer lugar el ver qué resolución estamos adoptando. Si por ejemplo, usamos todo el 

ancho de la hoja (1024 px), para representar los elementos más largos de nuestro objeto (las fachadas lado aire y 

lado tierra), que tienen 51,40 m., dividiendo nos arroja una resolución de 5 cm/px. Esto no está nada mal, pero si 

queréis podemos hacerla con más. O habrá zonas que podamos emplear menos resolución, ya que no hay apenas 

detalles (las cubiertas por ejemplo). Bien pues coger papel y lápiz, y hacemos a escala un cuadrado que nos 

represente nuestra hoja de 1024x1024. Yo normalmente uso un programa de CAD para hacerlo, por comodidad. 

Ahora iremos desglosando nuestra terminal en fachadas distintas, tomando las medidas y representándolas en 

nuestra plantilla. Tenemos un factor de escala en nuestro caso de 20 (1024 px/51,40 m), así que a cada medida que 

tengamos en metros, lo multiplicamos por 20 y tenemos los píxeles que va a ocupar. 



 

Faltan algunos elementos aún, pero vemos que nos va a sobrar bastante hoja. No os preocupéis que la usaremos 

enterita. Para que no se nos olvide ningún elemento, podéis ir mancando en el pdf que adjuntamos anteriormente 

con los planos, en la parte de las 4 imágenes en perspectiva, las zonas que hemos ido haciendo. Tened en cuenta 

que no todos los elementos del edificio van a necesitar su textura propia, sino que usará parte de otras. Por ejemplo, 

los cantos de las cubiertas, pueden usar la misma textura que la de la cubierta en sí. 

Ahora llega la hora de trabajar con PhotoShop. Iremos haciendo rectángulos con las dimensiones de nuestra 

plantilla, aunque no importa si nos pasamos o quedamos cortos con alguna medida. Usaremos nuestra base de 

fotografías del edificio, para ir cortando zonas e ir pegándolas en nuestra hoja, adaptándolas en tamaño y posición y 

jugando con los colores, brillo, contraste, efectos, etc. También podremos crear a mano algunas zonas, pintándolas 

con los colores que deseamos. Hay una herramienta muy útil en PhotoShop, y me imagino que en todos los 

programas de edición, que es la de “recortar”. Esto se emplea cuando tenemos fotos en perspectiva, y queremos 

ponerla “plana”. La usaremos infinidad de veces. 

https://www.youtube.com/watch?v=pk1yNL666lQ 

https://www.youtube.com/watch?v=Lcj4g3UIns8 

También usaremos muy frecuentemente el método de medir en fotografías que vimos hace tiempo ya. Recordad 

que ya comentamos la necesidad de tener una buena base de datos de fotografías de los edificios, ya que aparte de 

medir sobre ellas, también las usaremos para recortar zonas y pegarlas en nuestra hoja. Siempre es recomendable 

que las partes de nuestra hoja de texturas sean ortogonales, es decir sin perspectivas, aunque esto no es del todo 

imprescindible, ya que en el mapeo podemos también corregir éste efecto. 

Después de varias horas o días de trabajo, obtenemos nuestra hoja de texturas: 



Observad varias cosas. Lo primero es que no hemos rellenado la hoja por completo. Nos resta aproximadamente el 

50% (parte inferior de la hoja). Esto lo aprovecharemos posteriormente. Después v

espacio entre las distintas fachadas, tan solo hay que tener claro los límites a la hora de proceder al mapeo del 

objeto. Es interesante también que el contraste y el brillo de las texturas sean altos, ya que FSX tiende a osc

los materiales. Por último fijaros que hemos creado una zona donde están dibujadas las barandillas, que tienen un 

canal alpha (sombreado en gris claro), para crear transparencias de igual forma que vimos para las texturas de los 

GP. Tenemos que estar seguros de no olvidar ninguna parte visible de nuestra terminal que deba ser texturizado.

Cuando tengamos lista la hoja, debemos de grabarla de dos formas distintas (podemos usar el directorio textures 

que se encuentra ubicado dentro de gmax/gamepacks/FS

.psd (la propia de Photoshop), y otra como BMP de 32 bits. El motivo de grabarla de dos formas tiene una 

explicación, y es que GMax no lee los archivos BMP de 32 bits, necesarios si tenemos canales alfa. 

usaremos el archivo con extensión .psd para usarla en GMax, y el que tiene extensión .bmp para transformarla en 

texturas comprimidas DXT con el programa DXTBMP. Lo que sí es fundamental es que el nombre del archivo sea el 

Observad varias cosas. Lo primero es que no hemos rellenado la hoja por completo. Nos resta aproximadamente el 

50% (parte inferior de la hoja). Esto lo aprovecharemos posteriormente. Después vemos que no es necesario dejar 

espacio entre las distintas fachadas, tan solo hay que tener claro los límites a la hora de proceder al mapeo del 

objeto. Es interesante también que el contraste y el brillo de las texturas sean altos, ya que FSX tiende a osc

los materiales. Por último fijaros que hemos creado una zona donde están dibujadas las barandillas, que tienen un 

canal alpha (sombreado en gris claro), para crear transparencias de igual forma que vimos para las texturas de los 

r seguros de no olvidar ninguna parte visible de nuestra terminal que deba ser texturizado.

Cuando tengamos lista la hoja, debemos de grabarla de dos formas distintas (podemos usar el directorio textures 

que se encuentra ubicado dentro de gmax/gamepacks/FSX_GMaxGamepacks), una vez la grabamos con extensión 

.psd (la propia de Photoshop), y otra como BMP de 32 bits. El motivo de grabarla de dos formas tiene una 

explicación, y es que GMax no lee los archivos BMP de 32 bits, necesarios si tenemos canales alfa. 

usaremos el archivo con extensión .psd para usarla en GMax, y el que tiene extensión .bmp para transformarla en 

texturas comprimidas DXT con el programa DXTBMP. Lo que sí es fundamental es que el nombre del archivo sea el 

 

Observad varias cosas. Lo primero es que no hemos rellenado la hoja por completo. Nos resta aproximadamente el 

emos que no es necesario dejar 

espacio entre las distintas fachadas, tan solo hay que tener claro los límites a la hora de proceder al mapeo del 

objeto. Es interesante también que el contraste y el brillo de las texturas sean altos, ya que FSX tiende a oscurecer 

los materiales. Por último fijaros que hemos creado una zona donde están dibujadas las barandillas, que tienen un 

canal alpha (sombreado en gris claro), para crear transparencias de igual forma que vimos para las texturas de los 

r seguros de no olvidar ninguna parte visible de nuestra terminal que deba ser texturizado. 

Cuando tengamos lista la hoja, debemos de grabarla de dos formas distintas (podemos usar el directorio textures 

X_GMaxGamepacks), una vez la grabamos con extensión 

.psd (la propia de Photoshop), y otra como BMP de 32 bits. El motivo de grabarla de dos formas tiene una 

explicación, y es que GMax no lee los archivos BMP de 32 bits, necesarios si tenemos canales alfa. Por lo tanto 

usaremos el archivo con extensión .psd para usarla en GMax, y el que tiene extensión .bmp para transformarla en 

texturas comprimidas DXT con el programa DXTBMP. Lo que sí es fundamental es que el nombre del archivo sea el 



mismo, aunque con las dos extensiones distintas, así que pueden compartir directorio sin problema. En mi caso las 

he llamado LEBA001.psd y LEBA001.bmp. 

Ahora arrancamos DXTBMP, y cargamos la textura LEBA001.bmp. Comprobamos que tenemos el canal alfa visible en 

el recuadro superior derecho. Activamos la casilla “Mipmaps->Include when saving”. A continuación, la 

transformamos en una textura extendida DXT-1 (ya que solo tenemos un nivel de transparencia, y no transparencias 

graduales), con extensión .bmp extendida, y la ubicamos en el directorio textures dentro de nuestro escenario 

(LEBA/textures), con el mismo nombre. 

Hacemos un inciso. Durante el proceso de creación de las texturas, seguramente querremos ir comprobando qué tal 

se comporta en el simulador, y ello implicará que tengamos que ir modificándola sobre la marcha. Recordad que si 

modificamos la hoja de texturas, debemos de volver a grabarla de las dos formas anteriormente comentadas, así 

como volver a realizar la transformación en texturas extendidas. 

De momento tenemos lista la textura, pero nos falta crear el material en GMax, e indicarle que queremos aplicar 

dichas texturas. Veamos como hacerlo. 

Abrimos GMax, y abrimos nuestro modelo “LEBAterminal.gmax”. Lo seleccionamos. Pinchamos en el editor de 

materiales , que está en la caja de herramientas a la derecha. Se nos abre un cuadro de diálogo, y pinchamos 

en “New”. Se nos vuelve a abrir otro cuadro, llamado “New Material”, y seleccionamos “FlightSimX”. Así crearemos 

un material tipo FSX, que tiene innumerables opciones. Ahora se vuelve a quedar el editor de materiales con éste 

aspecto: 

 

Vemos una bola grisácea que es donde vemos las características que le damos a nuestro material, así como muchas 

persianas desplegables con opciones. Os voy a decir lo que tenemos que ir tocando. En primer lugar, dentro de la 

persiana “Blinn Basic Parameters”, vemos tres barras llamadas “Ambient”, “Diffuse” y “Specular”. Pinchamos en el 

color blanco junto a “Specular”, y seleccionamos el color negro en lugar del blanco actual. Esto hará que nuestro 

material no se vea brillar en exceso. En “Diffuse”, junto al color gris vemos un pequeño recuadro vacío. Es el 

recuadro “None”. Pinchamos ahí, y se nos abre otro cuadro de diálogo, que es el navegador de materiales de GMax. 

Aquí lo que vamos a indicarle es que queremos una hoja de texturas bitmap en lugar de un material uniforme. 



 

Pinchamos en “Bitmap” dos veces, y se nos abre un buscador de archivos. Nos vamos al directorio donde tenemos 

guardadas nuestras texturas, y seleccionamos “LEBA001.psd”. Ahora vemos que en editor, la bola grisácea ha 

cambiado, y vemos la textura dentro de ella. Pero nuestro objeto sigue sin estar texturizado. Tenemos que hacer dos 

cosas, primero activar la casilla “Show map in viewport”,  que se encuentra a la derecha del nombre del 

material (el nombre del material es irrelevante, lo podemos dejar como está). Por último pulsamos “Apply”. Ahora 

vemos que nuestro objeto ha cambiado de color, pero seguimos sin ver la textura sobre él. Eso es porque le falta el 

mapeo. 

El mapeo es el proceso mediante el cual nuestra hoja de texturas se va a proyectar sobre nuestro objeto. Esta 

proyección se puede realizar de múltiples formas, y tendremos que escoger la que mejor se adapte a la forma del 

modelo que tengamos. Veamos detenidamente éste proceso. Primero cerramos provisionalmente el editor de 

materiales. Nos vamos a la lista de modificadores, y en la persiana desplegable elegimos “UVW Map”. Vemos que se 

nos añade a la lista justo por encima del recuadro donde nos aparece “Editable Poly”. Aquí vemos las diferentes 

opciones de mapeo que tenemos: Planar, Cilindrical, Spherical, Shrink Wrap, Box, Face y XYZ to UVW. Cada una 

proyecta a su manera la hoja de texturas sobre el objeto. Si tenemos una forma cilíndrica, la mejor proyección será la 

cilíndrica lógicamente. Como nuestro objeto es más que nada rectangular, elegiremos la opción “Box”, que proyecta 

la hoja como si fuera una caja sobre el edificio. No os preocupéis si lo véis raro, ya que después tendremos que situar 

cada cara del edificio en su correspondiente posición. Además siempre podemos mapear cada subelemento de 

forma independiente, por ejemplo una cara, un elemento completo, etc. 

Una vez hecho esto, colapsamos el modificador “UVW Mapping” del recuadro para que se quede integrado. 

Ya tenemos mapeado el edificio, aunque queda lo más laborioso que es asignar a cada elemento su posición en la 

textura. Pero previamente volvamos al editor de materiales para modificar otras variables que nos van a resultar 

útiles. En las persianas desplegables encontramos una que indica “Flight Simulator Extended Parameters”, con un 

sinfín de opciones. Buscamos un recuadro “Material Alpha Test”, y lo dejamos de ésta forma: 



 

Esto es para que las transparencias se muestren correctamente en el simulador. En FS2004, no era necesario hacer 

esto, ya que las transparencias se controlaban exclusivamente con el canal alfa de la textura. En FSX, además de eso, 

tenemos que controlar éstos parámetros. 

También debemos de modificar varios parámetros más, solo en el caso de que queramos que nuestro objeto 

proyecte sombras sobre otros objetos o sobre el suelo. Esto es opcional, ya que si generamos sombras el 

rendimiento del simulador se ve afectado. Pero siempre cabe la posibilidad de que el usuario desactive dichas 

sombras en la configuración de FSX. Por lo tanto, la crearemos, y en el apartado “Enhanced Parameters”, marcamos 

así: 

 

Una última cosa previa al montaje de las texturas es que en el display de Gmax no se muestra con mucha resolución 

el resultado del mapeo, lo que es incómodo ya que debemos de ir probando continuamente el resultado en FSX. Hay 

una solución a esto. En los menús de Gmax vamos a Customize->Preferences->Viewports. En el apartado “Display 

Drivers”, pulsamos “Configure Driver”, y dejamos el cuadro de diálogo de la siguiente forma: 



 

Aunque no se aprecia bien en la imagen, en “Background Texture Size” tenemos marcada la opción de 1024, y en 

“Download Texture Size”, 512. 

Bien, ahora empieza el trabajo en serio, que es situar cada cara del edificio en su posición correspondiente dentro de 

la hoja de texturas. Para ello, seleccionamos el subelemento que queramos editar, cuando lo veamos marcado en 

rojo, nos vamos a la lista de modificadores y seleccionamos “Unwrap UVW”.  En “Parameters”, pinchamos en “Edit”. 

Se nos abre una ventana, que se llama “Edit UVW”. 

 

Aquí vemos varias cosas: en la parte superior están los botones de control, donde modificaremos la posición de los 

vértices, desplazándolos, girándolos, escalándolos, etc. En la parte central vemos un cuadrado que ahora está en gris 

que es donde aparecerá nuestra hoja de texturas en un momento, y también vemos (en blanco), la posición relativa 

de los vértices del elemento que hayamos seleccionada en relación a la textura, y en la parte inferior más botones de 

control. En primer lugar tenemos que cargar la textura. Para ello, nos vamos a la persiana desplegable de la parte 

superior derecha y hacemos click en “Pick Texture”. A continuación doble click en “Bitmap”, y buscamos nuestro 

archivo “LEBA001.psd”. Ya la tenemos cargada. Ahora desplazando los vértices, los colocamos en la posición que 

deseamos, y cerramos la ventana. Miramos en el display si está correcta, y cuando estemos seguros colapsamos el 

modificador “Unwrap UVW”. 



Pues bien, éste proceso lo tendremos que repetir innumerables ocasiones, hasta que todo nuestro edificio esté 

pintado. A mí me ha quedado así en Gmax. 

 

 

Grabamos nuestro archivo y vamos a ver como lo exportamos. 

3.EXPORTACION 

Con el proceso de exportación lo que haremos será crear un archivo .mdl, listo para ser compilado posteriormente 

hasta convertirlo en un .bgl capaz de ser leído por el simulador. Este apartado no presenta complicación alguna. En 

Gmax, y con el objeto seleccionado, vamos en los menús a “FSTools->LOD Name Tool”. Nos aparece un cuadro de 

diálogo llamado “LOD and GUID tools”. Abajo a la derecha, casi oculto, pinchamos en “Create New Guid for this file”. 

Se nos abre otro nuevo cuadro de diálogo, llamado “Friendly Name Info”. Aquí le asignamos un nombre a nuestro 

objeto, por ejemplo “terminal”. Pulsamos en “Go!”, y cerramos el cuadro. Aquí lo que hemos hecho es asignarle un 

GUID a nuestro objeto. Un GUID es un código alfanumérico que se asigna a un objeto, único, y que nos servirá 

posteriormente para compilarlo. No os preocupéis mucho de esto, pero si por curiosidad queréis saber el GUID 

asignado, vamos a File->File Properties->Custom, y ahí lo tenemos, tanto el GUID como en nombre asignado. 



Ahora, para exportarlo, en los menús vamos a “File->Export”. En la ventana que nos aparece, seleccionamos el 

directorio que queremos para ubicar nuestro archivo, por ejemplo en “scenes”, dentro de 

gmax/gamepacks/FSX_GMaxGamepacks. En la persiana desplegable seleccionamos el tipo “FlightSim Model 

(*.mdl)”, y le asignamos un nombre. En mi caso también he escogido llamarlo “terminal”. Se nos abre un cuadro 

llamado “Flight Simulator Model Export Options”, y dejamos todas las opciones por defecto. Ya lo tenemos. 

 

 


